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NATIONAL OPEN UNIVERSITY OF NIGERIA 

 

LIS 326: INTRODUCTION TO APPLICATION PACKAGES  

 

INTRODUCTION  

The Course LIS 326: Introduction to Application Packages runs for one 

Semester.  It has two credit loads and it is for students in the undergraduate 

programme in Library and Information of the National Open University of 

Nigeria.  It consists of five modules divided into 16 units.  The overall goal of 

LIS 326 is to introduce students to various application packages. The packages 

will include general purpose and specialized application software. The general-

purpose software will include word processing, spreadsheets, presentation, and 

graphics.  Students will also be introduced to database development software like 

Access 2000. Furthermore, students will be introduced to specialized accounting, 

web development, and multi-media packages. 

COURSE OBJECTIVES   

To achieve the above aims, a set of relevant objectives have been formulated to 

guide LIS 326. Focusing on these objectives is critical to students’ self-

evaluation as the course progresses.  Students should be able to do the following 

at the end of the course: 

 Define and describe application software. 

 Differentiate between general purpose and specialized application 

packages. 

 Understand and use Microsoft word processing package. 

 Understand Excel spreadsheet and its users  

 Master the use of Microsoft PowerPoint for presentation. 

 Describe graphic packages. 

 Learn the fundamentals of database development packages with practical 

applications using Access 2000. 

 

CONTENTS 

INTRODUCTION 
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What you will learn from the course 

Course Aims 

Course Objectives 

Working through the Course 

Study Units 

Course Materials 

Assessment 

The Presentation Schedule 

Tutor Marked Assignments 

Final Examination and Grading 

Summary 

 

LIS 326: INTRODUCTION TO APPLICATION PACKAGES 

 

LIS 326 Modules and Units 

The five modules of this course are divided into 17 study units as indicated 

below: 

MODULE 1: DEFINITION AND DESCRIPTION OF APPLICATION 

SOFTWARE 

Unit 1: Introduction to Application Packages 

Unit 2: Types or Categories of Application Packages 

Unit 3: Common Features of Software 

 

MODULE 2: WORD PROCESSING PACKAGE  

Unit 1: Microsoft Word Basics 

Unit 2: Working with Texts 

Unit 3: Layout and Printing 

MODULE 3: SPREADSHEET 

Unit 1: Microsoft Excel Basics 
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Unit 2: Formulae and Functions 

Unit 3: Working with Cells and Sheets 

Unit 4: Working with Data 

MODULE 4: PRESENTATION PACKAGES 

Unit 1: PowerPoint Basics 

Unit 2: Working with Slides 

Unit 3: Texts and Objects 

MODULE 5: GRAPHICS DESIGN AND DATABASE  

Unit 1:  Introduction to Graphics Design 

Unit 2: Introduction to Adobe Photoshop 

Unit 3: Introduction to CorelDraw 

Unit 4: Introduction to Microsoft Access 

  

Course Materials 

Students who take this course will be presented with relevant materials to 

facilitate their learning experience. The materials will include  

 Recommended textbooks; 

 LIS 326 Course guide; 

 Study Units; 

 Appropriate sources; and  

 Assignment file 

 Students who consult and use the above materials are likely to be better than 

those who fail to do so. 

Assessment 

The Presentation Schedule 

Tutor Marked Assignments 

Final Examination and Grading 

Undertaking this course is like an adventure and some vital steps/secrets will guarantee 

successful completion of LIS 326. The first secret is to understand that LIS326 is 

practically intensive. The second vital step is to personally practice in each application 
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package’s environment. Students should studiously cover the modules and units of the 

course. Fourthly, get and read recommended textbooks and other materials related to 

the course. Fourthly, actively participate in the practical session and online facilitation 

at the study centre.  Fifthly, master the course content/structure consisting of 

introduction, aims, and objectives, expected outcomes, summary, and conclusion. 

Sixthly, access online resources by clicking on the links provided in this module. Take 

special notice of the electronic books published by Wiley Press and Microsoft Press. 

Seventhly, complete all Tutor-Marked Assignments which are objective assessments of 

your progress in the course.  Finally, downloading the courseware will assist you to 

study it ubiquitously. 

 

ASSESSMENT 

Assessment for LIS 326 will consist of formative and summative approaches. The 

formative approach is administered at the end of each study Unit and the goal is to help 

students objectively assess their progress or learning outcomes. For LIS 326 there will 

be three continuous assessments of 10% each (30% in all). The final approach is in the 

form of a Computer-Based Test (CBT). The final examination is compulsory for all 

students. 

GETTING THE BEST OUT OT LIS 326 

 

It is possible to maximise your moment in LIS 326. Please note that this course 

is offered in the Open and Distant learning model. Consequently, ownership of 

hardware device like a laptop or another electronic device is imperative. Internet 

access is also critical to enable  download of e-resources and courseware.  

Computer literacy, the internet and information literacy are essential to 

effectively navigate the electronic landscape which is the operational platform 

for this Course. 

 

MODULE 1: DEFINITION AND DESCRIPTION OF 

APPLICATION SOFTWARE 

Unit 1: Introduction to Application Packages  

Unit 2: Types or Categories of Application Packages 

Unit 3: Common Features of Software 

 

UNIT 1: INTRODUCTION TO APPLICATION PACKAGES 

1.1 Introduction   

1.2 Learning Outcomes 
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1.3 Introduction to Application Packages 

1.3.1 Definition of Application Software 

1.4 Versions, Releases, & Compatibility 

1.5. Points to note on application packages  

1.6. Summary 

1.9 Glossary 

1.8 References/Further Reading 

1.9 Possible Answers to Self-Assessment Exercises (SAEs)  

1.1  INTRODUCTION  

This unit aims to layout an introduction to the subject of application packages. 

Also, this unit will introduce you to the concepts of versions, releases, and 

compatibility as they relate to application packages. Getting to know about 

application packages will be both fascinating and an enriching computer 

application experience. Get ready to do the Self-Assessment Exercises (SAEs) 

at the end of the various section of this Unit. Welcome to the world of application 

packages..  

1.2 LEARNING OUTCOMES 

At the end of this unit the students should be able to: 

 define the concept application packages 

 explain the meaning of versions, releases, and compatibility 

 understand the basic operations of application packages 

 

1.3 Introduction to Application Packages 

1.3.1 Definition of Application Software 

Software’s can be defined as a set of instructions that instruct a computer on how 

to perform various tasks. Applications software is software that has been 

developed to perform useful work on specific tasks, or particular problems, or 

provide entertainment for users. As users, you interact with the application's 

software. System software enables the applications software to interact with the 

computer and helps manage its internal resources. Generally, it is considered as 

any set of commands that guides or tells the hardware how to accomplish a given 

task. If you buy a new microcomputer in a store, you will find that some 

packaged software have already been installed on it. This typically includes 

system software (e.g., operating system) and various types of applications 

software compatible with it. Application Software’s are programs designed for 

end users which allow end-users to accomplish a set of specific tasks.  This might 

include among others i.e., programs to find solutions to users’ problems.  
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As has been before, the software can be divided into systems software (i.e., these 

are programs designed to control the execution and utilization of other programs 

and hardware effectively) and applications software (i.e., these are programs to 

solve users’ problems). Systems software is generally supplied by hardware 

manufacturers. In this section, let us look at some general points on applications 

software. Applications software comprises the method and guides which enable 

computer systems to do what the user requires. Software design essentially 

involves three abstract concepts. These are algorithms, data structures, and file 

structures.  

Algorithms are simply the steps for computation. They may either be numerical 

or non-numerical, for example, sorting, text searching, etc. Data structures, on 

the other hand, indicate how information is organized in the computer's memory. 

Self-Assessment Exercise1: What is software? 

 

1.4 Versions, Releases, & Compatibility 

After certain period software developers enhance their products and put forth 

new versions or new releases. Although not all software developers use the terms 

consistently, their accepted definitions are as follows. 

 Version: A version can be said to be a major upgrade of a software 

product. Traditionally versions have been indicated by numbers such 

as 1.0, 2.0, 3.0, and so forth. The higher the number preceding the 

decimal point, the more recent the version. In recent years, some 

software developers have departed from this system. An example is 

when Microsoft launched Windows 95” instead of calling it windows 

4.0. 

 

 Release: A release can be said to be a minor upgrade. Release is 

indicated by changing the number after the decimal point – 4.0, then 

4.1, then perhaps 4.11, then 4.2, and so on.  

 

 Compatibility: Compatible means what has been created or modified 

in earlier versions of the software can be processed successfully by 

later versions. Compatible also means that a new version of an 

applications program will run with the system software you are 

currently using. To avoid issues arising with incompatibility it is 

advisable to read the software package before buying it.  

 

Self-Assessment Exercise 2: What are the differences between system and 

application packages? 
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1.5. Points to note on application packages  

Basically, it can be said that a software package is a program written to help a 

computer perform the required tasks. Software is a set of instructions to help a 

computer do its job. Application packages are software programs written to 

support tasks that a computer was originally allowed to do; they are developed 

according to the needs of computer users. Most of the time the application 

software has to be installed by the user. This means that the application packages 

you may have on your computer will be different from what others may have on 

your system because each user has different needs or tasks to perform. In 

addition, application software is available in various versions and versions. And 

the system properties determine which packages will work on the computer 

depending on the system capacity. 

Self-Assessment Exercise 3: What do you understand by compatibility of 

application software? 

 

1.6 SUMMARY  

In this unit, we have examined the concept of software and application packages. 

It has been seen from this unit that without software a computer system cannot 

function and that application packages help to perform specific tasks on the 

computer. 

 

1.7 Glossary 

Applications software: Developed to perform useful work on specific tasks, or 

particular problems, or provide entertainment for users. 

Release: A release can be said to be a minor upgrade of a software. 

Software: Defined as a set of instructions that instruct a computer on how to 

perform various tasks.  

Version: A major upgrade of a software product 

 

1.8 REFERENCES/FURTHER READING 

Ikekeonwu, G. A. M & Oguike, O. E. (2017). Computer Applications. 

 Department of Enugu: Computer Science, University of Nigeria, 

 Nsukka., 307 . 

 

Lawrence Rosen (2004). "Why the public domain isn't a license". 

 rosenlaw.com 

Hanwell, Marcus D. (28 January 2014). "Should I use a permissive license? 

 Copyleft? Or something in the middle?". opensource.com. 
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1.9 Possible Answers to Self-Assessment Exercises (SAEs)  

Self-Assessment Exercise1: What is a software? 

Answer to SAE 1: 

Software’s can be defined as a set of instructions that instruct a computer on how 

to perform various tasks. Applications software is software that has been 

developed to perform useful work on specific tasks, or particular problems, or 

provide entertainment for users. 

 

Self-Assessment Exercise 2: What are the differences between system and 

application packages? 

Answer to SAE 2 

Systems software is generally supplied by hardware manufacturers. In this 

section, let us look at some general points on applications software. Applications 

software on the other hand, comprises the method and guides which enable 

computer systems to do what the user requires. 

Self-Assessment Exercise 3: What do you understand by compatibility of 

application software? 

Answer to SAE 3: 

Compatible means what has been created or modified in earlier versions of the 

software can be processed successfully by later versions. Compatible also means 

that a new version of an applications program will run with the system software 

you are currently using. To prevent issues arising with incompatibility it is 

advisable to read the software package before buying it. 

 

 

 

 

 

 

 

 

 

. 

UNIT 2: CATEGORIES OF APPLICATION SOFTWARE 
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CONTENT 

 

2.1 Introduction   

2.2 Learning Outcomes 

2.3 Entertainment Software and Home/Personal Software 

2.3.1 Entertainment Software 

2.3.2 Home/Personal Software 

2.4 Education/Reference Software and Productivity Software 

1.4.1 Education/Reference Software 

1.4.2 Productivity Software 

2.5 Specialty Software 

2.6 Summary  

2.7 Glossary 

2.8 References/Further reading  

2.9 Possible Answers to Self-Assessment Exercises (SAEs)  

 

2.1 INTRODUCTION  

 

We have treated the subject of application packages in the previous unit and this 

unit aims to treat five major categories of application software.  

 

2.2 LEARNING OUTCOMES 

At the end of this unit the students should be able to: 

 define the concept of entertainment Software, Home/Personal Software, 

Education/Reference Software, Productivity Software, Specialty 

Software 

 differentiate the features of the five major categories of application 

software 

2.3 Entertainment Software and Home/Personal Software 

 Application software may be classified in many ways. In this unit, we are 

going to use five categories. That is: 
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 Entertainment software 

 Home/personal software 

 Education/reference software 

 Productivity software 

 Specialty software 

 

Let us consider them briefly. 

2.3.1 Entertainment Software 

Entertainment Software refers to a wide variety of software, it can refer to video 

games, software for watching videos or playing music, displaying pictures, and 

other forms of entertainment which users can experience through a computer 

device. It can also be said that entertainment software is type of software that 

provides opportunities for leisure activities or any form of entertainment. 

 

We can say that due to the loose definition of entertainment software, there is 

quite a lot of software that fall into this category. One of the most well-known 

sectors of entertainment software is video games or the gaming industry, we can 

see how popular video games are if we take a look around, from adventure games 

like tomb raider to sports games like FIFA, NBA to action games like Call of 

Duty to simple games like candy crush and it’s not all games that are for leisure 

purpose, we also have educational games like Hangman, Scrabble, etc. Video 

games have been around since the ‘70s and they have developed rapidly to the 

point that modern-day games almost look as good as the real world. The first set 

of video games was not as realistic as modern games, they had basic visual 

representation and were small in size, as small as a few MB compared to modern 

games that are almost as large as 100GB. We had famous games like Pac-Man, 

Space Invader, Pong, etc. that introduced people to video games and it didn’t 

take long before the audience fell in love with video games, which lead to the 

creation of more and more video games.  

 
Figure 1.1 Image of Pac-Man Game: Source::Researchgate.net    Figure 1.2: Image of Space Invaders; Source: Smithsonianmag.com 
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Figure 1.3:Image of FIFA Video Game 

Source: Goal.com 

 

Another category is the Media Software, this can be for media creation and 

editing or for playing media files (movies and music). Though this category may 

not be as popular as the gaming category, they are still quite widely known. We 

also have various software for watching movies like VideoLAN (VLC), 

KMPlayer:, Netflix, etc., or listening to music like iTunes, Deezer, etc. All this 

software enables us to watch videos or listen to music on our Computers. We 

also have software for creating or editing video and music, which include Sony 

Vegas pro, adobe Photoshop, shazam, sound cloud, virtual DJ, etc. both the video 

and music editors work similarly, they can create, replace, delete, adjust, 

transform and do anything to the frames on the screen. This has created endless 

opportunities for content creators and professional workers. 

 

 

 
Figure 1.4:Image of VideoLAN  Figure 1.5:Image of Deezer 

Source:Videolan.org   Source: https://dribbble.com/tags/deezer 
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Figure 1.6:Image of Virtual DJ   Figure 1.7: Image of Sony Vegas Pro 

Source: digitaldjtips.com           Source: getintopc.com  

 

Entertainment Software  are not solely for leisure purposes, we also use it for 

educational purposes. Children love to be entertained, they love to have fun and 

it is also easy to instruct children through educational games or videos, this is 

commonly used in modern schools and it has proven to be very efficient. 

Educational games come in various forms and sizes; some are general while 

others offer a more specialized educational experience, examples include 

Minecraft which is used by architectural schools for the project, Kahoot which 

can be said to be an educational platform. Overall, there are so many different 

ways to teach kids while having fun, that it's a great thing that such software 

exists. Because this means modern children have many new opportunities to be 

interested in learning and have fun while doing it. 

 

All this shows that entertainment software plays an important role in our daily 

lives, from movies to music to video and music editing to educational games. 

 

 2.3.2 Home/Personal Software 

Personal software or Personal application software can be said to be software 

one uses for their purpose, this implies that it is software you use to complete a 

certain task that relates to you, technically personal software does not have to be 

unique, it just has to be software that various individuals can use for their 

purpose. It is also known as home application software because it is intended for 

home, private use. 

Most software that we use is personal software because of various reasons apart 

from being intended for home and private use, they come most times with 

instructional use, they are comparatively cheaper than any other category of 

application software, they also increase personal productivity and effectiveness. 

Based on this description of personal software we can give an example of 

personal software which is Microsoft Office. Microsoft Office is considered as 

an example of personal software because it caters to a lot of activities in our daily 

lives, for example, Microsoft word is used for typing documents like research 

papers, projects, lesson notes, assignments, etc. Microsoft Office is also one of 

the most popular if not the most popular personal software in the world today, 

apart from that it is also very cheap to acquire and easy to use. Other examples 
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are our various web browsers like Google Chrome, Safari, Firefox, Explorer, etc. 

they enable us to have access to the web and to browse it. The common feature 

among all these examples are that One, we use them for personal purposes. Two, 

we use them in our daily activities. Three, they are cheap to get, and most even 

come along with our device, and finally, they increase personal effectiveness. 

2.4 Education/Reference Software and Productivity Software 

 2.4.1   Educational/Reference Software 

Educational software are programs that are mainly developed for teaching and 

learning. It covers a wide range of different purposes right from language 

learning software to reference software to classroom management software to 

video instruction software etc. The potential of educational software was 

recognized early by educational professionals, this lead to educational software 

arriving virtually with the first desktop computers. Educational software covers 

a large area of different forms, costs, and purposes, some exist to instruct 

children on various letters in the alphabet, others include introducing complex 

concepts to all grades, some are also for developmental purposes in the aspect of 

good writing skills, good speaking skills, etc. some are designed for instructing 

professionals various details of their job, etc. some examples include Encarta, 

Google Classroom, Litmos, Moodle, etc. 

There are various categories of educational software which include: One, 

Courseware, these are additional materials that can either be intended as kits for 

teachers or tutorials for students, in most cases, they are documents intended to 

provide further assistance. Two, Classroom Aids, are specifically designed for 

use in school classrooms. When such software are used they are typically 

displayed on large whiteboards e.g. Moodle. Three, Specific Educational 

purpose, these are highly specific software that is used mainly teaching on a 

specific subject or instruct on a specific task e.g. driving test software, language 

learning software, etc. Other categories include corporate training, custom 

platforms reference software, and assessment software. 

 2.4.2 Productivity Software   

Productivity software just as the name implies is used for the production of 

information which could be in the form of databases, documents, worksheets, 

charts, graphs, etc. It is primarily used for increasing productivity especially 

among office workers. A bundle of productive software intended to be used by 

office workers is known as Office Suite. The components are generally 

distributed together, have a consistent user interface, and usually can interact 

with each other.  

 The most popular kinds of productivity tools are: 

 Word processing software  

 Spreadsheet software 

 Database software, including personal information managers 
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 Financial software, including personal finance programs 

 Software for cyberspace – communications, e-mail, Web browsers 

 Integrated software and suites. 

 

It may still be possible to work in an office these days without knowing any of 

these programs. However, that probably won't be the case as we move along into 

the 21st century. We shall describe productivity software in more detail 

beginning in another few pages. 

 

 
 Figure 1:8: Example of a Productive Software   

 

2.5. Specialty Software 

 

Whatever your occupation, you will probably find it has specialized software 

available to it. This is so whether your career is as an architect, building 

contractor, pilot, etc.Some programs help architects or engineers to be able to  

simulate buildings before building them. Other programs help construction 

estimators pull together the costs of materials and labour needed to estimate a 

job. 
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Figure 1:9 Image of AutoCAD Software: A specialty software for engineers and 

Architects  

Source:www.digitalengineering247.com 

 

2.6 SUMMARY  

Various categories of application software help to carry out various tasks ranging 

from education-related tasks and entertainment. Users determine which of these 

categories they install depending on their needsIn this unit, we have gone through 

the five major categories of application packages. It is clear that users have the 

choice to install any or all of the categories. 

 

Self-Assessment Exercise1: List the various categories of application software 

you know. 

Self-Assessment Exercise 2:  What are the most popular productivity tools? 

 

2.7 Glossary 

1. Entertainment Software: Entertainment Software refers to a wide variety of 

software, it can refer to video games, software for watching videos or playing 

music, displaying pictures, and other forms of entertainment which users can 

experience through a computer device. 

2. Educational Software: Educational software are programs that are mainly 

developed for teaching and learning. 

 

3. Productivity software: Productivity software just as the name implies is used 

for the production of information which could be in the form of databases, 

documents, worksheets, charts, graphs, etc. 
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2.9 Possible Answers to Self-Assessment Exercises (SAEs)  

Self-Assessment Exercise 1: List the various categories of application software 

you know. 

Answer to SAE 1:There are at least five categories of application software. These 

are: 

 Entertainment software 

 Home/personal software 

 Education/reference software 

 Productivity software 

 Specialty software 

Self-Assessment Exercise 2:  What are the most popular productivity tools? 

Answer to SAE2: 

The most popular kind of productivity tools are: 

 Word processing software  

 Spreadsheet software 

 Database software, including personal information managers 

 Financial software, including personal finance programs 

 Software for cyberspace – communications, e-mail, Web browsers 

 Integrated software and suites. 
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UNIT 3: COMMON FEATURES OF SOFTWARE 
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Software and Types of Licenses 
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3.5.2 Propriety Software and Types of Licenses 

3.6 Summary  

3.7 Glossary  
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3.9 Possible Answers to Self-Assessment Exercises (SAEs)  

 

3.1 INTRODUCTION  

Having treated the various application packages, this unit aims to focus on the 

various features of typical software or application. The lesson will pay attention 

to the user interface, explore the issue of tutorials and documentation as well as 

the issues of help for users, and other useful software assistants. 

 

3.2 LEARNING OUTCOMES  

At the end of this unit the students should be able to: 

 Explain the basic features in a typical user interface 

 Explain the use of tutorials and documentation 
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 Define what the concept of freeware, shareware, and proprietary 

software 

3.3 The User Interface 

The following discussion provides a brief review of some features common to 

both applications software and system software. 

 

The User Interface or UI is the point at which we the users interact with a 

computer program or application, the main goal of the user interface is to make 

the user experience easy, enabling the user to achieve a maximum outcome with 

minimal effort. The type of user interface is usually determined by the system. 

There have been various types of interface in the past but the currently most used 

or widely known is the Graphic User Interface or GUI as it is commonly known. 

It is a form of user interface which allows users to interact with a computer 

through graphical icons and an audio indicator. Various actions in GUI are 

usually performed by directly manipulating the graphical elements. 

 

 
 

Figure 1.10: Image of a Graphic User Interface for Windows 
Source:https://www.itpro.co.uk/operating-systems/30248/what-is-a-graphical-user-interface 

Common features of GUIs are menus, windows, icons, buttons, and dialog 

(dialogue) boxes. 

 Menus: A menu is a list of available commands shown on the screen. It is 

a list of command options presented to a user of a computer system. 

 

A menu bar is a horizontal bar that contains the labels for drop-down menus 

which is usually anchored to the top of a window, coming most times after 

the title bar. 
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Figure 1.11: Image of a Menu Bar in File Explorer 

Source: Screenshot 

 

 

A drop-down menu is a list of commands options that "drop down" from a 

selected menu bar item at the top of the screen. It allows a user to choose one 

value from the list. When it is inactive it shows a single value, when it is activated 

or clicked on it drops down a list of values or commands for a user to select one. 

 
Figure 1.12: Image of an active Drop Down Menu 

Source: Screenshot 

 

A pop-up menu, also known as shortcut menu and context menu, refers to a 

hidden menu that doesn’t show/appear until the user right-clicks. This menu is 

mostly referred to as a context menu because the menu that appears relates to 

what was right-clicked. For example in Microsoft word, if a text that is 

highlighted is right-clicked on, a pop-up menu similar to the example below will 

appear. This menu gives quick access to common features related to the text.  

 

 
Figure 1.13: Image of a Pop Up Menu 

Source: Screenshot 
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3.3 .1 Windows 

Window: A particularly interesting feature of GUIs is the use of windows.A 

window is the rectangular part of the computer display in the GUI that shows the 

program currently in use. For example, the browser window you use to explore 

the files on your system is a window. Windows allows users to work with 

multiple programs or view multiple programs at the same time. Most windows 

allow you to minimize and maximize them, allowing you to temporarily hide and 

show programs. 

 
 

Figure 1.14: Image of a Window 

Source: Screenshot 

  

 

  A window (small w) should not be confused with Windows (capital W) 

- the program known as Microsoft Windows, which is the most popular 

form of system software for the personal computer. However, as you might 

expect, Windows features extensive use of windows. 

 

 

3.3.2 Icons 

Icons: An icon is a small graphical representation of a program, function, 

or file. When you click or double-click an icon, the associated file or 

program opens or an action is performed. For example, if you double-

click the This PC icon, Windows Explorer will open windows explorer. 
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Icons are components of GUI operating systems, including Apple's 

macOS X and Microsoft Windows. Icons help users quickly identify the 

type of file represented by the icon. The image is an example of the "My 

Computer" icon in various versions of Microsoft Windows.  

     

 
  

Figure 1.15: Image of a Windows Screen with Various Icons 

Source: Screenshot 

 

 

3.3.2 Buttons:  

A button is a graphic icon that may have text that performs a software 

function. For example, the Windows Start button is used to open 

the Start menu, the X button by the top right of a window s used to close 

the window. 

 

https://www.computerhope.com/jargon/i/icon.htm
https://www.computerhope.com/jargon/s/start.htm
https://www.computerhope.com/jargon/s/startmen.htm
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Figure 1.16: Image with the windows button clicked  

Source: Screenshot 

 

3.3.4 Dialog box 

Dialogue (Dialog) box: A dialog box is a window that opens to allow 

communication between the computer and you, the user. Dialogue can ask 

questions or give you information. Generally, once a dialogue box appears, an 

action must be taken which relates to it before the user can access other 

applications. 

 

Figure 1.17: Image of a Dialogue Box 

Source: Screenshot 

 

3.4 Tutorials and Documentation and Helps for Software Users 

3.4.1 Tutorials and Documentations 

How does a new user intend to get familiarized with the program? Please note 

that commercial producers of application packages also provide tutorials and 

documentation along with products. 

 Tutorials: A tutorial is a book, document, or video that shows a new user 

the walk through on how to get familiarized with the program. Take, for 

instance, publishers provide several books on how to get familiarized with 

the software package, sometimes they are provided as part of the software 

package. 
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 Note: Not all software products come with tutorials. 

 Documentation: Documentation can be said to be a short pictorial 

description of a program. The documentation may be in print, but today 

it is generally available on CD-ROM and the Internet. The documentation 

may be educational, but features and functions are generally grouped by 

category for reference. 

Let us now consider the various forms of applications software used as 

productivity tools. Then we will cover specialty programs. 

3.4.2 Help for Software Users 

Why devote so much space to a discussion of the difficulties of software and risk 

frightening newcomers before they've even begun? Because it is easy for users 

(especially newcomers) to think that the reason they can't make a program work 

lies with their ineptness – when the culprit is the manufacturer making slipshod 

goods. There are, however, some sources of user assistance – although even here, 

to be forewarned is to be forearmed. 

 Instruction manuals: User guides or instructions manuals printed on paper 

have traditionally accompanied boxes of applications software diskettes or 

CD-ROMs. Sometimes these are just what you need. Sometimes, however, 

you need to know what you need help with, and it may be difficult to define 

the problem. In addition, these guides may be a puzzle to anyone not trained 

as a programmer because they are often written by the very people who 

developed the software. And experts are not always able to anticipate the 

problems of the inexpert. More recently, software manufacturers have been 

giving short shrift to print-on-paper manuals. Says business-technical 

writer John Merchant, "as the software has become more complex, the 

(paper) user guides have become slimmer the drastically reduced time 

allowed to get new software products to market does not allow for 

comprehensive manuals to be written." 

 

 Help software: Instead of printed manuals, software manufacturers now 

rely more on the "help" programs on a floppy disk or CD-ROM that come 

with the software, which contain various help menus. However, these can 

also include techno language that is confusing for newbies. As with paper 

manuals, utilities can be in the last-minute rush to publish them. Help 

programs may also be available on the Internet. The issue with going online 

is that, How do you go online to ask for help when the system is not 

working? Or how can you go online to get advice on how to fix your 

software and fix your software at the same time? (It helps to have two 

computers!). 

 

 Telephone helplines: If you encounter a software glitch,      use a helpline 

to call a customer-support technician at the program's manufacturer. The 

tech would then try to talk you through the problem or might refer you to a 

Web site from which you could obtain a file that would remedy your 
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problem. Both software and hardware makers have long offered telephone 

helplines for customers. If your computer breaks down, you may find that 

your hardware company still offers emergency advice for free (although 

you may have to pay the phone company's long-distance tolls). However, 

software manufacturers now invariably charge for help calls if you have 

had the software longer than 30-90 days. This could run to a few hundreds 

or thousands of Naira depending on the arrangement you have with them. 

An analyst for Dataquest, a market-research firm based in the United States 

of America estimates that microcomputer users placed 200 million calls in 

1999 to ask software questions. He also found the average time a user had 

to wait on hold was about 3 minutes. It is quite common to wait for 20 or 

30 minutes – even at midnight – listening to bubbly music and a recorded 

voice urging you to "stay on the line for the next available technician." 

 

 Commercial how-to books: Because of the inadequacies in user support 

by the software developers themselves, an entire industry has sprung up 

devoted to publishing how-to books. These are the kind of books found both 

in computer stores and in general bookstores such as Barnes & Noble or 

Abiola Bookshops, based in Lagos. Examples are the "For Dummies" or 

"Complete Idiot's" books (such as Adobe Photoshop for Dummies and The 

Complete Idiot's Guide to Microsoft Office 2000 Professional). It needs to 

be said, however, that many of these are guides to how to use a particular 

program – that is, they are tutorials, rather than fix-it manuals telling you 

how to make the software work right. Sometimes, some users complain that 

they are rather too technical to them. 

 

 Knowledgeable friends: Believe it or not, nothing is better than having a 

knowledgeable friend: your teacher or mentor, a more advanced student 

than you, or someone with a technical interest in computers.. Business 

people pay millions of dollars to have computer technicians come into their 

offices and deal with software and hardware problems. However, many 

users can't afford expensive consultants. Thus, we can't stress enough how 

important it is to get to know people – from your classes, from computer 

user groups (including online Internet groups), from family friends, or 

whatever – who can lend aid and expertise when your computer software 

gives you trouble. As it assuredly will at some point. (And don't forget to 

do something for them in return!.) 

 

A final word: If you are happy with a particular applications program, don't feel 

you have to go out and upgrade to the latest version just because everyone around 

you seems to be doing so. The ultimate test, after all, is: How useful is the 

software for you? You don't necessarily need to be influenced by the argument 

that something is "better, faster, and incorporates all the latest technology."  

3.5. Public Domain Software: Freeware and Shareware and Propriety 

Software and Types of Licenses 
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1.5.1 Public Domain Software: Freeware, & Shareware 

These are the general issues you need to consider when you are thinking about 

how to use someone else's intellectual property in the Digital Age. Now let's see 

how software fits in. No doubt most of the applications programs you will study 

in conjunction with this book will be commercial software packages, with brand 

names such as Microsoft Word or Excel. However, there are  some software 

products – many available over communications lines from the Internet – that 

are available to you as public domain software, freeware, or shareware. 

 Public domain software: Public domain software is software that can be 

duplicated by anyone meaning, it is not protected by copyright. Public 

domain programs have been donated to the public by their creators. They 

are made available through various sites, for example, GitHub; users can 

upload their systems and make them public if they want others to have 

access to it. With public domain software, you don’t have to fear authorities 

if you make any changes to it, but in hindsight, we have to be careful of the 

free software we download some conceal malicious programs that can be 

harmful to your system. 

 

 Freeware: Freeware is software that is available free of charge. Freeware 

is distributed without charge, usually through the Internet or among user 

groups. Software creators let their software go for free for seeing how the 

users response to the program to improve in the program, later on, 

sometimes it could be for a scholarly purpose. Freeware developers often 

retain all rights to their programs, so that technically you are not supposed 

to duplicate and distribute them further. Still, there is no problem with your 

making several copies for your use. 

 

 Shareware: Shareware is copyrighted software that is distributed free 

of charge, but whose users must contribute to continue using it. 

Shareware is also distributed mainly through communication links such 

as the Internet. An example is WinZIP, a program for managing 

computer files that you can get from the Internet.  "Trialware" versions 

of shareware are sometimes available on the Internet. This type of 

software has limited functionality (it is a weakened version of the real 

version) or the amount of time that the software can work is self-limited. 

After the trial period ends, the user pays a fee to get the fully functional 

version, or the software simply becomes unusable. Have trouble making 

copies of shareware for your friends? The developer hopes it will. In 

this way, the program is distributed to many people, some of whom the 

creator of the software expects to "contribute" or pay a "registration fee" 

for advice or updates.  Although shareware copying is allowed, because 

it is copyrighted, you cannot use it as a basis for developing your 

software to compete with the developer.  
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3.5.2 Proprietary Software & Types of Licenses  

 

Proprietary software is software whose rights belong to a person or a company, 

usually the software developer. The property is copyrighted and the owner 

expects you to buy a copy to use it. The software may not be legally used or 

copied without permission.  

 Software manufacturers don't sell you the software as much as a license to 

become an authorized user. What is the difference? By paying for a software 

license, you are signing an agreement that you agree not to make copies of the 

software for donation or resale. That is, you have only purchased the company's 

authorization to use the software and not the software itself. This legal subtlety 

allows the company to retain its rights to the program and restrict how its 

customers can use it. The fine print in the license agreement allows you to make 

one copy (backup or archive copy) for your use.  

   There are several types of licenses:  

 Shrink-wrap licenses: Shrinkwrap licenses are printed licenses that are 

inserted into software packages and are visible through the clear plastic 

film. The use of shrink film licenses eliminates the need for a written 

signature, as the buyer knows they are entering into a binding contract 

simply by opening the package. Each Shrinkwrap license is for a single 

system.  

 Site licenses: A site license allows a customer to make multiple copies of 

a software product for use only within a specific installation.  

 Concurrent-use licenses: A concurrent use license allows the 

simultaneous use of a certain number of copies of software within a given 

installation. For example, if a concurrent use license is granted for 10 users 

within a company, all 10 users in the company can use the software at the 

same time.. 

 Network single-user licenses: A single-user network license limits the use 

of the software on a network to one user at a time. 

 Network multiple-user license: A network multi-user license allows more 

than one person on a network to use the software. Each user is assigned a 

license and only those licensed as such can use the network software. 

 

3.6. SUMMARY 
 

This unit has treated the various features of software such as an interface, 

tutorials, and documents. It also took a look at some free and proprietary wares 

and how they make the use of certain software easier. Typical software will have 

the Users’ Interface which contains the Windows, the Icons, the Buttons, and the 

Dialog box. To use the software a user must familiarize themselves with these 

features and correctly use them. Also, to make the use of the software easier, 
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most software packages have tutorials and documentation as part of the features 

in the software. These and other features on software packages make them easier 

to use and navigate. 

Self-Assessment Exercise1: Mention the major features of graphic user interface 

(Graphic User Interface. 

Self-Assessment Exercise 2: What are the sources of help for software users? 

Self-Assessment Exercise 3: What type of licences are available to users? 

 

3.7 Glossary 

Public domain software: A software that can be duplicated by anyone meaning, 

it is not protected by copyright. 

Freeware: Freeware is software that is available free of charge. 

Shareware: Shareware is copyrighted software that is distributed free of charge, 

but whose users must contribute to continue using it 

Proprietary software: Proprietary software is software whose rights belong to 

a person or a company, usually the software developer. 

Tutorials: A tutorial is a book, document, or video that shows a new user the 

walk through on how to get familiarized with the program. 
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3.9 Possible Answers to Self-Assessment Exercises (SAEs)  

Self-Assessment Exercise1: Mention the major features of Graphic User 

Interface. 

 

Answer to SAE 1: Common features of GUIs are menus, windows, icons, 

buttons, and dialog (dialogue) boxes. 

 

Self-Assessment Exercise 2: What are the sources of help for software users? 

 

Answer to SAE 2: 

The major sources of user assistance include: 

 Instruction manuals: User guides or instructions manuals printed on paper 
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have traditionally accompanied boxes of applications software diskettes or 

CD-ROMs.  

 

 Help software: Instead of printed manuals, software manufacturers now rely 

more on the "help" programs on CD-ROM that come with the software, which 

contain various help menus. Help programs may also be available on the 

Internet.  

 Telephone helplines: If you encounter a software hitch, you can use a 

helpline to call a customer-support technician at the program's 

manufacturer. Both software and hardware makers have long offered 

telephone helplines for customers. If your computer breaks down, you may 

find that your hardware company still offers emergency advice for free 

(although you may have to pay the phone company's long-distance tolls).  

 

 Commercial how-to books: Because of the inadequacies in user support by 

the software developers themselves, an entire industry has sprung up devoted 

to publishing how-to books. These are the kind of books found both in 

computer stores and in general bookstores Examples are the "For Dummies" 

or "Complete Idiot's" books (such as Adobe Photoshop for Dummies and The 

Complete Idiot's Guide to Microsoft Office 2000 Professional).  

 Knowledgeable friends: Believe it or not, nothing is better than having a 

knowledgeable friend: your teacher or mentor, a more advanced student 

than you, or someone with a technical interest in computers..  

 

Self-Assessment Exercise 3: What type of licences are available to users? 

 

Answer to SAE 3: 

There are at least five types of licenses available to software users. They 

include:  

 Shrink-wrap licenses: Shrinkwrap licenses are printed licenses that are 

inserted into software packages and are visible through the clear plastic 

film. The use of shrink film licenses eliminates the need for a written 

signature, as the buyer knows they are entering into a binding contract 

simply by opening the package. Each Shrinkwrap license is for a single 

system.  

 Site licenses: It allows a customer to make multiple copies of a software 

product for use only within a specific installation.  

 Concurrent-use licenses: A concurrent use license allows the 

simultaneous use of a certain number of copies of software within a given 

installation. For example, if a concurrent use license is granted for 10 users 

within a company, all 10 users in the company can use the software at the 

same time.. 

 Network single-user licenses: A single-user network license limits the use 

of the software on a network to one user at a time. 

 Network multiple-user license: The license allows more than one person 

on a network to use the software. Each user is assigned a license and only 
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those licensed as such can use the network software. 
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13.4 Touch mode 

1.3.5 Ruler 

1.3.6 Scroll Bars 

1.3.7 Document View Buttons 

1.3.8 Zoom sliders 

1.3.9 The mini Toolbar and keyboard Shortcuts 

1.4. Microsoft Basic 2: Creating and Printing Document 

1.5 Point to note  

1.6 Summary  

 

1.7 Glossary 

 

1.8 References/Further Reading 

1.9 Possible Answers to Self-Assessment Exercises (SAEs)  

 

1.1  INTRODUCTION 

 

This Unit introduces students to Microsoft environment basics such as 

Title bar, ribbon ruler, keyboard shortcuts, and how to create, print, and save 

documents. 

 

1.2  LEARNING OUTCOMES 

After going through this Unit students gain an understanding of: 

  the title bar, the Ribbon, the file tab and backstage view, Touch mode,  

 how to use Ruler,  

 how to use Scroll Bars,  

 how to use Document View Buttons,  

 how to use Zoom sliders,  

 how to use the mini Toolbar,  

 how to use Keyboard Shortcuts and learn how to create a document,  

1.3. Microsoft word environment 
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The new Word environment is designed to more closely reflect the way people 

generally work with the program. Microsoft Word 2016 is a word processing 

application that allows you to create a variety of documents, including letters, 

resumes, and more. In this section, you'll learn how to navigate the Word 

interface and become familiar with some of its most important features, such as 

the Ribbon, Quick Access Toolbar, and Backstage view. Word 2016 is similar 

to Word 2013 and Word 2010. If you've previously used either version, then 

Word 2016 should feel familiar. But if you are new to Word or have more 

experience with older versions, you should first take some time to become 

familiar with the Word 2016 interface. 

To open this application called Microsoft Word, go to the start button and click 

it, you will see all app there, look for the Microsoft icon and lunch it.  This is the 

environment you will be working on, it comprises of the title bar, menu bar, 

standard toolbar, formatting toolbar, ruler, insertion point, End of Document 

Marker, Help, Scroll bars, Status Bar, Task pane, View Buttons, Office 

Assistant, etc. 

 

 

Figure 2.1: The tool bar 

Source: Screenshot  
 

 1.3.1 The Tile bar 

As seen above, by default it is titled “Document 1-Word”.  When you save as 

then you have the option to name it whatever you want to name it. 

1.3..2 The Ribbon 
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As seen above, the ribbon is a set of toolbars at the top of the window in Office 

programs designed to help you quickly find the commands that you need to 

complete a task. 

1.3.3 The file tab and backstage view 

As seen above, The File tab is a colored tab, for example, a blue tab in Word, 

located in the upper-left corner of Microsoft Office programs while the 

backstage view provides access to saving, opening, info about the currently open 

file (Permissions, Sharing, and Versions), creating a new file, printing, and fc 

 

Figure 2.2: The Microsoft Word environment 

Source: Screenshot  

1.3.4 Touch mode 

To do this click the drop-down arrow to the right of the quick access toolbar and 

select touch mode from the dropdown you see, the touch mode will appear on 

the quick access toolbar. 

1.3.5 Ruler 

You can see this at the top side of your document as shown above. 

1.3.6 Scroll Bars 

You can see this on the right side of your document as shown above. 

1.3.7 Document View Buttons 
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 The view buttons are a feature that lets you change how the presentation or 

document appears. 

1.3.8 Zoom sliders 

The zoom slider is usually in the lower right corner of the software window as 

shown above. 

1.3.9 The mini Toolbar 

The mini toolbar appears whenever you right-click text in Word. 

1.3.10 Keyboard Shortcuts 

Here are a list of shortcuts you can always use,  Basic Windows 

keyboard shortcuts 

Ctrl+Z: Undo., Ctrl+W: Close., Ctrl+A: Select all., Alt+Tab: Switch apps., 

Alt+F4: Close apps., Win+D: Show or hide the desktop., Win+left arrow or 

Win+right arrow: Snap windows., Win+Tab: Open the Task view. 

 

1.4 Microsoft Basic 2: Creating and Printing Document. 

Using MS Word is a very practical issue. It is therefore important to master how 

to open a document, close a document, save a document, and recover unsaved 

document. Also, skills such as entering and selecting text are important to using 

MS Word. Equally important are skills related to printing a document, using 

pictures and media, and how to insert video in your document. Let us discuss 

them one after the other. 

Opening a document 

The first step in creating a word document begins with the opening of 

the Microsoft Word program. In the menu at the top, click the File menu and 

select the Open option otherwise open the document direct from where you 

saved it on your PC. See below. 
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Figure 2.3: Opening of Word document  

Source: Screenshot  

 

Closing a document 

Click the gray "X" in the upper-right-hand corner. But ensure to save your work 

if you will still use it next time for it is a good practice. See below to see the blue 

arrow pointing where to click to close your document. 

 

 

Figure 2.4: Closing of Word document 
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Source: Screenshot  

 

Saving document 

To save a document, press ctrl S or you click the file button and click the save 

As after which you save the document with whatever name you want to save it 

as and also you have the option to choose whatever file type you want to save 

the document with. See below 

Note the file path you are saving your document to as shown below.  

 

Figure 2.5: Saving of Document Window 

Source: Screenshot  
 

Recovering Unsaved document 

In MS Word, click the File Tab in the upper left. Click Manage Document and 

select Recover Unsaved Documents from the d rop-down list. 

 

Entering Text 

Entering text is always done at the position of the cursor. Any newly-typed 

character is added to the text at the position occupied by the cursor, after which 

the cursor is moved one column to the right. 

Selecting Text 

Selecting is highlighting text or picking an object.  
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Printing Documents Printing to a File. Word allows you to send your output to 

a file instead of to a printer. 

Working with Tabs 

Word inserts a tab character and moves the insertion point to the tab setting, 

called the tab stop. You can set custom tabs or use Word's default tab settings.  

Pictures and Media 

Word allows you to insert pictures into your document. See below. 

 

Figure 2.6: Insertion of pictures window 

Source: Screenshot  

 

Inserting online pictures 

Same procedure as shown above. 

Inserting your pictures from your PC 

Same procedure as shown above. 

How to insert screenshots 

As shown below, you can screenshot your document. 
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Figure 2.7: Inserted screenshot window 

Source: Screenshot  
 

Also you can use screen clipping option, see below

 

Figure 2.8: Screen clipping option 

Source: Screenshot  

 

Inserting online Video 
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Same as seen above from the insert tab. 

 

1.5 Final point to note  

The environment is where we work with word document, a lot of document 

formatting are carried out there. The document is where users interact most of 

the time with text entering and document saving and recovery are done. Also, 

we can print out a document, insert an image from our PC, and we can use 

screenshot. Furthermore, we have been able to learn how to create a document, 

how to close a document, how to save and retrieve a document. Also, we have 

been able to learn how we can print from our PC, from the back view, or by 

pressing the ctrl P key. Also, we (hopefully) now understand how to insert 

images, videos and use screen shoot in your document. 

 

1.6 SUMMARY 

In this Unit, we have been able to understand the title bar, the Ribbon, the touch 

mode, the ruler, the scroll bar, the zoom slides, etc. The first step in creating a 

word document begins with the opening of the Microsoft Word program. 

Printing is an output process that enables us to have a hard copy of our word 

processing activities. We can print from our PC, from the back view, or by 

pressing the ctrl P key.  

Self-Assessment Exercises 

Self-Assessment Exercise 1. What do you understand by the ribbon? 

Self-Assessment Exercise 2. What is the Microsoft environment? 

Self-Assessment Exercise 3: What is the first step in creating a word document? 

Self-Assessment Exercise 4: What is printing in MS Office? 

Self-Assessment Exercise 5 : List at least seven window keywors short you can 

use. 

 

1.7 Glossary 

Ribbon in MS Word: The ribbon is a set of toolbars at the top of the window in 

Office programs designed to help you quickly find the commands that you need 

to complete a task 

MS Environment: The environment is where we work with word document, a 

lot of document formatting are carried out here 

Printing in MS Word: Printing is an output process that enables us to have a 

hard copy of our word processing activities. 
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1.9 Possible Answers to Self-Assessment Exercises (SAEs)  

Self-Assessment Exercise 1. What do you understand by the ribbon? 

Answer to SAE 1: 

The ribbon is a set of toolbars at the top of the window in Office programs 

designed to help you quickly find the commands that you need to complete a 

task 

 

Self-Assessment Exercise 2. What is the Microsoft environment? 

Answer to SAE 2 

The environment is where we work with word document, a lot of document 

formatting are carried out there. 

 

Self-Assessment Exercise 3: What is the first step in creating a word document? 

Answer to SAE 3 

The first step in creating a word document begins with the opening of 

the Microsoft Word program. 
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Self-Assessment Exercise 4: What is printing in MS Office? 

Answer to SAE 4 

Printing is an output process that enables us to have a hard copy of our word 

processing activities. We can print from our PC, from the back view, or by 

pressing the ctrl P key. 

 

Self-Assessment Exercise: List at least seven window keywors short you can 

use. 

Answer to SAE 5 

Here are a list of shortcuts you can always use. They are Basic Windows 

keyboard shortcuts 

1. Ctrl+Z to Undo., 2. Ctrl+W to Close., 3. Ctrl+A to Select all., 5. 

5. Alt+Tab to Switch apps., 6.Alt+F4 to Close apps., 7. Win+D to Show 

or hide the desktop.,8. Win+left arrow or Win+right arrow to Snap 

windows.,9. Win+Tab to Open the Task view. 
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UNIT 2: DRAWING OBJECT, PAGE BACKGROUND, APPLYING 

BULLETS AND NUMBERS 

2.1 INTRODUCTION  

2.2 LEARNING OUTCOMES 

2.3 Drawing Objects,  Page Background  

2.3.1 Drawing Object 

2.3.2  Page Background,  

2.4 Applying Bullets and Numbers 

1.4.1Applying Bullet and Numbers 

1.4.2 Formatting bullet and numbers 

2.5 Selecting of the table object and Deleting cells and Tables 

2.5.1 Selecting of the table object 

2,5,2 Deleting cells and Tables 

2.6 Summary  

2.7. Glossary 

2.8 References/Further Reading  

2.9 Possible Answers to Self-Assessment Exercises (SAEs)  

 

2.1 INTRODUCTION  

 

Having gone through MS Word basics in Unit 1, this unit is intended to take 

students further in their ability to navigate the MS Word environment. You will 

be introduced to drawing an object, page background, and applying for bullets 

and numbers. We will be able to build bullets, apply numbers and tables in our 

document, this is very essential for itemizing points we want people to see 

whenever they receive or see our message or document.  
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2.2 LEARNING OUTCOMES 

At the end of this course, you should be able to  

 

 draw an object on MSWord using insert shapes,  

 use WordArt,  

 format shapes and insert charts. 

 apply watermark on their document, format it 

 create page borders on their document, and apply for bullets and numbers. 

 apply for number in a listed text,  

 create and format a table  

 use merging and splitting effectively.  

2.3 Drawing Objects,  Page Background 

2.3.1 Inserting Shapes 

To add a shape, click Insert, click Shapes, select a shape, and then click and 

drag to draw the shape. See below. 

 

Figure 2.9: Process of inserting shape 

Source: Screenshot  
 

You have many options to design whatever you want with the New Drawing 

canvas as shown below.  
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Figure 2.10: New drawing canvas 

Source: Screenshot  

 

Inserting WordArt 

On the Insert tab, in the Text group, click WordArt, and then click 

the WordArt style that you want. See below 

 

Figure 2.11: Inserting WordArt; Source: Screenshot  
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Formatting Shapes 

To format shapes, click the shape that you want to change after which under 

Drawing Tools, on the Format tab, in the Insert Shapes group, click Edit text. 

See below. 

 

Figure 2.12: Formatting shapes 

Source: Screenshot  

 

Inserting SmartArt 

To insert smartArt, click the insert tab, in the Illustrations group, click SmartArt. 

In the Choose a SmartArt Graphic dialog box, click the type and layout that you 

want. See below 
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Figure 2.12: Inserting SmartArt 

Source: Screenshot  

 

Inserting Charts 

On the Insert tab, in the Illustrations group, click charts. In the Choose 

a chart Graphic dialog box, click the type and layout that you want. As seen with 

the case of SmartArt above. 

2.3.2 Page Background 

2.3.2.1 Applying Watermarks 

To use watermarks, click on the layout tab, select Watermark. In the Insert 

Watermark dialog, select Text and either type your own watermark text or select 

one, like DRAFT, from the list. Then, customize the watermark by setting the 

font, layout, size, colors, and orientation, select OK. See below 
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Figure 2.13: Applying watermarks 

Source: Screenshot  

 

Creating Customs Watermarks 

As shown above. 

Removing watermarks 

Removing watermarks as shown in the image above at the dropdown of the 

watermark tab. 

Applying Page Borders 

To apply page borders, enter the “Page Border” settings menu 

(Layout/Design/Page Layout > Page Borders) and click the “Apply To” drop-

down menu. See below 
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Figure 2.14: Page borders 

Source: Screenshot  
 

2.4  Applying Bullets and Numbering 

2.4.1  Applying Bullets and Numbering 

In your Microsoft document, place your cursor or highlight the text where you 

wish to insert a bulleted list. Under the [Home] tab in the “Paragraph” section, 

click the [Bullets] drop-down menu. Choose a bullet style or select "Bullets and 

Numbering” to create a customized bullet style. See below 
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Figure 2.15: Applying bullets 

Source: Screenshot  

 

 

 

Figure 2.16: Applying numbers;  

Source: Screenshot  
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2.4.2 Formatting Bullets and Numbering 

As seen previously you can also format bullets and number an item on your 

document, Select the bulleted list that you want to format. , and then click Bullets 

and Numbering. Click on the style that you want. Click the button 

under Customize, and then click the bullet style that you want. 

Creating a table 

To do this, Click Insert > Tables > Insert Table from the dropdown menu. In 

the Insert Table dialog box, enter the number of columns and rows you want in 

this table. You can also draw tables as displayed   in Fig……… 

 

Figure 2.17: Tables 

Source: Screenshot  
  

2.5 Selecting of the table object and Deleting cells and Tables 

2.5.1 Selecting of the table object 

To select an entire table, move your mouse over the table until you see 

the table selection icon in the upper-left corner of the table and click on it 

to select the table. When working within a table, the Table Tools tab appears in 

the Ribbon and includes the Design and Layout tabs. See below 
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Figure 2.18: Table objects 

Source: Screenshot  

 

Inserting and deleting columns and rows 

To do this, click a row or cell in the table, and then click the Table Layout tab. 

Under Rows & Columns, click insert or Delete Rows. See below 
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Figure 2.19: Colunm and rows  

Source: Screenshot  

 

2.5.2 Deleting cells and Tables 

Position the insertion point in the cell you want to delete. And click OK. See 

below 

 

Figure 2.20: Cells and tables 

Source: Screenshot  

 

Merging and Splitting cells 

You can split and merge cells in a table. Splitting cells is similar to adding a 

row or column, but it all takes place in one cell instead of a group 

of cells. Merging cells, however, is similar to deleting a cell and then adjoining 

it with a neighboring cell. See below 
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Figure 2.21: Splitting cells 

Source: Screenshot  
 

 

 

Figure 2.22: Merging of cells 

Source: Screenshot  
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2.6 SUMMARY  

 

At the end of this Unit, you have hopefully been acquainted with  how to add 

watermark to your document and custom watermark to your document. You have 

also seen how you can apply borders to your document. You have also seen how 

to use shapes, WordArt, how to format shapes, and also include charts on your 

document. You can apply bullets and number text in your document. Hopefully, 

you also can create tables and insert new rows and columns in your tables. 

 

Self-Assessment Exercises (SAEs) 

1. Where can we locate the shape Element on our Word Environment? 

2. What is WordArt used for? 

3. Where is the watermark Element located? 

4. How can you customize a watermark of your choice? 

5. How can we apply bullets to out text? 

6. How can we apply numbering to out text? 

7. How can we create tables and split them and also merge them on MS word? 

 

2.7 Glossary 

Watermark in MS Word: The image or text that appears behind the main 

document. 

WordArt: A fast way to make text to appear special or achieve special effects. 

 

2.8 REFERENCES/FURTHER READING  
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Velsoft Training Materials, Inc. (2020). Microsoft Word 365:  ( Instructor guide) Part 

 1.  Velsoft Training Materials. 

 

2.9 Possible Answers to Self-Assessment Exercises (SAEs)  

SAE 1. Where can we locate the shape Element on our Word Environment? 

Answer to SAE 1 

To locate the shape element click Insert, click Shapes, select a shape, and then 

click and drag to draw the shape 

 

SAE 2. What is WordArt used for? 

Answer to SAE 2 

The WordArt is used to create decorative effects or add special text effects to 

one’s documents or publications. 

 

SAE 3. Where is the watermark Element located? 

Answer to SAE 3 

The watermart element is located on layout tab. To use watermarks, click on 

the layout tab, select Watermark 

 

SAE 4. How can you customize a watermark of your choice? 

Answer to SAE 4 

In the Insert Watermark dialog, select Text and either type your 

own watermark text or select one, like DRAFT, from the list. Then, customize 

the watermark by setting the font, layout, size, colors, and orientation, select 

OK. 

 

SAE 5. How can we apply bullets to out text? 

Answer to SAE 5 

In your Microsoft document, place your cursor or highlight the text where you 

wish to insert a bulleted list. Under the [Home] tab in the “Paragraph” 

section, click the [Bullets] drop-down menu. Choose a bullet style or select 

"Bullets and Numbering” to create a customized bullet style. 

 

SAE 6. How can we apply numbering to out text? 

Answer to SAE 6 

In your Microsoft document, place your cursor or highlight the text where you 

wish to insert a number list. Under the [Home] tab in the “Paragraph” section, 

click the [Number] drop-down menu. Choose a number style or select 

"Numbering” to create a customized number style 
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SAE 7. How can we create tables and split and also merge cells on MS word? 

 

Answer to SAE 7 

 

a) To create:To create a table, Click Insert > Tables > Insert Table from 

the dropdown menu. In the Insert Table dialog box, enter the number of 

columns and rows you want in this table 

b) To split or merge cells: You can split and merge cells in a table. Splitting 

cells is similar to adding a row or column, but it all takes place in 

one cell instead of a group of cells. Merging cells, however, is similar to 

deleting a cell and then adjoining it with a neighboring cell. 
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UNIT 3: DOCUMENT VIEW AND BASIC EDITING SKILLS 

3.1 INTRODUCTION  

3.2 LEARNING OUTCOMES 

3.3 Document View 

3.3.1 How to change document view 

3.3.2 How to hide Ruler and show it 

3.3.3 How to zoom the document 

3.4 Working in new document in a new window 

3.4.2 Working with word file format 

3.4.3 Deleting Text 

3.4.4 Cutting, Copying and Pasting 

3.4.5 Undoing and Redoing actions in word 

3.4.6 Finding and replacing text 

3.4.7 Selecting text and objects 

3.5 Basic Proofing Tools 

3.5.1 Spelling and Grammar Tools 

1.5.1 Formatting Paragraphs and Document Layout 

3.5.2 How to use the Thesaurus 

3.5.3  Font Formatting 

 

3.5.4 Font Dialog Box 

3.5.5 Formatting Paragraphs and Document Layout  

3.5.5.1 Aligning Paragraphs 

3.5.5.2 Line Spacing and Paragraph spacing 



 70 

3.5.5.3 Setting Page and Section Breaks 

3.5.5.4 Creating columns in a document 

3.5.5.5  Using Headers and footers 

 

3.5.5.6 Page setup dialog box 

3.5.5.7 Setting margins 

3.5.5.8  Layout settings 

3.6 Summary  

3.7 Glossary  

3.8 References/Further Reading  

3.9 Possible Answers to Self-Assessment Exercises (SAEs)  

 

3. I INTRODUCTION  

 

This Unit will introduce you to document viewing and editing skills which are 

essential skills to have when working with a document to effectively optimize 

MSWord. This Unit will also familiarise you with basic proofing tools and how 

to format paragraphs essential features of document layout. 

 

 

3.2 LEARNING OUTCOMES 

 

At the end of this unit students should be able to; 

 use ruler and toggle between showing and hiding it,  

 know how to zoom a document and how to split windows.  

 align paragraphs to either left, right, or center,  

 use the line spacing.  

 use header and footer in their document. 
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3.3 Document View 

3.3 .1 How to change document view 

Click the View tab and then click the view you want to use, such as Print Layout 

or Draft view. See below 

 

Figure 2.23: Document view 

Source: Screenshot  

 

3.3.2 How to hide Ruler and show it 

You can show and hide both rulers simultaneously by repeatedly clicking/ 

toggling on Ruler in the Show section, under the View tab in the top menu bar. 

See below 
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Figure 2.24: Rulers 

Source: Screenshot  

 

3.3.3 How to zoom the document 

To do this, Select the View menu bar at the top of the screen, and select Zoom. 

Select your Zoom level.  See below 
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Figure 2.25: How to zoom 

Source: Screenshot  

 

3.4 Working in new document in a new window 

3.4.1 To open a document in a new document in a new window 

To do this, click the VIEW tab in the Window group, click New Window. See 

below 

 

Figure 2.26: Open document in a new view 

Source: Screenshot  

 

 3.4.2 How to split in window  

Same process as indicated above from the view Tab. 

Working with word file format 

You will see this option when you want to Save As. See below 
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Figure 2.27: Word file document 

Source: Screenshot  

 

3.4.3 Deleting Text 

To delete a text, click on backspace at the end of the text or highlight it and press 

the delete key. 

3.4.4 Cutting, Copying and Pasting 

To cut, copy and paste, highlight the text you want to perform this task on and 

right click your mouse or you use the shortcuts, like ctrl C for copy, ctrl V to 

paste.   See below 
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Figure 2.28: Cutting, copyiny and pasting 

Source: Screenshot  

 

3.4.5 Undoing and Redoing actions in word 

Ctrl Z for undoing and Ctrl Y for redoing  

3.4.6 Finding and replacing text 

Using crtl F to find and crtl H to Replace or you use the icon under editing ribbon 

at the top left. See below.  
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Figure 2.29: Find and replace text 

Source: Screenshot  

 

3.4.7 Selecting text and objects 

This has to do with highlighting of text or an object. 

3.5 Basic Proofing Tools 

3.5.1 Spelling and Grammar Tools 

Click File > Options > Proofing, clear the Check spelling as you type box, and 

click OK. To turn spell check back on, repeat the process and select the 

Check spelling as you type box. To check spelling manually, click Review 

> Spelling & Grammar. See below. You can choose to do it this way from the 

file option display below 
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Figure 2.30: Spelling and grammar cheking 

Source: Screenshot  

 

Or from the review> spelling and Grammar option, see below. 
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Figure 2.31: Spelling and grammar option 

Source: Screenshot  

 

3.5.2 How to use the Thesaurus 

Same way as the spelling and Grammar, you can use the Thesaurus in the 

proofing section.  

3.5.3  Font Formatting 

Formatting text in Microsoft Word involves tasks like bolding the text, 

italicising it, and changing the font and size. The commands to perform all of 

these formatting tasks are found on the Home tab in the Font group. Select 

your text and then click on the required formatting button to see the effects or 

highlight it and right-click to see options.  To do the former, select an option to 

change the font, font size, font color, or make the text bold, italic, or underline. 

See below 

 

Figure 2.32: Font formatting dialogue box 

Source: Screensho 
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3.5.4 Font Dialog Box 

Just as the image above, the Font dialog box contains all the commands for 

formatting text, including quite a few that didn't find their way into 

the Font group on the Ribbon. See below 

 

Figure 2.33: Font dialogue box 

Source: Screenshot  

 

3.5.5 Formatting Paragraphs and Document Layout  

3.5.5.1 Aligning Paragraphs 

To do this, select the text that you want to align. on the Home tab, in the 

Paragraph group, click Align Left or Align Right or Center or Justify. Align left 

is the default one.  See below 
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Figure 2.34: Aligning dialogue box 

Source: Screenshot  

 

3.5.5.2 Line Spacing and Paragraph spacing 

Line spacing determines the amount of vertical space between lines of text in 

a paragraph.  Paragraph spacing determines the amount of space above or below 

a paragraph.    To do this, select the paragraphs you want to change. go to Home 

> Line and Paragraph Spacing, after which you choose the number of line spaces 

you want or select Line Spacing Options, and then select the options you want 

under Spacing. See below 
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Figure 2.35: Line spacing and paragraphing box 

Source: Screenshot  

 

3.5.5.3 Setting Page and Section Breaks 

Go to Layout > Breaks, and then choose the type of section break you want. 

Next Page Starts the new section on the following page. Continuous Starts the 

new section on the same page. See below 
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Figure 2.36: Page and section break 

Source: Screenshot 

3.5.5.4 Creating columns in a document 

Select the Layout tab, then click the Columns command. A drop-down menu will 

appear. Select the number of columns you want to create. The text will format 

into columns. See below 
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Figure 2.37: Creating columns; Source: Screenshot  

 

3.5.5.5  Using Headers and footers 

To do this, go to Insert > Header or Footer. choose the header style you want to 

use. Tip: Some built-in header and footer designs include page numbers. Add or 

change text for the header or footer then select Close Header and Footer or press 

Esc to exit. See below 
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Figure 2.38: Header and footer 

Source: Screenshot  

 

3.5.5.6 Page setup dialog box 

First, click the Layout tab, click the dialog box launcher in the lower-right corner 

of the Page Setup group, the Page Setup dialog box appears, Margins tab 

forward. Then you type the margin offsets in the Top, Bottom, Left, and Right 

boxes. Or you can use the spinner gizmo to set the values.  Use the Preview to 

check the margins as they relate to page size.  Ensure that the Whole Document 

is chosen from the Apply to menu button. You can reset margins for only a 

section or selected text if you instead choose those options from the menu. Click 

the OK button to confirm your new settings and close the Page Setup dialog box. 

See below 

 

Figure 2.39: Page set up dialogue box 

Source: Screenshot  

 

3.5.5.7  Setting margins 

Just as shown in the above picture, the margin is also in the page setup. See 

below. 
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Figure 2.40: Margins 

Source: Screenshot  

 

3.5.5.8  Layout settings 

See this on the page Setup > Orientation, you can either choose portrait or 

landscape. 

 

3.6 SUMMARY  

We have studied how to change document view, how to toggle the ruler, how to 

zoom a document, how to split our window, and how to select an object. We 

have examined how to use the spelling and Grammer Tools, how to format fonts, 

and about the font dialog box. We have also looked at how to align a paragraph, 

how to use the line spacing, and setting page layout. Also learned how to use 

margin for our document. Finally, we must know how to work with file formats, 

how to zoom documents, and delete and copy text as the case may be. 

Understanding how to use proofing tools are essential to maximize the usage of 

MS Word for writing. Basic formatting of text is pivotal to bringing the beauty 

of your writing to MS Word. Formatting of the paragraph makes our work look 
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professional, to accomplish that we need to align our paragraphs, we need to 

learn how to do page setup, how to set our layout.   

Self-Assessment Exercises (SAEs) 

1. Where is the Thesaurus located? 

2. How can we change the fonts of a Text? 

3. What is the process of opening a new document? 

4. How do you toggle the ruler? 

5. How do you work with copy and pasting?  

6. How do you replace s text in a document? 

7.  How are actions undone and redone in MS Word document? 

8. Where is orientation located? 

9. How can you change the orientation of your document? 

 

3.7 Glossary 

Thesaurus: This is a facility available and used in Microsoft Word to find out 

synonyms and synonyms for a particular selected word. Authors are able to use 

it to find exact and suitable words to express their idea 

Page orientation: This concept refers to “the direction in which a document is 

displayed. It is of two types; portrait (vertical) and landscape (horizontal). The default 

orientation is portrait; it can be changed to landscape by following these steps; Select 

the Page Layout tab. Locate the Page Setup group”. 

Font: “The word font refers to a set of printable or displayable typography or 

text characters in a specific style and size. Font styles are used in both print and 

digital text” 

Undo: This is a process of canceling an action in MS Word. 

Redo: This is the process of doing again an undone action in MS Word 

 

3.8 REFERENCES/FURTHER READING  

Bucki, Lisa A. et. al.(2013). Microsoft Word 2013 Bible: the 

 comprehensive tutorial resource. Indianapolis: Wiley. 

Foulkes, L.(2020). Learn Microsoft office 2019: a comprehensive guide 

 to getting started with Word, PowerPoint, Excel Access, and 

 Outlook. Birmingham: Packt publishing. 

Gookin, D. (2013).Microsoft Word 2013 for dummies. New Jersey: Wiley. 
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Lambert, J. & Cox, J.(2010). Microsoft Word 2010 step by step. 

 Washington:  Microsoft Press. 

Murray, K. (2010). Microsoft Word 2010 inside out. Washington: 

 Microsoft Press. 

Murray, K. (2010). Microsoft Word 2010 Plain  & Simple. California: 

 O’Reilly. 

Murray, K.(2010). Microsoft Word 2010 inside out. Washington: 

 Microsoft Press 

VanHuss, Susie H. et.al (2017). Keyboarding & Word Processing: 

 complete course, Microsoft Word 2016, Lesson 1-110 20e. 20 ed. 

 Boston: Cenage. 

VanHuss, Susie H. et.al (2017). Advanced Word Processing Lesson 56-

 110: Microsoft word 2016. 20 ed. Boston. Cenage. 

Velsoft Training Materials, Inc. (2020). Microsoft Word 365:  ( Instructor 

 guide) Part 1.  Velsoft Training Materials. 

3.9 Possible Answers to Self-Assessment Exercises (SAEs) 

SAE 1: Where is the Thesaurus located? 

Answer to SAE 1 

The thesaurus is located under the review section of MS Word. 

SAE 2: How can we change the fonts of a Text? 

Answer to SAE 2 

The commands to perform all of these formatting tasks are found on the Home 

tab in the Font group. Select your text and then click on the 

required formatting button to see the effects or highlight it and right-click to 

see options.  Select an option to change the font, font size, font color, or make 

the text bold, italic, or underline 

SAE 3: What is the process of opening a new document? 

Answer to SAE 3 
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It is assumed that you are working on an open word file. First click on the file 

menu. Secondly, click on the “New” in the drop down and elect from one of 

the templates/blank document to open a new document. 

SAE 4: How do you toggle the ruler? 

Answer to SAE 4 

You can show and hide both rulers simultaneously by repeatedly clicking/ 

toggling on Ruler in the Show section, under the View tab in the top menu bar. 

SAE 5: How do you work with copy and pasting?  

Answer to SAE 5 

First highlight the text you what copied and pasted. Then click on the copy 

menu. After this move your cursor to the place on the document you want it 

pasted and click the paste menu. 

SAE 6: How do you replace s text in a document? 

Answer to SAE 6 

Using crtl F to find and crtl H to replace or you use the icon under editing 

ribbon at the top left. 

SAE 7: How are actions undone and redone in MS Word document? 

Answer to SAE 7 

At the right hand side of MS Word click on the undo icon and to redo an action 

click on the redo icon. Alternatively use Ctrl Z for undoing and Ctrl Y for 

redoing  

SAE 8: Where is orientation located? 

Answer to SAE 8 

The page orientation is located under the page layout of MS Word. 

SAE 9: How can you change the orientation of your document? 

Answer to SAE 9 

See this on the page Setup > Orientation,. You can then either choose 

portrait or landscape. 
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MODULE 3: PRESENTATION PACKAGE: POWERPOINT 

UNIT 1: INTRODUCTION TO POWERPOINT 

UNIT 2:  USES OF TEXTS AND PICTURES IN POWERPOINT   

By completing this module: 

 You should be able to work with Microsoft powerpoint. 

 You should be quick in carrying out presentation tasks given to you with 

ease. 

 Be acquainted with powerpoint. 
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UNIT 1: INTRODUCTION TO POWERPOINT 

1.1 Introduction  

1.2 Learning Outcomes 

 

1.3 Definition of PowerPoint and Description of its Operating Environment 

1.3.1 Definition of PowerPoint 

1.3.2 Description of Powerpoint Operating Environment 

 

1.4 Creating Basic PowerPoint Presentation  

1.4.1 Opening Presentation 

1.4.2 Closing PowerPoint Presentation 

1.4.3 Creating New Presentation  

1.4.4 Saving Presentations 

1.4.5 Inserting New Slides and Slide Layouts 

1.4.6  Sharing presentations 

 

1.5 Views in PowerPoint 

1.5.1 Sorter View and Reading View 

1.6 Summary  

 

1.7 Glossary 

 

1.6  References/Further Reading 

  

1.7 Possible Answers to Self-Assessment Exercises (SAEs) 

 

1.1  INTRODUCTION  

This Unit introduces you to the most versatile application package used for the 

presentation of information; and ideas to a large audience. The beauty of it is that 

It comes with a slide show. We will be creating a basic powerpoint presentation. 

We will be launching our first powerpoint slide. We will be introduced to the 

various viewpoint in powerpoint.  

 

1.2 LEARNING OUTCOMES  

At the end of this Unit, students should be able to: 

 

 understand the PowerPoint environment,  
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 use the file back view and the Ribbon alongside the Title bar. 

 create a New presentation, how to save their presentation,  

 know how to insert New Slides, Share Presentations; 

 and lastly, understand how to apply slides layouts. 

 understand various viewpoints in powerpoint and these includes; Normal 

view, outline View, Slide Sorter View, Note page View, and Reading View 

1.3 Definition of PowerPoint and Description of its Operating Environment 

1.3.1 Definition of PowerPoint 

PowerPoint is a graphics presentation package that enables you to create 

formatted presentations which can be used in some ways. You can produce 

projects such as overheads for a tea briefing, slides for a business meeting, or 

interactive onscreen presentations on your company’s products. For our 

discussion here we will use PowerPoint 2010.PowerPoint 2010 allows you to 

create presentations for printing or online viewing using a variety of tools. The 

range of tools from wizards in the package helps you with the content, look and 

feel of your presentation, and the animation tools used to create moving images. 

Whatever, your presentation style is, PowerPoint has tools and enhancements to 

make your presentation easy and professional looking. 

 

1.3.2 PowerPoint Environment 

The PowerPoint window contains many features that look like the ones in 

Microsoft Office programs. These features include the Office button, Quick 

Access toolbar, Title bar, Tabs, scroll bars, and a Status bar. Search for 

PowerPoint on your search icon below is the image. 
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Figure 3.1: Powerpoint environment 

Source: Screenshot  

 

After launching the powerpoint app on your pc as followed in the image above, 

you should see this below. Click on the Blank presentation.  
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Figure 3.3:Blank presentation window  

Source: Screenshot  

 

TITLE BAR 

The Title bar is located at the top in the center of the PowerPoint window. 

The Title bar displays the name of the presentation on which you are currently 

working. 
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Figure 3.4: Title bar window 

Source: Screenshot  

 

The Ribbon 

The Ribbon is Microsoft's primary user interface gadget. It is the strip of labels, 

which PowerPoint calls tabs, that runs across the top of the PowerPoint window.
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Figure 3.5: Ribbon bar 

Source: Screenshot  

 

File and Back view 

You can access the Backstage view simply by clicking on the File tab. This is 

the area where files and data about them is managed— creating, saving, printing, 

sending to others, inspecting for hidden metadata or personal information, and 

setting options. 

 

Figure 3.6: Backstage view 

Source: Screenshot  

 

1.4 Creating Basic PowerPoint Presentation  

This section of the Unit is intended to address some practical aspects of the 

PowerPoint application package. Let us begin with how to open a PowerPoint 

presentation 

 

1.4.1 Opening Presentation 
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First opening a presentation means you already have a powerpoint presentation 

on your PC, so to do this, click the File tab, then click Open. To see files saved 

in Open Document format in the File of type list, click Open Document 

Presentation. Click the file you want to open and click open, you can also double 

click it.  

 

Figure 3.7: Opening presentation window 

Source: Screenshot  

 

Double click the already existing Presentation. 
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Figure 3.8: Opening an existing presentation 

Source: Screenshot  

 

1.4.2 Closing Presentation 

Click the Close Window button (the X) in the presentation window. 

 

Figure 3.9: Closing presentation 

Source: Screenshot  

 

1.4.3 Creating New Presentation  

To do this, open PowerPoint. Select an option: Select 

Blank Presentation to create a presentation from scratch. 
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Figure 3.10: New presentation windon 

Source: Screenshot  

 

1.4.4 Saving Presentations 

Saving for the first time, click the File tab, select Save As, below the Save As 

under Recent Folder, select Browse, pick the file path and the folder you want to 

save it into and then name your file. After saving as type with the file format you 

want. Select Save. 
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Figure 3.11: Saving presentation 

Source: Screenshot  

 

Notice the default name of the presentation above with a red arrow and notice it 

when it changes after saving it. 

 

Figure 3.12: Default name of presentation 

Source: Screenshot  
 

After clicking the Save As, you will see the Browse and click it, it will take you 

to a dialog box as seen below. 
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Figure 3.13: Saving presentaion 

Source: Screenshot  

 

You can choose to save it wherever you want as seen below. 

 

Figure 3.14: Choosing where to save presentation 

Source: Screenshot  
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1.4.5 Inserting New Slides and Slide Layouts 

Click the New Slide dialog box, select the layout that you want for your 

new slide as seen below. 

 

Figure 3.15: Inserting new slide 

Source: Screenshot  
  

1.4.6  Sharing presentations 

To share your PowerPoint, click the top right of the ribbon, select the share, and 

select Invite people. After entering the email address of the people or person you 

wish to share your presentation with. See below. 
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Figure 3.16: Sharing presentation 

Source: Screenshot  

 

1.5 Normal View and other various views 

It is the standard view used for creating and viewing presentation slides. 

This view is also known as Slide View. Check out VIEWS for all View 

Options. 

 

Figure 3.17: Normal view window 

Source: Screenshot  
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1.5.1 Sorter View and Reading View 

See below 

 

 

Figure 3.18: Sorter and reading view 

Source: Screenshot  
 

1.6 SUMMARY  

We have explored how we can create a new slide, how to save slides, how to 

close slides, how to share our presentation, and how to apply new slides to our 

presentation. PowerPoint is used for presentation, we can presentation of 

information to an audience. Finally, we have seen how the Powerpoint 

Environment works using the Title Bar, the Ribbon, and the File and Back view. 

In conclusion, wherever you open a powerpoint presentation it is expected that 

we close our work but then we first understand that documents or files not saved 

can be lost hence it is a good practice to save your work whenever you made any 

changes.  

SELF-ASSIGNMENT EXERCISES  (SAEs) 

1. What is the icon sign to close a presentation? 

2. What is the process to save a presentation for the first time? 

3. How can you insert new slides? 

4. How do you make a presentation in PowerPoint? 

5. What is powerpoint? 

6. What is powerpoint Environment? 

7. Where is the backstage view located? 

8. What are the various Viewpoints in PowerPoint? 
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9. What is the Reading Viewpoint used for? 

 

1.7 Glossary 

Microsoft PowerPoint: A presentation programme created by Robert Gaskins 

and Dennis Austin. 

Normal view: The PowerPoint presentation viewed in its normal format. 

PowerPoint Animation: This is used to create games or movies 

PowerPoint Deck: Describes the slides that can be built on the PowerPoint 

platform. 

PowerPoint Slide Show: A process that allows users to add  audiovisuals 

qualities to their presentations. 

Reading View: It is used to view the content of the presentation as if you are 

using the slide show view but withing the frame of the application window 

compared yo the full screen. 

 

1.8 REFERENCES/FURTHER READING  

Bucki, Lisa A. et. al.(2013).Microsoft office 2013 Bible: the comprehensive tutorial 

 resource. Indianapolis: Wiley. 

Cox, J.(2010).Microsoft PowerPoint 2010 step by step. Washington: Microsoft press. 

Cox, J., Lambert, J. & frye, C. (2011). Microsoft office: professional 2010 step by step. 

 Washington: Microsoft press. 

Foulkes, L.(2020). Learn Microsoft office 2019: a comprehensive guide to getting 

 started with Word, PowerPoint, Excel Access, and Outlook. Birmingham: 

 Packt publishing. 

Lambert, J. (2015).Microsoft PowerPoint 2016 step by step. Washington: Microsoft 

 press. 

Lowe, D.(2019). Microsoft PowerPoint 2019 for dummies. New Jersey: Wiley. 

Wempen, F. (2013).Microsoft PowerPoint 2013 Bible. Indianapolis: Wiley. 

 

1.9 POSSIBLE ANSWERS TOSELF-ASSIGNMENT EXERCISES 

(SAEs) 
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SAE 1: What is the icon sign to close a presentation? 

 

Answer to SAE 1: 

 

The icon sign to close a PowerPoint presentation is X, especially if you have 

multiple presentations open. 

 

SAE 2: What is the process to save a presentation for the first time? 

 

Answer to SAE 2: 

 

To save a presentation for the first time, click the File tab, select Save As, below 

the Save As under Recent Folder, select Browse, pick the file path and the 

folder you want to save it into and then name your file. After saving as type 

with the file format you want. 

 

SAE 3:How can you insert new slides? 

 

Answer to SAE 3; 

 

To insert a new slide, click the New Slide dialog box, select the layout that you 

want for your new slide 

 

SAE 4: How do you make a presentation in PowerPoint? 

Answer to SAE 4: 

To do this, open PowerPoint. Select an option: Select 

Blank Presentation to create a presentation from scratch. 

 

SAE 5: What is powerpoint? 

 

Answer to SAE 5: 

 

PowerPoint is a graphics presentation package that enables you to create 

formatted presentations which can be used in some ways. You can produce 

projects such as overheads for a tea briefing, slides for a business meeting, or 

interactive onscreen presentations on your company’s products. 

 

SAE 6: What is powerpoint Environment? 

 

Answer to SAE 6 

 

The PowerPoint environment contains many features that look like the ones 

in Microsoft Office programs. These features include the Office button, Quick 

Access toolbar, Title bar, Tabs, scroll bars, and a Status bar. 
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SAE 7: Where is the backstage view located? 

 

Answer to SAE 7: 

The backstage view is located in the File tab on the ribbon. To access this view, 

click the File tab on the Ribbon. 

 

 

SAE 8: What are the various Viewpoints in PowerPoint? 

 

Answer to SAE 8: 

The various viewpoints in powerpoint include the normal, slide sorter, reading, 

slide master, handout master and note master notes views. 

 

SAE 9: What is the Reading Viewpoint used for? 

 

Answer to SAE 9: 

The Reading View is used to view the content of the presentation as if you are 

using the slide show view but with the frame of the application window 

compared you the full screen 
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UNIT 2 USING TEXT IN POWERPOINT AND USING PICTURES 

IN POWERPOINT 

2.1 Introduction  

2.2 Learning Outcomes 

  

2.3 Using Text in PowerPoint and Using Pictures in PowerPoint 

2.3.1 Adding text slides 

2.3.2 Inserting pictures saved on your PC 

2.3.3 Inserting Online Pictures 

2.3.4 Using PowerPoint Picture Tools 

 

2.4 Printing, Animations, Video, Inserting of Video, Themes, Settings of Slides 

2.4.1 Running a slide show 

  2.4.2 Using custom shows 

  2.4.3 Changing slide size 

 

2.5 Setting up Your Presentation and Inserting Charts, Objects, and Tables 
2.5.1 Inserting charts 

2.5.2 Inserting objects 

2.5.3 Inserting tables 

 
2.6 Summary 

  

2.7 Glossary 

 

2.8 References/Further Reading 

 

2.9 Self-Assignment Exercises (SAEs)  

 

2.1   INTRODUCTION  

Text and pictures are used in powerpoint often to convey a message. We must 

understand how to manipulate the image using the powerpoint picture tools. 

Whenever you are done with your powerpoint document you can choose to 

print it out and also you can also have your powerpoint animated.  

 

2.2 LEARNING OUTCOMES  

At the end of this Unit, students are expected to  

 

 know how to use text on powerpoint; how to format a paragraph,  

 how to insert pictures saved on your PC, 

  how to use online pictures and lastly  
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 how to use the picture tools 

 know how to print a powerpoint presentation,  

 how to use animations in their presentation, and  

 how to set a slide show. 

 

2.3 Using Text in PowerPoint and Using Pictures in PowerPoint 

 

2.3.1 Adding text slides 

On the slide, click the location where you want to add the text box. Type or paste 

your text in the text box. As seen  in Fig………. 

 

Figure 3.19: Text addition window 

Source: Screenshot  

 

 

Highlight the text you want to format, right-click on it and make whatever 

formatting you want for your text as seen below 
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.  

Figure 3.20:Text formatting window 

Source: Screenshot  

 

2.3.2 Inserting pictures saved on your PC 

To do this, click where you want to insert the picture on the slide after which 

you click, insert then will see a dropdown to Pictures.In the dialog box that 

opens, browse to the picture that you want to insert, click that picture, and then 

click Insert as seen below. 
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Figure 3.21: Inserting picture from PC 

Source: Screenshot  

 

Next, select any document of your choice as seen below.

 

 

Figure 3.22: Document selection window 

Source: Screenshot  
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Here is the output….

 
 

 

Figure 3.23: Selection output window 

Source: Screenshot  

 

2.3.3 Inserting Online Pictures 

Same process as inserting from your PC 
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Figure 3.24: Inserting online picture window 

Source: Screenshot  

 

2.3.4 Using PowerPoint Picture Tools 

PowerPoint allows you to change the picture style and shape, add a border, crop 

and compress pictures, add artistic effects, and more. With this, you can do a lot 

with your desired image. 
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Figure 3.25: Powerpoint picture tools 

Source: Screenshot  

 

2.4 Printing, Animations, Video, Inserting of Video, Themes, Settings of 

Slides  

2.4.1 Running a slide show 

Click the Start from Beginning command on the Quick Access Toolbar, or press 

the F5 key at the top of your keyboard. The presentation will appear in full-

screen mode as seen below.

 
 

Figure 3.26: Starting slide show  

Source: Screenshot  

 

2.4.2 Using custom shows 

Same process as the slide show with a click to the Custom show, and then click 

the custom show that you want as seen below.  
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Figure 3.27: Custom show 

Source: Screenshot  

 

2.4.3 Changing slide size 

Open your PowerPoint presentation to begin and then click the “Design” tab 

on the ribbon bar. In the “Customise” section of the “Design” tab, select the 

“Slide Size” button. This will display the two common slide sizes in a drop-

down menu. See below. 
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Figure 3.28: Choosing slide size 

Source: Screenshot  

 

2.4.4 Setting slide header and footer 

 

In the Header and Footer box, on the Slide tab, select the Footer check box, 

and then type the footer text that you want. Click Apply to All. See below. 
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Figure 3.29: Setting slide header and footer 

Source: Screenshot  

 

2.4.5  Previewing and printing presentations in powerpoint 

Click on the file at the top left and it will take you to where you will see print. 

Click print to preview and print as shown below. 
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Figure 3.30: Preview of presentation 

Source: Screenshot  

 

2.4.6 Adding slide Transition Animation 

Select the object you want to animate. Choose the Animations tab. Click the 

Custom Animation button. The Custom Animation pane appears. Click 

the Add Effect button. A menu appears. Choose the type of effect you want. A 

submenu appears. Click the effect you want. See below. 

 

Figure 3.31: Slide transition animation 

Source: Screenshot  

 

2.4.7 Adding Object Animation 

This is done by picking more than one item which makes an object. Press Ctrl 

and select the objects you want.  Select Format > Group > Group to group 

the objects . Select Animations and choose an animation. Applicable just as the 

image above. 

 

2.4.8 Inserting video and sounds 

From insert from the top right corner, click Video > Video on My PC. find 

the video you want to add and click “Insert”. See Fig……   
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Figure 3.32: inserting video and sound 

Source: Screenshot  

 

Next. 

 

Figure 3.33: inserting video and sound 

Source: Screenshot  
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Output for your video 

 

Figure 3.34: Video output 

Source: Screenshot  

 

2.4.9 Inset audio 

Same process with the video as seen above 

2.4.10 Recording a sound 

As seen below 
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Figure 3.35: Sound recording 

Source: Screenshot  

 

2.4.11 Recording your screen 

See below 
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Figure 3.36: Screen recording 

Source: Screenshot  

 

2.4.12  Applying themes 

Select the Design tab on the Ribbon, then locate the Themes group. See below. 

 

Figure 3.37: Applying themes 

Source: Screenshot  

 

Note: All this can be done following the above method 

 Creating custom themes 

Creating custom color schemes 

Creating a custom slide background 

 Setting up your presentation 

Setting up your slide show 
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From the slide show you can choose from any of your choice that befits your 

presentation, you can also time your show.

 

Figure 3.38: Timing slide show 

Source: Screenshot  

 

2.5 Presentation Setup And Insertion of Charts, Objects  and 

 Tables 

From the slide show you can choose from any of your choice that befits your 

presentation, you can also time your show. 
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Figure 3.39: Stting up presentation 

Source: Screenshot  

 

2.5.1 Inserting charts 

 

Click Insert > Chart then Click the chart type and then double-click the chart you 

want. 
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Figure 3.40: Insertin charts 

Source: Screenshot  

 

2.5.2 Object 

Objects are any elements that you can add in PowerPoint 2019. A text label is 

an object. An image is an object. Graphs and charts are objects. 

2.5.3 Table 

You can input this in two ways as you can see below. 

 
 

Figure 3.41: Inserting tables 

Source: Screenshot  
 

Second method as seen below: 
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Figure 3.42: Inserting tables 

Source: Screenshot  

 

2.6 SUMMARY  

You have learned how to format a paragraph, how to insert pictures saved from 

your PC, how to insert pictures from online, and how to use the picture tools in 

PowerPoint. At the end of this Unit, you have seen how to print out Powerpoint 

documents, how to use animation, and how to use themes and also how to set 

our slides. Skills on how to set up our presentation and insert tables and charts 

to our presentation are critical to optimal use of tools of PowerPoint application 

package. In conclusion PowerPoint has the features of editing your text, it also 

gives the flexibility of inputting pictures from your PC and also gives you the 

option to use pictures online. Understanding how to print your slides is pivotal 

in this course. Also you see how you can use animation and also set our slides 

here. You have seen how you can make your presentation and insert objects and 

tables into your presentation. 

 

SELF-ASSIGNMENT EXERCISES (SAEs) 

1. How can you insert a picture from your PC into a slide? 

2. How do you insert an online picture into your slide? 

3. How do you print a slide? 

4. How do you animate an object? 
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5. How do you use themes?  

6. How do you set up a presentation? 

7. How do you insert a table into a presentation? 

8. How do you insert charts into a presentation? 

 

2.7 Glossary 

Animations: They are visual effects for the objects in your PowerPoint 

presentation  

 

An entrance animation: Is an animation that brings something onto the slide.  

 

Objects: Objects are any elements that you can add in PowerPoint. A text label 

is an object. An image is an object. Graphs and charts are objects. 

Theme: ”A theme is a predefined set of colors, fonts, and visual effects that you 

apply to your slides for a unified, professional look” 

Transition: A slide transition is the visual effect that occurs when you move 

from one slide to the next during a presentation.  

 

2.8 REFERENCES/FURTHER READING  

Bucki, Lisa A. et. al.(2013).Microsoft office 2013 Bible: the comprehensive tutorial 

 resource. Indianapolis: Wiley. 

Cox, J.(2010).Microsoft PowerPoint 2010 step by step. Washington: Microsoft press. 

Cox, J., Lambert, J. & frye, C. (2011). Microsoft office: professional 2010 step by step. 

 Washington: Microsoft press. 

Foulkes, L.(2020). Learn Microsoft office 2019: a comprehensive guide to getting 

 started with Word, PowerPoint, Excel Access, and Outlook. Birmingham: 

 Packt publishing. 

Lambert, J. (2015).Microsoft PowerPoint 2016 step by step. Washington: Microsoft 

 press. 

Lowe, D.(2019). Microsoft PowerPoint 2019 for dummies. New Jersey: Wiley. 

Wempen, F. (2013).Microsoft PowerPoint 2013 Bible. Indianapolis: Wiley. 

 

2.9 Possible Answers to Self-Assignment Exercises (SAEs) 
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SAE 1: How can you insert a picture from your PC into a slide? 

Answers to SAE1: 

To do this, click where you want to insert the picture on the slide after which 

you click, insert then will see a dropdown to Pictures. In the dialog box that 

opens, browse to the picture that you want to insert, click that picture, and then 

click Insert. 

SAE 2: How do you insert an online picture into your slide? 

To insert online picture into your slide, click where you want to insert the online 

picture on the slide after which you click, insert then, browse to the 

picture online that you want to insert, click that picture, and then click Insert 

SAE 3: How do you print a slide? 

Answers to SAE 3: 

To print, Click on the file at the top left and it will take you to where you will 

see print. Click print to preview and print. 

SAE 4: How do you animate an object? 

Answers to SAE 4: 

To animate an object, Select the object you want to animate. Choose 

the Animations tab. Click the Custom Animation button. The 

Custom Animation pane appears. Click the Add Effect button. A menu appears. 

Choose the type of effect you want. A submenu appears. Click the effect you 

want. 

SAE 5: How do you use themes? 

Answers to SAE 5: 

To use a theme, Select the Design tab on the Ribbon, then locate 

the Themes group and apply as desired. 

 

SAE 6: How do you set up a presentation? 

 

Answers to SAE 6: 
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To set up your presentation, Click on the slide show. Several presentation option 

will appear. You can choose from any of the choices that befits your presentation, 

you can also time your show 

 

SAE 7: How do you insert a table into a presentation? 

 

Answers to SAE 7 

To insert a table click on Insert and choose table on the dropdown and then click 

on the insert the draw table option to select the numbers of colunms and rows for 

your table. 

 

SAE 8: How do you insert charts into a presentation? 

 

Answers to SAE 8: 

To insert charts, Click Insert > Chart then Click the chart type and then double-

click the chart you want. 
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MODULE 4:  EXCEL SPREADSHEETS 

Welcome to the learning adventure through Microsoft Soft Excel Spreadsheet. 

The following are some of the learning outcomes from this adventure. Although 

this package is technical, working through it can be a fun 

 You should know the common Excel functions used in the office. 

 You should learn to maintain a large set of Excel data. 

 Learn to use formulas like IF, VLOOKUP, INDEX, MATCH functions. 

 Understand excel and how to automate your task through macros and 

VBA 

 Learn how to create dynamic reports 

Course outline: 

Unit 1: Introduction to Excel 

1.1 Introduction  

1.2 Learning Outcomes  

1.3 Understanding what Excel is used for 

1.3.1 Microsoft Excel Startup workbook 

1.4 Excel Interface/Features/Ribbon 

1.5 Structure of an Excel Workbook 

1.5.1 Saving an Excel Document 

1.6 Summary 

1.7 Glossary 

1.8 References/Further Reading 

1.9 Self-Assignment Exercises (SAEs)  

 

Unit 2: Editing text and working with Formulas in Excel 

1.1 Introduction  

1.2 Learning Outcomes  

1.3 Creating Spreadsheet titles 

1,4      Working with some Basic Excel Functions 

1.4.1 Work with SUM() function 

1.4.2 Work with MIN()function  

1.5 Work with AVARAGE() function and Work with COUNT() function 

1.5.1 Work with AVARAGE() function 

1.5.2 Work with COUNT() function 

1.6 Summary  

1.7 Glossary 

1.8 References/Further Reading 

1.9 Self-Assignment Exercises (SAEs)  
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Unit 3: Modifying, inserting images, shapes and working with SmartArt and 

also printing in Excel 

1.1 Introduction  

1.2 Learning Outcomes 

1.3 Excel basic skills  

1.3.1 Move and copy data in an Excel worksheet 

1.3.2 Inserting and deleting Rows and column 

1.3.3 Changing the width and length of cells 

13.4 Hiding and un-hiding excel rows and column  

1.3.5 Naming a worksheet 

1.4  Formatting Data in an Excel worksheet 

1.4.1   Changing the background color of a cell 

1.4.2 Format data as currency values 

1.4.3 How to use conditional formatting 

1.5 1nsert images and shapes into an Excel worksheet and Printing 

1.5.1 Inserting Images 

1.5.2   Inserting Excel Shapes 

1.5.3 Working with Excel SmartArt 

1.5.4 Printing an Excel Worksheet 

1.5.5 Viewing documents in print preview in Excel 

1.5.6 Changing the merging, scaling and orientation   

1.5.6 Page layout view 

1.5.7 Header and footer 

1.5.8 Printing a specific range of cells 

1.6 Summary  

1.7 Glossary 

1.8 References/Further Reading 

1.9 Self-Assignment Exercises (SAEs)  
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UNIT 1: INTRODUCTION TO EXCEL 

 

CONTENTS 

1.1 Introduction  

1.2 Learning Outcomes  

1.3 Understanding what Excel is used for 

1.3.1 Microsoft Excel Startup workbook 

1.4 Excel Interface/Features/Ribbon 

1.5 Structure of an Excel Workbook 

1.5.1 Saving an Excel Document 

1.6 Summary 

1.7 Glossary  

1.8 References/Further Reading 

1.9 Self-Assessment Exercises (SAEs)  

 

1.1 INTRODUCTION  

Excel is used for calculation; it is easy to use. With excel you can perform a 

lot of mathematical functions. In this unit, we will be introducing what and 

how the excel interface looks like. 

  

1.2 LEARNING OUTCOMES  
 

The objectives of this course are to introduce the student to the excel interface 

and the structure of the excel workbook. Also, this course will teach the student 

how to save excel documents. 

1.3 Introduction to Excel: Understanding what Excel is used for 

Excel, which is part of Microsoft Office Suite has become the global choice and most 

widely accepted spreadsheet software.. Despite the availability of another spreadsheet, 

the popularity of Excel appears to be unmatched and has been the flagship in 

spreadsheet applications cross the years and globally. Preference for Excel is predicated 

on its versatility. The strength of Excel lies in the performing numerical calculations. 

However, Excel is also useful for non-numeric applications. The uses of Excel are many 

and varied.  Here are just a few uses for Excel:  

1. Create budgets,  

2. Tabulate expenses,  

3. Analyze survey results, and  

4. Perform just about any type of financial analysis you can think of.  
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5. Create a variety of highly customizable charts.  

6. Compiling mailing lists by using the row-and-column layout to store lists 

efficiently.  

7. Accessing other data Import data from a variety of sources.  

8. Creating graphical dashboards Summarize a large amount of business information 

in a concise format.  

9. Creating graphics and diagrams  

10. Use shapes and SmartArt to create professional-looking diagrams.  

11. Automating complex tasks: Perform a tedious task with a single mouse click with 

Excel’s macro capabilities. 

 

1.3.1 Microsoft Excel Startup workbook 

Click the start icon on the left down of your pc. and if you cannot find the start 

icon then click all programs to see all programs  as seen below. 

 

Figure 4.1: Excel Startup workbook 

Source: Screenshot  

 

The Excel Starter startup screen appears, and a blank spreadsheet is displayed. 

In Excel Starter, a spreadsheet is called a worksheet, and worksheets are stored 

in a file called a workbook. Workbooks can have one or more worksheets in 

them. 

Click on the blank sheet as seen below. 



 133 

 

Figure 4.2: Excel worksheet 

Source: Screenshot  

 

1.4 Excel Interface/Ribbon 

Excel interface revolves around the ribbon. The excel ribbon comprises of tabs, 

which contain groups of controls. The commands available in the Ribbon vary, 

depending upon which tab is selected. The Ribbon is arranged into groups of related 

commands. Here’s a quick overview of Excel’s tabs: 

Home You’ll probably spend most of your time with the Home tab selected. This tab 

contains the basic Clipboard commands, formatting commands, style commands, 

commands to insert and delete rows or columns, plus an assortment of worksheet 

editing commands. 

Insert Select this tab when you need to insert something into a worksheet—a table, a 

diagram, a chart, a symbol, and so on. 

 Page Layout This tab contains commands that affect the overall appearance of your 

worksheet, including some settings that deal with printing. 

 Formulas Use this tab to insert a formula, name a cell or a range, access the formula 

auditing tools, or control the way Excel performs calculations.  

Data Excel’s data-related commands are on this tab, including data validation 

commands. 
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Review This tab contains tools to check to spell, translate words, add comments, or 

protect sheets. 

 View The View tab contains commands that control various aspects of how a sheet is 

viewed. Some commands on this tab are also available in the status bar. 

 Developer This tab isn’t visible by default. It contains commands that are useful for 

programmers. To display the Developer tab, choose File ➪ Options and then select 

Customize Ribbon. In the Customize the Ribbon section on the right, make sure that 

Main Tabs is selected in the drop-down control and place a checkmark next to 

Developer. 

Help This tab provides ways to get help, make suggestions, and access other aspects of 

Microsoft’s community.  

Add-Ins This tab is visible only if you loaded an older workbook or add-in that 

customizes the menu or toolbars. Because menus and toolbars are no longer available 

in Excel 2019, these user interface customizations appear on the Add-Ins tab. The 

preceding list contains the standard Ribbon tabs. Excel may display additional Ribbon 

tabs based on what’s selected or resulting from add-ins that are installed. (Alexander, 

M. & Kusleika, D) (2019). 

See below. 

 

Figure 4.3: Excel interface ribbon 

Source: Screenshot  

 

1.5 Structure of an Excel Workbook 
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A worksheet is inside a workbook and it is used in Excel documents which is a 

collection of cells organized in rows and columns as you see above. The 

worksheet is the working surface you interact with to enter data. You perform the 

work you do in Excel in a workbook. Please note that it is practicable to have as many 

workbooks open as may be needed, each appearing in its window.  

It is important to emphasise that in Excel each workbook contains one or more 

worksheets, and each worksheet consists of individual cells. Each cell can contain a 

number, a formula, or text. A worksheet also has an invisible drawing layer, which 

holds charts, images, and diagrams. Objects on the drawing layer sit over the top of the 

cells, but they are not in the cells like a number or formula. Each worksheet in a 

workbook is accessible by clicking the tab at the bottom of the workbook window  

(Alexander, M. & Kusleika, D) (2019). Furthermore, a workbook can store chart 

sheets: a chart sheet displays a single chart and is accessible by clicking a tab. 

Newcomers to Excel are often intimidated by all of the different elements that appear 

within Excel’s window. After you become familiar with the various parts, it all starts 

to make sense and you’ll feel right at home. It is advisable to open the Excel programme 

and familiarise yourself with the environment of the application package. (Alexander, 

M. & Kusleika, D) (2019). 

1.5.1 Saving an Excel Document. 

Saving your workbook 

Until now, everything that you’ve done has occurred in your computer’s memory. If 

the power should fail, all may be lost—unless Excel’s AutoRecover feature happened 

to kick in. It’s time to save your work to a file on your hard drive: 

1. Click the Save button on the Quick Access toolbar. (This button looks like an old-

fashioned floppy disk, popular in the previous century.) Because the workbook hasn’t 

been saved yet and still has its default name, Excel responds with a Backstage screen 

that lets you choose the location for the workbook file. The Backstage screen lets you 

save the file to an online location or your local computer.  

2. Click Browse. Excel displays the Save As dialog box. 

3. In the File Name field, enter a name (such as Monthly Sales Projection). If you like, 

you can specify a different location.  

4. Click Save or press Enter. Excel saves the workbook as a file. The workbook remains 

open so that you can work with it some more. (Foulkes, L.(2020) 

Under the Save dialogue box, you can Save or Save As 

Click the file and then the Save As, under the Save As, select the place you want 

to save your document to. In the file name box, write the name you want to save 
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the document with and then save. When you Save, Excel assumes that the 

destination where the work will be saved is already predetermined. See below. 

 

Figure 4.4: Document saving window, Source: Screenshot  
 

 

1.6 SUMMARY  

At the end of this unit, we have been able to learn about Excel as the world’s 

number one spreadsheet application package because of its versatility and use 

for various functions. We have also studied the workbook of Excel, the interface, 

the structure, and lastly how to save an Excel document. Preference for Excel is 

predicated on its versatility. The strength of Excel lies in the performing numerical 

calculations create budgets, tabulating expenses, analyze survey results, performing just 

about any type of financial analysis and creating a variety of highly customisable charts 

 

SELF-ASSESSMENT EXERCISES (SAEs)   
 

Mention various functions you can use Excel to perform 

1.7 Glossary 

Active Cell: Is the selected cell where data is entered when typing commences  

Cell: A box is formed when/where the row and column intersecton a worksheet as 

soon as information is entered.  

Chart: Any object that presents data in a visualor graphic manner 

Column: Vertical arrangement of cells 

Spreadsheet: A file consisting of cells in rows and columns which facilitates the 

arrangement, calculation and sorting of data 
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Row:Horinzontal arrangement of cells 

Workbook:This an excel file with at least one workshhet 

Worksheet: One spreadsheet in a workbook.  

 

1.8 REFERENCES/FURTHER READING 

Alexander, M. & Kusleika, D. (2019). Microsoft Excel 2019 Bible: the 

 comprehensive tutorial resource. Indianapolis: Wiley. 

Cox, J., Lambert, J. & frye, C. (2011). Microsoft office: professional 2010 step 

 by step. Washington: Microsoft press. 

Daniel, J. (2018). Excel: 5 Books in 1- Bible of 5 Manuscripts in 1-Beginner's 

 Guide+ Tips and Tricks+ Simple and Effective Strategies+ Best 

 Practices to Learn Excel Programming Efficiently+ Advanced 

 Strategies. K.M. Publishing. 

Foulkes, L.(2020). Learn Microsoft office 2019: a comprehensive guide to 

 getting started with Word, PowerPoint, Excel Access, and Outlook.  

 Birmingham: Packt publishing. 

1.9 Possible Answers to the Self-Assessment Exercises  

SAE 1: Mention various functions you can use Excel to perform 

Answer to SAE 

The uses of Excel are many and varied.  Here are just a few uses for Excel:  

1. Create budgets,  

2. tabulate expenses,  

3. analyze survey results, and  

4. perform just about any type of financial analysis you can think of.  

5. Create a variety of highly customizable charts.  

6. Compiling mailing lists by using the row-and-column layout to store lists 

efficiently.  

7. Accessing other data Import data from a variety of sources.  

8. Creating graphical dashboards Summarize a large amount of business 

information in a concise format.  

9. Creating graphics and diagrams  

10. Use shapes and SmartArt to create professional-looking diagrams.  

11. Automating complex tasks: Perform a tedious task with a single mouse click 

with Excel’s macro capabilities. 

 

UNIT 2: EDITING TEXT AND WORKING WITH FORMULAS IN 

EXCEL 
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2.1 Introduction  

2.2 Learning Outcomes  

2.3 Creating Spreadsheet titles 

2, 4      Working with some Basic Excel Functions 

2.4.1 Work with SUM() function 

2.4.2 Work with MIN()function  

1.5 Work with AVARAGE() function and Work with COUNT() function 

2.5.1 Work with AVARAGE() function 

2.5.2 Work with COUNT() function 

2.6 Summary  

2.7 Glossary 

2.8 References/Further Reading 

2.9 Self-Assignment Exercises (SAEs)  

 

2.1 INTRODUCTION  

The students will be introduced to how Excel works with formulas, and performs 

many mathematical functions, including addition, division, and do many other 

arithmetic solutions. 

2.2  LEARNING OUTCOMES 

At the end of this course,  students should be able to work with various functions 

in excel such as the SUM(), AVARAGE (), and COUNT() functions. 

2.3 Creating Spreadsheet titles 

 

Click the Insert tab, then to the header and footer button on the ribbon, click the 

spreadsheet title as seen below. 
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Figure 4.5: Spreadsheet title 

Source: Screenshot  

 

2.4 Working with some Basic Excel Functions 

2.4.1 Work with SUM() function 

The sum function adds values. you can add individual values, cell references or 

ranges, or a mix of all three. to do this, select a cell next to the numbers you want 

to sum, click auto sum on the home tab, press enter, and you're done.  Remember 

to alight the whole figures you want to sum before clicking the sum button at the 

right corner of the ribbon. See  Fig……as  example.  
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Figure 4.6: Sum function 

Source: Screenshot  

 

2.4.2 Work with MIN()& MAX()function 

 

Excel MIN or MAX function returns the smallest or largest numeric value in a 

range of values respectively.MIN will return the minimum value in a given list 

of arguments while MAX will return the highest value in a given list of argument 

from a given set of numeric values, it will return the smallest or highest value 

respectively. To do this, select a cell below or to the right of the numbers for 

which you want to find the smallest or highest number. On the Home tab, in the 

Editing group, click the arrow next to AutoSum., click Min (calculates the 
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smallest) or Max (calculates the largest), and then press ENTER. See below.

 
 

Figure 4.7: MIN()& MAX()function 

Source: Screenshot  
 

2.5 Work with AVARAGE() function and Work with COUNT() function 

 

2.5.1 Work with AVARAGE () function 

The same process as seen above, after highlighting the fields you want to work 

on, click the arrow next to AutoSum > Average, and then press Enter 

 

2.5.2 Work with COUNT() function 

Count function returns the count of numeric values (includes numbers and 

dates); To do this, the COUNT function will get the number of entries in a 

number field that is in a range or array of numbers. 

Use the =count function to do this operation and highlight the fields you want to 

perform this function on and click ENTER, see below for example. 
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Figure 4.8: COUNT() function 

Source: Screenshot  

 

Note that count gives you the number of cells you are working on. 

2.6 SUMMARY  

We have seen how we can create a spreadsheet title, we also learned about 

functions, this includes the SUM() function, MIN() function, AVARAGE () 

function, and COUNT() function. We have also seen how we can work with 

formulas. Excel as we mentioned earlier is mostly used for calculations.  

SELF-ASSESSMENT EXERCISES (SAEs)  

Calculate the SUM of 3,22,34,12 using the SUM() function. 

Calculate the MIN of 33,22,11,234,1 using the MIN() function. 

Calculate the AVARAGE of 33,22,11,3,4,5,3 and 4 using AVARAGE() 

function 

 

2.7 Glossary 

Formula: Calculation which has been entered into a cell 

Range: Selected set of multiple cells 

Ribbon:Refers to the band on to of the workplace that displays all the tools and 

items 



 143 

Sort: Rearrangement of rows or columns according to certain criteria 

Value: Any data in a one cell. It can also refer to the result of any formula 

Zoom: Reduction or enlargement of screen of entire worksheet. 

 

2.8 REFERENCES/FURTHER READING 

Foulkes, L. (2020).Microsoft Excel 2010 is plain and simple. Birmingham: 

 Packt publishing. 

Frye, Curtis D. (2010). Microsoft Excel: step by step. Washington: Microsoft 

 press. 

George, N. (2020). Excel 2019 Basics: a quick and easy guide to boosting your 

 productivity with Excel. GTech Publishing. 

Harvey, G. (2010). Microsoft Excel 2010 all in one for dummies. New Jersey: 

 Wiley 

2.9 POSSIBLE ANSWERS TO SELF-ASSESSMENT EXERCISES 

(SAEs)  

SAEs: Calculate the SUM of 3,22,34,12 using the SUM() function. 

Answer to SAE: Enter the figures 3, 22.34.12 vertically in a column and click 

or horinzontally in a row and click the summation icon  Σ. The answer is 71 
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UNIT 3: MODIFYING, INSERTING OF IMAGES, SHAPES AND 

WORKING WITH SMARTART AND ALSO PRINTING IN EXCEL 

3.1 Introduction  

3.2 Learning Outcomes 

3.3 Excel basic skills  

3.3.1 Move and copy data in an Excel worksheet 

3.3.2 Inserting and deleting Rows and column 

3.3.3 Changing the width and length of cells 

3.3.4 Hiding and un-hiding excel rows and column  

3.3.5 Naming a worksheet 

3.4 Formatting Data in an Excel worksheet 

3.4.1   Changing the background color of a cell 

3.4.2 Format data as currency values 

3.4.3 How to use conditional formatting 

3.5 1nsert images and shapes into an Excel worksheet and Printing 

3.5.1 Inserting Images 

3.5.2   Inserting Excel Shapes 

3.5.3 Working with Excel SmartArt 

3.5.4 Printing an Excel Worksheet 

3.5.5.1 Viewing documents in print preview in Excel 

3.5.6 Changing the merging, scaling and orientation   

3.5.7 Page layout view 

3.5.8 Header and footer 

3.5.9 Printing a specific range of cells 

3.6 Summary 

3.7 Glossary 

3.8 References/Further Reading 

3.9 Self-Assignment Exercises (SAEs)  

 

3.1  INTRODUCTION  

 

With Excel, we can insert images of our various choice. Just open your 

workbook and follow up. 

 

3.2  LEARNING OUTCOMES 

 

At the end of this unit, students are expected to be able to modify the text, use 

images in their worksheet, work with SmartArt and also know how to print the 

worksheet out via a printer. 

3.3 Excel basic skills 
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3.3.1 Move and copy data in an Excel worksheet 

Right-click on the worksheet tab and select Move or Copy or use your copy 

and paste method. 

3.3.2 Inserting and deleting Rows and column 

 Right-click the row number, and then select Insert or Delete. See below 

insert 

 

Figure 4.9: Inserting and deleting Rows and column window 

Source: Screenshot  

 

To delete follow the arrow below 
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Figure 4.10: Deleting Rows and column window 

Source: Screenshot  

 

3.3.3 Changing the width and length of cells 

Select the column or columns that you want to change. On the Home tab, in 

the Cells group, click Format. Under Cell Size, click Column Width. In the 

Column width box, type the value that you want. See below  
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Figure 4.11: Changing width and length of cells 

Source: Screenshot  

 

3.3.4 Hiding and un-hiding excel rows and column 

It is possible to either hide of not to hide Excel rows and columns. (Please see 

Figure 4.12 below).  

 

Figure 4.12:Hiding and un-hiding excel rows and columns 

Source: Screenshot  

 

3.3.5 Naming a Worksheet 
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To do this, double-click the sheet tab, and type the new name or you right-

click the sheet tab and see rename in the dropdown and rename it. see below. 

 

Figure 4.13: Margins;Naming a worksheet.  Source: Screenshot  

 

3.4 Formatting Data in an Excel worksheet 

3.4.1 Changing the background color of a cell 

To this, select the cell or range of cells you want to format. Click Home> 

Format Cells dialog launcher. On the File tab, under Background Color, pick 

the color you want. Or you right-click after highlighting the cells and you will 

see format cells. See below 
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Figure 4.14: Changing colour of cells 

Source: Screenshot  

 

3.4.2 Format data as currency values 

To do this, select the cells that you want to format , and then, in the Number 

group on the Home tab, click the down arrow in the Number Format box. See 

below 
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Figure 4.15: Formatting data 

Source: Screenshot  

 

3.4.3 How to use conditional formatting 

To do this, select one or more cells in a range, table, or PivotTable report. On 

the Home tab, in the Style group, click the arrow next to Conditional 

Formatting, and then click Top/Bottom Rules. Select the command you want. 

Enter the values you want to use, and then select a format. See below. 

 

 

Figure 4.16: Conditional formating 

Source: Screenshot  

 

Note that you have the options to pick whatever conditions you want to give it. 
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Figure 4.17: Conditional formattingc option 

Source: Screenshot  

 

 

Figure 4.18:Conditional formatting option 

Source: Screenshot  

 

3.5 How to insert images and shapes into an Excel worksheet 
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3.5.1 Inserting Images 

To insert images in Excel, open your Excel spreadsheet, click where you 

want to put a picture, and then switch to the Insert tab then to Illustrations 

group, and click Pictures. See below

 

Figure 4.19: Inserting images and shapes 

Source: Screenshot  

 

See also 

 

Figure 4.20: Inserting images and shapes 
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Source: Screenshot  

 

3.5.2 Inserting Excel Shapes 

From the Insert tab, in the Illustrations group, click Shapes. Select a shape by 

clicking on it. Your cursor will change to a plus sign. Click in your worksheet 

where you want to place the shape, drag your mouse until the shape is the size 

you want it to be, and then release your mouse. See below 

 

Figure 4.21: Inserting Excel Shape 

Source: Screenshot  
 

3.5.3 Working with Excel SmartArt 

To do this, click the SmartArt button in the illustrations group. then choose 

a SmartArt graphic dialog box that appears. select a category in the navigation 

panel on the left followed by the list's or diagram's thumbnail in the center section 

then click ok. 
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Figure 4.22: Excel SmartArt 

Source: Screenshot  

 

3.5.4 Printing an Excel Worksheet 

3.5.4.1 Viewing documents in print preview in Excel 

Printing your worksheet 

The process of printing in Excel is not a big deal. Two things will facilitate this process. 

The first is to have a functional printer. The second is to ensure it is properly connected 

to your computer system. Alexander, M. & Kusleika, D. (2019) provide the 

following four steps to accomplish your printing process: 

1. Make sure that the chart isn’t selected. If a chart is selected, the chart will print on a 

page by itself. To deselect the chart, just press Esc or click any cell.  

2. To make use of Excel’s handy Page Layout view, click the Page Layout button on 

the right side of the status bar. Excel displays the worksheet page by page so that you 

can easily see how your printed output will look. In the Page Layout view, you can tell 

immediately whether the chart is too wide to fit on one page. If the chart is too wide, 

click and drag a corner of the chart to resize it, or just move the chart below the table 

of numbers. 

3. When you’re ready to print, choose File ➪ Print. At this point, you can change some 

print settings. For example, you can choose to print in landscape rather than portrait 

orientation. Make the change, and you see the result in the preview window.  
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4. When you’re satisfied, click the large Print button in the upper-left corner. The page 

is printed, and you've returned to your workbook. See Fig……   

 

Figure 4.23: Printing worksheet 

Source: Screenshot  

 

3.5.6 Changing the merging, scaling, and orientation   

On the Page Layout tab, in the Page Setup group, click Orientation, and then 

click Portrait or Landscape. See below 
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Figure 4.24: Changing the merging, scaling, and orientation 

Source: Screenshot  

 

3.5.7 Page layout view 

 

See Fig 4.24 image and go preview it from the file button. 

 

3.5.8 Header and footer 

On the Insert tab, in the Text group, click Header & Footer. See below 
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Figure 4.25: Header and footers 

Source: Screenshot  
 

3.5.9 Printing a specific range of cells 

Open your spreadsheet, hold the ctrl key and highlight the area you want to print 

out, then go to page layout to print Area and set print Area, see below. 

 

Figure 4.26: Printing a specific range of cells 
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Source: Screenshot  
 

Next 

 

Figure 4.27: Printing a specific range of cells 

Source: Screenshot  

 

3.6  SUMMARY  

We have learned how to move, copy data in excel; we have also learned how to 

delete rows and columns; we also learned how we can format data as currency 

values; we also learned how we can use conditional formatting e.t.c 

SELF-ASSESSMENT EXERCISES (SAEs)  

How do you delete rows and columns? 

How can you hide rows and columns in excel? 

How do you change the width and length of a cell? 

How do you name a worksheet? 

 

3.7 Glossary 

Autosum: Display the sum of the selected cells directly after the selected cell. 

Chart sheet: Refers to sheet in a workbook that contains only a chart 
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Database: Collection of data on a particular subject area 

Transpose: Involves the pasting of data in the opposite orientation  

VBA: Visual Basis Application, the programming language used for Excel. 
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3.9 POSSIBLE ANSWERS TO SELF-ASSESSMENT EXERCISES 

(SAEs)  

SAE 1: How do you delete rows and columns? 

Answer to SAE 1: 

To do this, Right-click the row  and column number, and then select Delete. 

SAE 2: How can you hide rows and columns in excel? 

Answer to SAE 2: 
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First on the far left side of the spreadsheet, right click on the row header for the 

row header for the row you want to hide.  Select hide in the pop-up menu. To 

hide column click the column header below the ribbon and select hide in the 

pop-up menu 

SAE 3: How do you change the width and length of a cell? 

Answer to SAE 3 

Select the column or columns that you want to change. On the Home tab, in 

the Cells group, click Format. Under Cell Size, click Column Width. In the 

Column width box, type the value that you want. 

SAE 4: How do you name a worksheet? 

Answer to SAE 4: 

To do this, double-click the sheet tab, and type the new name or you right-

click the sheet tab and see rename in the dropdown and rename it. 

Acknowledgments: The contributions of Mr Maxwell Ebebo in the design and 

development of Modules two, three and four is immensely appreciated.  
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MODULE 5: GRAPHICS DESIGN AND MICROSOFT ACCESS 

 

This module aims to introduce students to the subject of graphics design and get 

to understand the elements and principles of design. Also, students will be able 

to use the Adobe Photoshop package for basic usage. 

 

UNIT 1:  INTRODUCTION TO GRAPHICS DESIGN 

UNIT 2: INTRODUCTION TO ADOBE PHOTOSHOP 

UNIT 3: INTRODUCTION TO CORELDRAW 

UNIT 4: INTRODUCTION TO MICROSOFT ACCESS 

 

UNIT 1: INTRODUCTION TO GRAPHICS DESIGN 

1.1 Introduction 

1.2 Learning Outcomes 

1.3 Definition of Graphics Design and History of Graphics Design 

1.3.1Definition of Graphics Design 

1.3.2 History of Graphics Design 

1.4. Industry Specializations for Graphics Design 

1.5 Introduction to the Basics of Graphics Design 

1.5 Summary 

1.7 Glossary 

1.8 References 

1.9 Possible Answers to Self-Assessment Exercises (SAEs) 

 

1.1 INTRODUCTION  

This unit aims to introduce students to the subject of graphics design and get to 

understand the elements and principles of design. In thisu, you get to have an 

overview of what graphic design is and the professional opportunities inherent 

in acquiring graphic design skills. 
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1.2 LEARNING OUTCOMES  

By the end of this module, students should be able to: 

 Define graphic design 

 Know the history of graphic design 

 Describe industry specialisation for graphic design 

 Understand the elements and principles of design and their 

implementations.  

. 

3.8  Definition of Graphics Design and History of Graphics Design 

1.3.1 Definition of Graphics 

Graphics design has been generally defined as the art or skill of combining text 

and pictures in advertisements, magazines, or books. This definition though true 

doesn’t provide much context. Graphic design is not limited to advertisements, 

magazines, and books. It can be physical, digital, and anywhere in-between, this 

abstractness and versatility make it go far beyond the “simple” combination of 

text and images. The focus of graphics design is the visual communication of a 

message which could be to provide information, invoke thought, sell a product 

or even stimulate meaningful conversation. So you can say graphics design is 

about expressing an idea in the best way using visual storytelling and it requires 

problem-solving, communication, attentiveness, patience, and most importantly 

a good grasp of the project’s desired result. 

 

1.3.2 History of Graphics Design 
 

Graphic design has a long and interesting history, traceable to paintings, 

drawings, graphs maps, and writings, found in cave paintings and created around 

15,000 BC. These paintings were created to tell stories, keep records of events 

and provide information. Cave paintings started as basic line figures but 

expanded to detailed artwork as the years progressed. In some parts of the world, 

much original cave paintings are still visible. Cave paintings were useful, but 

they lacked a way to transport that information to other locations. This was 

resolved in 105 AD when Ts’Ai Lun invented paper. This made transporting and 

distributing written documents and various types of artwork easier than it had 

ever been. It also added more variety to the types of ink, paint, and other tools 

that could be used to create artwork. Finally, with the creation of Movable Type 

by Johannes Gutenberg in 1450, the key components needed for modern graphic 

design became available. 
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William Addison Dwiggins is considered the father of modern graphic design. 

He was a typeface designer in the 1920s. His most famous fonts include Caravan 

Metro, Electra, Caledonia, Eldorado, and Falcon. Dwiggins continued creating 

and innovating in the design community until he died in 1956. Less than a decade 

after Dwiggins’ death, Douglas Engelbart invented the mouse. This invention of 

a precision pointing device paved the way for what would be the greatest 

innovation in design tools of this generation: the Macintosh. Apple presented the 

Macintosh in 1984. This was the first computer with a user-friendly interface. 

Shortly after the invention of 1984, Macintosh graphics applications such as 

Photoshop and Illustrator were introduced to the world. Since the invention of 

these applications, designers have been able to create amazing works of art 

across a variety of media. 

 

1.4 Industry Specializations for Graphics Design 

There are several types of graphic design, each with its own area of specialization. 

Though they often overlap, each type of graphic design requires a specific set of 

skills and design techniques. Many designers specialize in a single type; others 

focus on a set of related, similar types. Let us consider some of the design 

specialisation available in graphic design. 

 

1.4.1. Visual Identity Design 

Visual identity design is also called brand identity design. This deals with how 

an organisation communicates its personality, tone and essence, as well as 

memories, emotions and experiences. Visual identity graphic design is exactly 

that: the visual elements of brand identity that act as the face of a brand to 

communicate those intangible qualities through images, shapes and color. 

Designers who specialize in visual identity graphic design collaborate with brand 

stakeholders to create assets like logos, typography, color palettes and image 

libraries that represent a brand’s personality. In addition to the standard business 

cards and corporate stationery, designers often develop a set of visual brand 

guidelines (style guides) that describe best practices and provide examples of 

visual branding applied across various media. These guidelines help to ensure 

brand consistency throughout future applications. Visual identity design is one 

of the most common types of design. Visual identity graphic designers must 

possess a general knowledge of all types of graphic design to create design 

elements that are suitable across all visual media. They also need excellent 

communication, conceptual and creative skills, and a passion for researching 

industries, organizations, trends and competitors.   

 

1.4.2 Marketing and Advertising Design 

There is no doubt that every organisation depends on successful marketing 

efforts to tap into its target audience’s decision-making process. In essence, great 

marketing engages people based on the wants, needs, awareness, and satisfaction 
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they have about a product, service, or brand. Since people will always find visual 

content more engaging, graphic design helps organizations promote and 

communicate more effectively. Marketing designers work with company owners, 

directors, managers, or marketing professionals to create assets for marketing 

strategies. They might work alone or as part of an in-house or creative team. 

Designers can specialize in a specific type of media (vehicle wraps or magazine 

ads, for example) or create a broad assortment of collateral for print, digital, and 

beyond. Marketing designers need excellent communication, problem-solving, 

and time management skills. In addition to being proficient in several graphic 

design, layout, and presentation apps, they must also be familiar with production 

for print and online environments. Entry-level positions in this area are a great 

way for new designers to learn processes and acquire valuable skills and 

experience.  

 

1.4.3 User Interface Design 

A user interface or what you might know as just UI is how a user interacts with 

a device or application. The UI design is the process of designing interfaces to 

make them easy to use and provide a user-friendly experience often also known 

as UX. 

The UI includes all of the things a user interacts with—the screen, keyboard, and 

mouse—but in the context of graphic design, UI design focuses on the user’s 

visual experience and the design of on-screen graphic elements like buttons, 

menus, micro-interactions, and more. It’s a UI designer’s job to balance aesthetic 

appeal with technical functionality. The UI designers specialize in desktop apps, 

mobile apps, web apps, and games. They work closely with UX (user experience) 

designers (who determine how the app works) and UI developers (who write 

code to make it work).  

 

1.4.4. Publication Design 

Publications are long-form pieces that communicate with an audience through 

public distribution. They have traditionally been a print medium. Publication 

design is a classic type of design and they range from books and newspapers to 

magazines and catalogs. Graphic designers that specialize in publications work 

with editors and publishers to create layouts with carefully selected typography 

and accompanying artwork, which includes photography, graphics, and 

illustrations. Publication designers may work as freelancers, as creative agency 

members, or in-house as part of a publishing company. Publication designers 

must possess excellent communication, layout, and organisational skills. In 

addition to graphic design expertise, they need to understand color management, 

printing, and digital publishing. 

 

1.4.5 Packaging Design 
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Most products require some form of packaging to protect and prepare them for 

storage, distribution, and sale. But packaging design can also communicate 

directly to consumers, which makes it an extremely valuable marketing tool. 

Every box, bottle, and bag, every can, container, or canister is a chance to tell 

the story of a brand. Packaging designers create concepts, develop mock-ups and 

create print-ready files for a product. This requires expert knowledge of print 

processes and a keen understanding of industrial design and manufacturing 

because packaging design touches so many disciplines. Packaging designers’ 

work requires top-notch conceptual and problem-solving skills in addition to a 

strong working knowledge of print and industrial design. They must also be 

aware of current trends.   

 

1.4.6 Motion Design 

What do we mean by motion designs? Simply put, motion designs are designs 

that are in motion. It can include animation, audio, typography, imagery, video, 

and other effects that are used in online media, television, and film. The 

medium’s popularity has skyrocketed in recent years as technology improved 

and video content became king. Motion graphics designers begin by developing 

storyboards and then bring their concepts to life with animation, video, and 

traditional art. Depending on the industry, a strong working knowledge of 

marketing, coding, and 3D modeling can be definite assets.  

 

1.4.7 Environmental Design 

What is the goal of environmental graphics? Environmental design visually 

connects people to places to improve their overall experience by making spaces 

more memorable, interesting, informative, or easier to navigate. How would you 

define environmental design? It is a broad type of design and multidisciplinary 

practice that merges graphic, architectural, interior, landscape, and industrial 

design. Designers collaborate with people in any number of these fields to plan 

and implement their designs. As a result of this, designers typically have 

education and experience in both graphic design and architecture. They must be 

familiar with industrial design concepts and able to read and sketch architectural 

plans.  

 

1.4.8 Art and Illustration for Graphics Design  

Graphic art and illustration are often seen as being the same as graphic design: 

however, they are each very different. Designers create compositions to 

communicate and solve problems: graphic artists and illustrators create original 

artwork. Their art takes several forms, from fine art to decoration to storytelling 

illustrations. Now technically, this is not a type of graphics design but so much 

is created for commercial use within the context of graphic design that you 

cannot talk about one without the others. You have examples like t-shirt designs, 

comic books, video games, websites, stock images. 

 



 166 

1.5 Introduction to the Basics of Graphics Design 

In this section, students should be able to know and understand the design 

elements and principles and should also be able to put them into practice. 

 

1.5.1 Elements of Design 

We’ve already established that graphic design is the art of combining images, 

text, and ideas to create works that capture a viewer’s attention to communicate 

a specific message and because graphic designers are always grappling with how 

to do just that, they’ve come up with a variety of tips and techniques to keep their 

work organized and effective. The elements of design are best understood as 

being the building blocks of any project. Even the most complex graphic design 

portfolio can be broken down into fundamental elements like lines, shapes, and 

fonts. The seven basic elements of graphic design are line, shape, color, texture, 

type, space, and image. Let us take them one by one. 

 

1.5.2 Line 

Lines are always more than just points that are strung together. Depending on 

their form, weight, length, and context, lines can help organize information, 

define shapes, imply movement, and convey emotions. 

Lines can: 

• …be horizontal, vertical, or diagonal. 

• …be straight, curved, or freeform. 

• …zigzag or create other patterns. 

• …be solid, broken, or implied. 

The invisible lines found in the grids of print designs act as guides, offering 

projects more structure and direction. Meanwhile, visible lines with weight and 

form can be used to communicate a variety of messages and moods in a 

designer’s finalized work. Think about the kinds of lines you see in your 

everyday life and recall the kinds of messages that they convey to you. 

Depending on their context, heavier dark lines can communicate stability—or 

underline a threat. Scribbled lines can suggest excitement, confusion, or 

messiness. Zig-zagged lines might express electricity or anger, while wavy lines 

can suggest fragility, elegance, uncertainty, or beauty. It is noteworthy that 

because even simple lines can convey so much, designers should always 

carefully consider how and when to use them to provide the very most impact. 

 

1.5.3 Shape 

For graphic design, shapes are best understood as areas, forms or figures 

contained by a boundary or closed outline. Two types of shapes are worthy of 

note: geometric and organic (or “free-flowing”). Geometric shapes can include 

either two-dimensional or three-dimensional forms. They are created by a set of 

points that connect by either straight or curved lines and are usually abstract and 

simplistic. Geometric shapes can include triangles, pyramids, squares, cubes, 
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rectangles, pentagons, hexagons, octagons, decagons, circles, ellipses, and 

spheres. Organic shapes are far less uniform, proportional, and well-defined. 

They can be symmetrical or asymmetrical. They might include natural shapes, 

such as leaves, crystals, and vines, or abstract shapes, such as blobs and squiggles. 

People often equate rounded edges and rings with positivity, community, love, 

friendship, and harmony. Squares and rectangles can suggest balance, 

dependability, and strength. And triangles have cultural associations with 

science, religion, history, civilization, and power. If you choose a certain set of 

shapes, you can convey stability, dependability, and organization. Choose others, 

and you communicate chaos, creation, and fun. According to Gestalt 

psychology—a reigning design theory—audiences make sense of designs by 

seeing them as a whole rather than as their parts. Pick interesting, appropriate 

shapes, and you’re on your way to giving viewers a more visually pleasing, 

attention-sustaining design.  

 

1.5.4 Colour 

Colour can be a useful tool for communicating a mood or provoking an 

emotional response from your viewer. Color theory and the color wheel provide 

a practical guide for graphic designers who want to select a single color or 

combine multiple colors in a harmonious—or intentionally discordant—way. 

In graphic design, some colors are grouped into particular categories. 

• Primary colors (red, yellow, and blue) are defined as the pure-

pigment colors from which all others are made. There is no way to mix 

any other color to get red, yellow, or blue. But mix them, and you create 

all kinds of shades. 

• Secondary colors (violet, green, and orange) are the immediate 

results of mixing two primary colors: Red and yellow make orange; blue 

and red make purple; and yellow and blue make green. 

• Tertiary colors (red-orange, yellow-orange, yellow-green, blue-

green, blue-violet, and red-violet) are the six colors that result from 

mixing a primary color and a secondary color. 

Color harmonies are created when two or more colors are chosen from 

their positions on the color wheel. 

• Complementary colors lie opposite one another on the color wheel.  

They are highly contrasting and can express vibrancy and energy or be 

visually jarring, depending on how they’re used. Red and green are 

complementary colors. 

• Analogous color schemes use colors that lie next to one another on 

the color wheel. They are visually pleasing and can create a sense of 

harmony and calm in a design. However, they can also seem dull if used 

incorrectly, or if they don’t have other contrasting elements to energize 

them. 

• Triad color schemes use colors that are evenly spaced around the 

color wheel. They are very vibrant and require balance to be visually 

pleasing. 
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• Split-complementary color schemes use a base color and the two 

colors that are adjacent to its complementary color. They provide great 

visual contrast without being jarring, which is why so many designers 

prefer them. 

• Tetradic or rectangular color schemes use two sets of 

complementary colors. Because they feature four colors, tetradic schemes 

offer designers a myriad of varieties and possible outcomes. 

• Square color schemes feature four colors that create the shape of a 

square on the color wheel. They also present many possible design 

outcomes, but should always be balanced when used. 

While you consider your color schemes, you may also want to decide 

which tint and shade are appropriate for your project. Pastel colors can 

seem calming or unconfident, while bright tints might convey fun and 

happiness—or seem cheap in the wrong context. Darker shades connote 

seriousness and professionalism, but they can also come across as somber 

or boring if you’re not careful. According to the experts, human beings 

have different psychological responses to color depending on the cultural 

context. It’s important to learn your audience’s color associations and to 

exploit or avoid them, depending on the goals of your project. 

 

1.5.5 Texture 

 

The texture is the feel of a surface—furry, smooth, rough, soft, gooey, or glossy. 

Most graphic designers must visually convey texture by using illusions to 

suggest how their work might feel if viewers could touch it. Mastering texture is 

an important part of making designs look polished and professional. There are 

different ways to experiment with texture in your design work. If you are inspired 

by nature, you may want to work with organic textures, drawing inspiration from 

leaves, tree bark, stones, fur, flowers, grass, and soil. Or you can create an 

abstract pattern by uniformly repeating two-dimensional elements, then use that 

pattern to make textured backgrounds. Consider working with textured 

typography to provide extra visual interest. If you’re interested in photography, 

you can also learn to incorporate images into your background that layer your 

work. For added textural contrast, adjust your photo’s color saturation and 

transparency levels and see how it affects the mood of your design. 

 

1.5.6 Type 

 

Whether you’re choosing a font or creating your typography for a graphic design 

project, it’s important to make sure the type you use is legible and appropriate 

for your subject. Type affects the overall mood of a design, so consider whether 

your letters should be printed or script and whether they should have angles that 

are sharp or rounded. The weight of your lettering is also an important part of 

your design. Typically, large or thick letters convey that the words they convey 

are important. If you aren’t careful, though, they can also seem heavy-handed or 

disrupt a design’s balance. Thin letters can connote elegance or modernity, but 
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they can also seem fragile. If you can’t settle on one font or size, there may be 

room for you to incorporate more than one into your logo’s final design. But as 

a general rule, don’t exceed three in a given project. 

 

1.5.7 Space 

 

Spacing is a vital part of any designer’s toolkit. It can give a design breathing 

room, increase its visual impact, balance out heavier visual elements, and 

emphasize images or messages that viewers should remember. Without enough 

space, a design can risk becoming too visually cluttered for your audience to 

understand. 

 

Spacing can separate objects or link them together. Narrow spacing between 

visual elements conveys that they have a strong relationship, while wider spacing 

communicates that they are less related. When you surround a visual element 

with space, you’re emphasizing its importance, but the space can also suggest 

loneliness and isolation. Positive space refers to the space occupied by visual 

elements that a designer wants their audience to focus on. Negative space refers 

to everything else, including the background. Many designers make the mistake 

of only focusing on crafting a positive space but organized negative space is just 

as essential to a cohesive, visually interesting composition. If you pay attention 

to the way negative space affects your design, it could elevate your project from 

amateurish to professional. 

 

1.5.8 Image 

 

Whether graphic designers use photographs or illustrations, they rely on images 

to grab the audience’s attention and express specific messages. An image works 

on multiple levels simultaneously: It provides context for a designer’s 

communication, adds necessary drama or action, and creates an overall mood. 

When incorporating images into your work, it is vital to find a picture that tells 

the right story and maximizes visual interest. You could choose an image with a 

lot of contrasting colors and textures, which offers viewers a visual feast to keep 

audiences interested. Or you might spotlight a particular part of an image to 

convey where they place the majority of their focus. Images are perhaps the most 

impactful visual tools of communication. If you thoughtfully use their power to 

your advantage, your work will convey more than you ever thought possible. 

 

 1.5.9 PRINCIPLES OF DESIGN 

The principles of design—sometimes referred to as “the principles of art”—are 

rules that help define and regulate how those elements interact with one another, 

their context, and their audience.  

 

1.5.9.1 Balance 
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This refers to the distribution of the graphic design elements, such as shapes, text 

boxes, and images, of a design evenly throughout a certain layout. Designers can 

choose between a balanced (stable) design or an off-balanced (dynamic) layout. 

In the context of graphic design, balance is of three types: 

• Symmetrical – This type of design is formed along a vertical axis 

and or horizontal axis, where the weight of the elements is evenly divided 

into both sides of the layout. 

• Asymmetrical – This type of balance employs scale, contrast, and 

colour to even out the flow of a layout. It is usually found in websites, 

where two sides of a webpage differ from each other but contain similar 

elements. 

• Radial – Here, the elements of a design are placed in a circular 

pattern on the layout. This provides a sense of movement and dynamism 

to the eyes of the viewer. 

 

1.5.9.2  Alignment 

 

This fundamental aspect of a design creates a visual connection between 

elements such as images, shapes, or blocks of texts. Alignment helps develop a 

sharp and ordered appearance by eliminating any distortion within the layout. It 

represents the scale of each element by comparing their proportion and focusing 

on the elements that can have a strong impact on users.  

 

1.5.9.3  Hierarchy 

 

This method combines two aspects, dominance and priority, giving extra weight 

to certain elements of a design over others. It helps brands convey their message 

to the audience by focusing on a particular element of the design. Hierarchy can 

be achieved by: 

• Highlighting the title using large or bold fonts; 

• Placing the key message at a higher level than other elements; 

• Adding shapes to frame the focal view; 

• Implementing detailed and colourful visuals. 

 

1.5.9.4  Contrast 

 

Contrast is an important principle in any form of visual art as it guides the 

customer’s attention to the key elements of a design. It is essential for 

maintaining the distinction between similar elements in a design, thereby 

enhancing a layout’s overall legibility. Contrast is formed when design elements 

are placed in opposition on a layout, for example: 

• Dark vs light; 

• Thick vs thin; 

• Contemporary vs traditional; 

• Large vs small. 
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1.5.9.5  Rhythm 

 

Rhythm brings together different elements to create a more organised and 

consistent look. Repetition of certain elements such as logos or colour can help 

make a brand easily recognisable and strengthen the overall look. Rhythm is 

classified into two types; 

• Fluid – This adds a significant amount of variation to the design, 

keeping the flow in a single direction. 

• Progressive – Progressive rhythm is based on a clear sequence that 

controls the visual movement of the audience between the different 

elements. 

 

 

1.5.9.6   Proximity 

 

Proximity helps in decluttering the overall design by creating a relationship 

between related elements. It forms a visual connection among important design 

factors such as colour, font, type, or size, ensuring the layout is balanced to form 

a perfect design. It enables the audience to have a pleasant overview of what they 

are looking at, thereby offering a good user experience. 

 

1.5.9.7  Colour and space 

 

Choosing the right colour can help define the tone of the design. Designers can 

choose from a wide range of colour combinations for the background and text of 

the layout. Space refers to the area around or between the various elements of 

the design. It can either be used to create shapes or highlight the important 

aspects of a design. Graphic designers use a colour palette to choose colours that 

can create contrast or even work together to complement other elements. 

 

1.6 SUMMARY 

In this unit, you have been able to learn about the core of design, from its history 

and specializations in designs to design principles and elements. We have also 

considered graphic design basics which are critical to practical applications. 

Whether you are a design enthusiast who simply wants to make community 

bulletins and attractive flyers, or a designer in a large enterprise who is forced to 

measure output in volume, you might not immediately know where you’re going 

creatively. But, especially as fine artists who are looking for that “special 

something” to redefine their work, we all pack toolkits for our artistic voyages, 

both virtual and physical. You’ve seen in this unit that the design software 

outlined here is a necessary part of your computer graphics toolkit. You’ve got 

the right applications, and basic knowledge needed to fire on, and now it’s simply 

up to you to create your gallery of ideas. You are guided toward a goal, you can 

modify the goal to suit scores of personal artistic needs, and the end goal is as 

simple or as ambitious as the situation calls for. 
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SELF-ASSESSMENT EXERCISES (SAEs) 

1. Define graphic design? 

2. What is the focus of graphic design? 

3, List and explain the elements of design 

4. List and explain the principles of design 

1.7. Glossary 

Balance: This refers to the distribution of the graphic design elements, such as 

shapes, text boxes, and images, of a design evenly throughout a certain layout.  

Environmental desisgn: It is a broad type of design and multidisciplinary 

practice that merges graphic, architectural, interior, landscape, and industrial 

design. 

Marketing designers: Designers who work with company owners, directors, 

managers, or marketing professionals to create assets for marketing strategies. 

Motion designs: Designs that are in motion. 

Publication design: A classic type of design that range from books and 

newspapers to magazines and catalogs. 

Texture: The texture is the feel of a surface—furry, smooth, rough, soft, gooey, 

or glossy. 

Visual identity design: is also called brand identity design. 

 

1.8 REFERENCES/FURTHER READING 

Ikekeonwu, G. A. M & Oguike, O. E. (2017). Computer Applications. 

 Department of Enugu: Computer Science, University of Nigeria, Nsukka. 

 121-142. 

 

I.9 Possible Answers to Self-Assessment Exercises (SAEs)  

SAE 1: Define graphic design? 

Answers to SAE 1; 

Graphics design is about expressing an idea in the best way using visual 

storytelling and it requires problem-solving, communication, attentiveness, 

patience, and most importantly a good grasp of the project’s desired result 

 

SAE 2: What is the focus of graphic design? 

Answer to SAE 2: 
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The focus of graphics design is the visual communication of a message which 

could be to provide information, invoke thought, sell a product or even stimulate 

meaningful conversation 

 

SAE 3: List the elements of design. 

Answer to SAE 3: 

SAE 4. List the principles of design. 

The following are the major principles in design: 

 

1) Line 

2) Shape 

3) Colour 

4) Texture 

5) Type 

6) Space and 

7) Image 

 

Answer to SAE 4: 

The principles of design—sometimes referred to as “the principles of art”—are 

rules that help define and regulate how those elements interact with one another, 

their context, and their audience. The following are the major principles in design: 

1) Balance 

2) Alignment 

3) Hierachy 

4) Contrast 

5) Rhythyn 

6) Proximity 

7) Colour and space 

 

SAE 5: What skills must publications designers must possess? 

Answer to SAE 5; 

Publication designers must possess excellent communication, layout, and 

organisational skills. In addition to graphic design expertise, they need to 

understand color management, printing, and digital publishing. 

 

 

 

UNIT 2– INTRODUCTION TO ADOBE PHOTOSHOP 

 

CONTENT 
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2.1 Introduction 

2.2 Learning Outcomes 

2.3 Overview and Photoshop Basics 

2.3.1   Overview 

2.3.2   Photoshop Basics 

2.3.3 Getting images for use in Photoshop 

2.4 Photoshop Tools 

2.4.1. Marque Tools 

2.4.2 Magic Wand Tool 

2.4.3 Quick Selection Tool 

2.4.4 Lasso Tool 

2.4.5 Crop Tool 

2.4.6 Brush Tool 

2.4.7 Clone Stamp Tool 

2.4.8 Type Tool 

2.5 Image Adjustment in Photoshop 

2.5.1 Sizing Images for the Screen 

2.5.2 Saving an Image 

2.5.3 Photoshop Actions 

2.6 Summary 

2.7  Glossary 

2.8  References/Further Reading 

2.9 Possible Answers to Self-Assessment Exercises 

2.1 INTRODUCTION 

This unit aims to introduce students to the subject of Adobe Photoshop. In this 

Unit you get to have an overview of Adobes a tool and the practical application 

of Photoshop in various design contexts 

 

2.2 LEARNING OUTCOMES 

 By the end of this module, students should be able to: 

 Understand Adobe Photoshop as a bitmap application; 

 Have basic knowledge of Adobe Photoshop 

 Navigate the Adobe Photoshop landscape 

 Know and use Adobe Photoshop tools 

 

 

2.3 Overview and Basics 

2.3.1 Overview 
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Adobe Photoshop is a bitmap application, meaning it is good for just about 

anything with continuous ranges of tones like photographs. Photoshop uses the 

graph paper-like way of drawing, which means that unless the squares of the 

graph paper you happen to be using are not small enough, those squares (pixels) 

are going to be visible to the naked eye. Photographs and other continuous-tone 

images are very important in design, so Photoshop is a vital tool in the designer’s 

toolbox. 

 

Please note: Adobe Photoshop is just a tool. It is the easy part of the design. The 

hard part is how to best use it to make designs that communicate well. This 

module attempts to lead you through the basic features of the applications so that 

you can also learn the more important design aspect with minimum frustration. 

The version of the application used as a reference is Adobe Photoshop Version: 

22.3.0. Photographs and other continuous-tone images are very important in 

design, so Photoshop is a vital tool in the designer’s toolbox. To see the graph 

paper-like quality of Photoshop, open the application up, go to File / New, and 

figure out how to draw something like a diagonal line with the paintbrush tool. 

Use the magnifier tool to zoom in on this repeatedly until you can see the squares. 

 

 

Figure 5.1: Adobe Photoshop 2021 “Home” Interface 
Source: Adobe Photoshop 2021 PC Software 

 

 

2.3.2 Photoshop Basics 

Pixels 
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Find an image that you like on your PC. Click and 

hold on to it, then drag the icon for that image (the 

image file) on your PC over the Photoshop icon to 

open it in Photoshop. You could also open it in 

Photoshop by control-clicking or right-clicking 

the file and choosing Photoshop. Use the zoom 

tool to magnify the image many times. You should 

see a couple of things. First, the image is 

composed of squares—these are called pixels. 

Each pixel can be only one color (if they appear to 

contain more than one color then it is an optical 

illusion called an adjacency effect). These pixels 

are the basic building blocks for an image, and all 

Photoshop (bitmap) images are composed entirely of these and nothing 

else. 

The second thing to notice is that there are no lines or objects in Photoshop. 

What may look like a line, such as at the side of someone’s face, is just 

colored pixels transitioning softly to differently colored pixels. This is 

important. It is a fundamental difference between Photoshop and 

Illustrator. 

 

Opening a New Document 

Close the image you have opened in Photoshop and open a new document 

(click on File / New). A blank document will help us to see the basics of 

the application.

 

 

Figure 2.2: Adobe Photoshop 
zoom tool 

Source: Adobe Photoshop PC 
software 
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Figure 5.3: Adobe Photoshop New document Interface 

Source: Adobe Photoshop 2021 PC software 

 

Photoshop has no page, only those little pixels that make up an image. 

The more pixels there are in an image, the smaller they will look. To use 

an analogy presented earlier in this module, we need graph paper with 

very small squares (pixels), hence a lot of squares. 

 

 

 

 

For your image, specify 1080 pixels by 1080 pixels. For just looking at 

some things on the screen this is plenty of pixels for now. The number in 

the resolution box does not matter at all for now. For color mode, choose 

RGB. This stands for Red, Green, and Blue. Also, choose 8 bit. Bits 

determine how many colors each pixel color could be chosen from. 

Images with more than 8 bits have more color information possible for 

each pixel, but we wouldn’t see it. Let’s start with a document filled with 

white pixels (it has to be filled with some color of pixels), so set the 

background contents to white. When you click ‘OK’ you will get a 

window with a white square. This is called the canvas. If you drag your 

whole window frame a bit larger you will see the difference between the 

canvas and the area surrounding it. The canvas is full of pixels we can 

Figure 5.4: Adobe Photoshop showing pixels of an imgage 

Source: Adobe Photoshop 2021 PC software 
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change, the area surrounding it is... well, just the area surrounding it—no 

pasteboard, no functionality. 

 

2.3.3. Getting Images for Use in Photoshop 

Almost any photographic image can be opened in Photoshop. You can get 

one from the web, from your digital camera or scanner, or just open 

something someone sent you in an email. Either go to File / Open in 

Photoshop, drag the image file onto the Photoshop icon, or hold down the 

control key while holding the mouse down on an image file and choose 

open with Photoshop. Go ahead and open an image file in Photoshop. 

Each image that you open will have a different pixel dimension, and as 

we will see later, the number of pixels in an image is very important. For 

now, go to Image / Image Size, and see the number of pixels you have. If 

either dimension is less than about 100, then your image is probably very 

small, or to put it another way, the pixels will be too big, so you should 

find another image. If, on the other hand, either dimension is over 6,000 

pixels, then your image is too big, and the sheer number of pixels may be 

unnecessary and bog down the application. So, you should choose a 

different image. If you do an image search in Google it will tell you the 

size of an image in pixels before you go to it, and you can also specify 

general pixel sizes to search for. 

 

Assuming you have an image that is just right, let’s look at a few things. 

If you are zoomed in, you can hold down the space bar to drag around the 

view. Zoom in close enough to look at the individual pixels that make up 

the image. Zoom back out to see how those individual pixels make the 

illusion of continuous tones. Now let’s look at the tools. We are going to 

be most concerned with the first 13 tools. The first group of 6 tools is 
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selector and move tools, and the second group of 9 are the tools that 

change the color of pixels or the editing tools.  

2.4.  Photoshop Tools 

 

2.4.1. Marque Tools 

 

 

 

 

Group A 

 

Group B 

Figure 5.5: Photoshop tool bars 

Source: Adobe Photoshop 2021 PC software 
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Choose the rectangular 

marquee tool and drag a 

box with it within your 

‘painting’ of lines. You 

should see a rectangle of 

‘marching ants’. Within that box 

the pixels are selected, outside 

they are not. With the zoom tool 

magnify the view on one of 

these borders to see how the 

selection lies between pixels, then double-click on the magnify tool to 

bring the view back to 100%. Now choose the move tool at the top of 

the panel. Click and drag to move your selection. Notice that the area 

where you moved your selection from is now filled with pixels the 

color of your background color. Select something else and move it. 

 

Number this image and provide the source 

 

 

 

2.4.2 Magic Wand Tool 

It is a quandary that a Photoshop image has no objects to select, but 

usually, weneed to select things 

we SEE as objects. But since 

these things are usually defined 

by their color and tonality, we 

have several selection tools that 

allow us to pick pixels that are 

of similar color and tonality and 

leave other ones alone.  

 

 

The tool with which we can best see how this works is the magic wand tool 

(associated with the quick selection tool). If the tolerance (in the option panel) is 

set to 1, this tool will only select the color (and tone) where you click. But in a 

photograph, one color usually doesn’t go very far (zoom up close to what appears 

to be one color and you will see that the pixels are usually composed of several 

colors). If you set the tolerance to a higher number you will see that the higher 

 

 

Figure 5.6: Photoshop Marquee Tool group 
Source: Adobe Photoshop 2021 PC Software 

Figure 2.7: Photoshop 

Magic Wand Group  

Source: Adobe Photoshop 2021 PC 

Software 

 

 

 

 

Figure 5.8: Photoshop Magic Wand Options Panel  

Source: Adobe Photoshop 2021 PC Software 
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the number, the more pixels close to that color will be selected. Checking the 

box labeled ‘contiguous’ is usually a good idea since it will limit the selection to 

those pixels which touch each other, rather than any pixel in the image that 

happens to be close in color.  

 

Click around your image changing tolerances to see how this works. As 

in most Adobe number boxes, you need to hit the enter key after you enter 

the number. You will also notice that making any selection deselects your 

last selection. If you would like to add to your selection click on the 

second box at the left of the options panel (or hold shift), and if you would 

like to subtract from your selection 

choose the third box (or hold down 

the alt key). If you would like your 

selection to be a little smoothed at 

the edges, then click the option 

labeled ‘anti-alias’. Whenever you 

have a selection in Photoshop, any action you do will only effect that 

selection. Choose the brush tool and paint over the selection. Now change 

the (brush options) mode from ‘normal’ to ‘color’ in the pull-down 

menu— the brush will only change the color within the selection, not the 

tonality (darkness). Remember to set the mode back to ‘normal’ when you 

are done. Copy your selection using the move tool and hold down the alt 

key while you drag it to see how that works. When you are finished with 

your selection, go to Select / Deselect. 
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1.4.3 Quick Selection 

Tool 

The quick selection tool is 

probably the most useful. 

With this tool choose a brush 

size in the options panel, and 

‘paint in’ your selection. The 

tool will attempt to find the 

line where colors change and 

conform to that line. If the 

selection goes beyond where 

you want it to, click in the 

options panel on the icon 

with the brush and the minus 

symbol to paint the selection 

back out (or just hold down 

the alt key while painting), 

then go back to the plus icon 

(or hold shift) to add it back 

in if you need to. By going 

back and forth like this you 

are teaching Photoshop what 

the object you are selecting 

looks like. 

 

 

 
Figure 5.10: Photoshop Quick selection options bar and Group 

Source: Adobe Photoshop 2021 PC Software 

 

 

 

 

 

 

 

Figure 5.9: Photoshop Quick Selection Action  
Source: Adobe Photoshop 2021 PC Software 
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2.4.4 Lasso Tool 

The lasso tool is one of the crudest selection tools, but also one of the 

quickest. This tool doesn’t look at the colors and tones in an image but 

just selects along the line that you draw with it. The magnetic lasso 

tool does much the 

same thing but 

attempts to ‘snap’ 

to color changes 

close to where you 

are drawing. 

 

 

 
Figure 5.11: Photoshop Lasso Tool Group 

Source: Adobe Photoshop 2021 PC Software 

 

 

2.4.5 Crop Tool 

While not exactly a selection tool, the 

crop tool is worth explaining here. 

Basically, you just draw a box around the 

part of the image you would like to keep 

and hit the return key. The outside parts 

of the image are consigned to the ether 

(gone). In the options panel, you can also 

size your image while cropping it, which 

is more useful to do after we learn about 

sizing images. 

 

 

2.4.6 Brush Tool 

Let’s treat Photoshop as a painting program for a little while. Choose 

the first brush tool (don't use the brush tool with the circle and arrow). 

Now look at the options panel, 

which is the horizontal ribbon 

over the top of the window. 

Like Illustrator, this top ribbon 

changes according to the tool 

you have chosen, but unlike 

Illustrator, it is the only way to 

make some settings for the tool 

you have selected (in this case 

the paintbrush). 

 

 

Figure 5.12: Photoshop Crop tool 

Source: Adobe Photoshop 2021 PC 

Software 

 

 

Figure 5.13: Photoshop Brush tool  
Group 

 

Source: Adobe Photoshop 2021  

PC Software 
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Many of the options are the same 

for different tools, so let’s look at 

these in detail. The most important 

options are in the second box on the 

left. Clicking on this will give you a 

pop-up menu that allows you to 

change the size of your brush (let’s 

set it on 125 pixels), the hardness 

(or fuzziness) of your brush (set it 

to 5%), and the shape of your brush 

(leave it a circle). Now set the mode 

of your brush to ‘Normal’. The 

mode determines how the color is 

applied. The opacity and flow of the 

brush is how dark your paintbrush 

will paint. 100% on both is good for now. Paint a few lines, then 

change the size and hardness of your brush and paint a few more lines. 

 

 

 

 

 

 

 

 

 

2.4.7 Clone Stamp Tool 

With all of the editing tools, if you 

have a selection, the tool only 

works within that selection. So 

let’s make sure we do not have a 

selection by going to Select / 

Deselect. Choose the clone stamp 

tool (also called the rubber stamp 

tool). What the stamp tool does is 

take information from one area of 

the image and paint it on another 

area. First, while holding down the alt key, click on the area you want 

to take from. This sets the source. Now with no key held down click 

where you want to paint and start painting. This does two things: First, 

it sets your destination (relative to your source) and secondly, it starts 

painting. If your brush is too big or too small, change the size (and 

hardness) in the options panel. Once you set the destination with that 

first click, the source and the destination are locked together until you 

set another source. Experiment with this. If you have two images open 

(or more than one layer in one image) in Photoshop you can set your 

 

Figure 5.14: Photoshop Brush 
tool Panel  

Source: Adobe Photoshop 2021 

PC Software 

 

 

Figure 5.15: Photoshop Brush tool Options Panel  

Source: Adobe Photoshop 2021 PC Software 

 

 

Figure 5.16: Photoshop Clone 
Stamp tool 

Source: Adobe Photoshop 2021 

PC Software 
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source at one image or layer and your destination at another. The clone 

stamp tool is a very good way to not only put another eye on your 

friends’ foreheads but also to clean up parts of images, such as wires 

in the sky, trash on the grass, or ex-boss in the photo. 

 

2.4.8 Type Tool 

The type tool is one tool you might find 

useful. With an image open in 

Photoshop, choose the type tool and 

look at the options panel. Here you can 

change the size of the type (pixels is 

usually the unit you want to use here), 

the color of the type, and other things. 

You can also open the character and 

paragraph panels here to have more 

options. By clicking and typing or by 

dragging a box and typing, make a word 

or two, and you will notice that a new 

type layer is created in the layers panel. 

A type layer in Photoshop behaves in 

many ways like any other layer. You 

can use the transform commands, move the layer’s stacking order, 

etcetera. It is different, however, in that the type is still typed, and it 

can be edited. Click on a layer other than the type layer to deselect it. 

Then double-click on the type layer’s icon in the layer panel. The text 

will be highlighted, your tool will change to the type tool and you can 

edit the text. 

At this point, the text is still text and not pixels, so there are limited 

ways of dealing with the text in combination with your image. For 

instance, you cannot make area selections of your text like you have 

with other images. To make the text pixels and make the layer behave 

exactly like any other layer, go to Layer / Rasterize / Type. You can 

now no longer edit the text, but it is now a true Photoshop image. Since 

the type is now in pixels, it will have jagged edges if the pixels are not 

small enough. And since type naturally has much harder edges than a 

photograph or other illustration, these pixels will still show even when 

they are very small.  

 

 

2.5 Image Adjustment in Photoshop 

 

Figure 5.17: Photoshop 
Type tool  

Source: Adobe Photoshop 

2021 PC Software 
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Perhaps the most basic and commonly used Photoshop techniques are 

adjusting the brightness, contrast, and color of images. With any image 

you work on you should at least consider the possibilities of tweaking 

these. With an open 

document, go to 

Image Adjust / 

Brightness / Contrast. 

With preview 

selected, adjust your 

image. If you have a 

selection it will only 

work in the area of 

the selection, but if 

you have everything 

selected or nothing 

selected your entire 

image will be adjusted. 

A more accurate and 

flexible alternative to 

brightness/contrast is 

to go to Image / 

Adjust / Levels. In the 

main window of this 

panel, there is what 

looks like a 

mountain(s). This is 

called a histogram, 

and it is a map of the 

different tones in your 

image. At the left are 

the darker areas, and 

at the right are the 

lighter areas. The 

height of the 

mountain is how 

many pixels there are 

of a certain tone. By 

dragging the small 

triangle sliders 

directly below the 

histogram you can 

‘remap’ the way these 

tones look. Drag the 

right slider to make 

the light areas lighter, 

and drag the left slider 

 

 

Figure 5.18: Photoshop Color Balance, 
Brightness/Contrast & Levels Panels  

Source: Adobe Photoshop 2021 PC Software 
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to make the dark areas darker. Generally, you first put the triangles near 

the bottom of the mountains. After you do this, drag the middle slider 

(called the gamma) back and forth until the image looks good (you may 

have to go back and tweak the other sliders after you do this). In all 

Photoshop requester boxes click ‘Preview’ on so that you can see the 

results as you adjust. To adjust the colors of an image, go to Image / 

Adjust / Color Balance. Even though there are only three colors you adjust 

directly, these are all that is needed to adjust all the colors in your image. 

Notice that there is no way to make an image more yellow and bluer at 

the same time. These colors are opposites. Remember that if you would 

like to change only one part of your image, make a selection first. 

 

 

2.5.1 Sizing Images for the Screen 

At the top of your document window, 

you will see a percentage. At 100% your 

image is the size it will appear if saved 

and viewed in almost any other 

application destined for the computer 

screen, including web browsers, emails, 

and presentations. To adjust this image 

size for the screen, go to Image / Image 

Size. For screen viewing we are only 

concerned with 

the pixel 

dimensions—it 

does not matter 

at all what the 

inch or other 

size is, since 

this refers only 

to printed 

documents. 

You should 

always make 

sure the 

proportions are 

locked (see 

yellow 

highlight). 

Without 

constraining 

proportions 

your image will 

stretch and 

distort. If you 

 

Figure 5.19: Photoshop 
Document Properties bar 

Source: Adobe Photoshop 2021 

PC Software 

 

 

Figure 5.20: Photoshop Pixel Dimensions Panel 

Source: Adobe Photoshop 2021 
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do need a long rectangle from a square image, go back to the crop tool. If 

that doesn’t work, find a new image!  

Resample is a fancy way of saying ‘change the number of pixels’, so 

without this checked we wouldn’t be able to do what we need to (check 

it). Now change either the width or the height of the pixel dimensions. If 

your resulting image is too large at 100%, undo your image size and enter 

a smaller number. You have to get used to pixels as a measurement. 

Screens have different sizes and resolutions, so inches or other 

measurement units don’t apply when talking about screens. A standard 

small screen is 1024 pixels wide by 768 pixels high. 

 

Adding pixels to an image is almost always a very bad idea. Think of it 

this way: if you had an image that was 5 pixels wide and 5 pixels high, 

then you would have a total of 25 colored squares – maybe only enough 

information to convey a rough letter or number, but not much else. Now 

imagine scaling this image to 500 pixels wide and high. There is no place 

for Photoshop to get more information, so it would be stuck with very 

little information in the original image. And since it would be bigger, it 

would look worse! Just like spiders. The same thing happens whenever 

you add pixels to an image. So don’t. 

 

2.5.2 Saving an Image 

When you save 

an image you 

opened from 

somewhere 

else, go to 

Image / Save 

As... You 

should save 

your image in 

one of two 

formats: 

Photoshop or 

JPEG (in the 

format box 

choose the 

shortest name 

of either 

option). 

Photoshop is 

the best format 

to save in if you 

want to retain everything about your image. It will save your layers and 

every bit of quality you have. If you want to send your image to someone 

 

Figure 5.21: Photoshop "Save As” drop-down options 

Source: Adobe Photoshop 2021 
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else, then JPEG is probably the best option. These are small files that send 

quickly, and they can be opened in any application that accepts images, 

including email, presentation, and web applications. The downside is that 

JPEG compresses the information in the image, so you lose some quality, 

and you also lose any layers you may have. 

Also, when naming an image, keep the file format suffix that Photoshop 

adds (.jpg or .psd). Changing this suffix or taking it off can lead to 

problems. 

 

2.5.3 Photoshop Actions 

Often when editing images you need to perform the same techniques on 

many images. For example, you have a hundred images from an event, 

and even though only a few will ultimately be used, to speed up the 

process, you can 

‘record’ what you 

do with one image 

and ‘play it back 

on the other 

images by using 

the actions panel. 

With an image 

open in Photoshop, 

open the actions 

panel (or go to 

Window / Actions) 

and in its menu 

choose one of the 

pre-made actions 

in ‘image effects’. 

Run a couple of 

these actions on an image by clicking the play button at the bottom of the 

panel. To record your actions, click the new action button next to the trash 

can. Name your action, then do some things to your image, like changing 

the image size or the levels. When you are done, click on the stop square 

next to the red record button. Now open a new image and ‘play’ your 

action with it. Actions are limited in the way they can record mouse 

movements across an image, so they won’t record things like brush 

strokes, but they are a huge time-saver for other image operations. Many 

times all of the photographs taken at the same event will need similar 

image adjustments. Actions can reduce the time needed to process these 

significantly. You can even playback action on a folder of images by 

going to File / Automate / Batch. Of course, the help menu can give you 

all the information you need to do this. 

 

2.6 SUMMARY 

 

Figure 5.22: Photoshop Actions Panel 

Source: Adobe Photoshop 2021 
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Adobe Photoshop is a bitmap application used for just about anything with 

continuous ranges of tones like photographs. Adobe Photoshop is just a tool. It 

is the easy part of the design. The hard part is how to best use it to make designs 

that communicate well. This is what this Unit attempts have been made to lead 

you through the basic features of the applications so that you can also learn the 

more important design aspect with minimum frustration. The Photoshop and 

CorelDRAW interface provides no mysteries, but only things you have not 

discovered yet. So if you read up and study this Unit, you’ll be that much more 

ahead when you decide to paint and retouch. This unit has intended to work the 

element of discovery into a creative process: you pick up the knowledge of how 

a tool or feature works, you discover several purposes for the tool, and finally, 

you take your new-found knowledge and apply it—to realize an idea on paper. 

Developing skill in any field including design comes with time and practice. If 

you take the time, this unit will provide you with the other ingredients needed so 

that your footing is sound in a new application, and your bearings are based first 

on knowledge and eventually on instincts 

 

 

SELF-ASSESSMENT EXERCISES (SAEs) 

 1. Adobe Photoshop is a tool for design use in various contexts.           

Highlight these tools. 

 

2.7 Glossary 

Lasso tool: Used for the creation of freeform selection areas. 

Line tool: Used to draw straight lines 

Pencil tool: Used to paint strokes of different sizes and shapes with hard 

edges. 

Ruler tools: Used to measure the distance between selected objects. 

Sharpen: A filter that sharpens up the edges of an image by definition 

enhancement. 
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2.9 POSSIBLE ANSWERS TO SELF-ASSESSMENT EXERCISES 

(SAEs) 

Self-assessment Exercise: Adobe Photoshop is a tool for design use in 

various contexts. Highlight these tools. 

 

Self-assessment Exercise: The following are tools available to Adobe 

Photoshop user depending on the context: 

1) Marque 

2) Magic word 

3) Lasso 

4) Crop 

5) Brush 

6) Clone Stamp and 

7) Types tools 

 

 

 

 

 

 

; 

 

 

 

 

 

 

 

UNIT 3: INTRODUCTION TO CORELDRAW 

 

3.1 Introduction 
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3.2 Learning Outcomes 

3.3  Definition and  Overview 

3.3.1 Working with Paged Documents 

3.4 Creating Basic shapes and applying transformations 

3.4.2 Arranging and organizing objects 

3.5 Working with Text in CorelDraw 

3.6 Summary 

3.7 Glossary 

3.8  References/Further Reading 

3.9  Possible Answers to Self-Assessment Exercises 

3.1 INTRODUCTION 

This unit aims to introduce students to the CorelDraw application package and 

get them to understand how to work paged documents, create shapes, arrange 

and organise objects.  

 

3.2 LEARNING OUTCOMES 

After going through this Unit, students would be able to: 

 Define CorelDraw 

 Work with paged documents 

 Create basic shapes and apply transformation 

 Arrange and organise objects 

 Work with texts in a CorelDraw environment 

 

3.3 Definition and Overview 

CorelDraw is a software program for editing vector graphics. Vector graphics 

are created in graphics packages and consist of objects. Each object can be edited 

separately, meaning that the shape, colour, size, and position can be 

changed.CorelDRAW allows users to do things like adding special effects such 

as borders to images, in addition to allowing for contrast adjustment, colour 

balancing and more. One of the handy features of the software is that it can also 

work with multiple layers and multiple pages. 

 

CorelDraw doesn’t just offer drawing tools, you also have filters and panels 

(dockers). It offers everything from color samples to the Align and Distributes 
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object feature. You’ll find effects for bitmap imports, typography tools for 

Desktop Publishing, and more. 

 

To make the most of your valuable time, there are a lot of ways to perform just 

about everything in CorelDRAW—and there are hard ways and easy ways. 

Guess which way you’ll learn in this chapter? There aren’t secrets or mysteries 

to unravel with CorelDRAW.There’s just stuff you might not be prepared to find 

or to use. Let’s get down to some serious exploration of the fun features of this 

new version right now. 

 

 

 

 

 

 

 

 

 

The CorelDraw Workspace 



 194 

Once CorelDRAW has loaded and you’ve specified a default document, the 

sheer wealth of options and tools can make one feel more than a little intimidated 

and lost. Suppose you want to change the page size or hide all the guides you 

dragged from the rulers. Or maybe you need a more detailed explanation of the 

B-Spline tool as you’re trying to use it. You can refine, redefine, and customize 

your document and your view of the document with a few well-placed clicks. 

Please note that the quickest way to access all options for the drawing page is by 

double-clicking the page shadow with the Pick tool. 
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Dimension number boxes: These are numerical entry fields for the units you’ve 

selected for the current page size. Although an abbreviation for the units follows 

the numerical entry, you don’t have to type, for example, the double-prime 

character (”) denoting inches to enter a value—CorelDRAW puts it in there after 

you put the cursor in a different field because the software understands you’ve 

specified inches when you created a new document. Therefore, you can change 

the page size at any time in a document merely by typing in a new value. Only 

 

Figure 5.23: CorelDraw Document Preset 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 84)  
 

 

Figure 5.24: CorelDraw Property Bar 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 87) 
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when you’re done resetting the values should you press ENTER to confirm the 

current entries. 

 

Elevator buttons: Most of the time in CorelDRAW, where there’s a num box, 

there are elevator buttons directly to the right of the fields. You click the up 

button to increase the current value and click the down button to decrease the 

current value in the corresponding box. For the Dimension boxes, the value (in 

inches) for increasing or decreasing the amount is 0.05”. 

If you put your cursor directly between the up and down elevator buttons on any 

of these “combo boxes” (a box that accepts number entry and clicking/dragging 

on elevator buttons), you’ll see that the cursor changes to a two-way arrow with 

a divider in between the arrows. Drag up or down to significantly change the 

value of a nudge, a page dimension, or any value box that features elevator 

buttons. 

 

Portrait and Landscape orientations: With a simple click of either of these 

buttons, you rotate your page by 90°. A wide page becomes a tall one, and vice 

versa. The portrait is tall and the landscape is wide. 

 

Set dimensions for all pages: You should only click this button after you’ve 

sent new page size. Then, all the pages in your multipage document are identical 

in orientation and size. 

 

Set dimensions for only the current page: If you’ve made a different sized 

page, perhaps for printing scrapbook content, and want only this page uniquely 

sized, click this button while viewing the page. All other pages will remain the 

same size. 

Units drop-down: Clicking this button reveals a drop-down list of units, from 

which you change all features that display and use units. For example, if your 

current unit of measurement in CorelDRAW is inches, and for some reason, you 

choose Feet from the Units drop-down, a standard U.S. Letter page size will be 

displayed as .917’ wide instead of 11”. Similarly, if you had a nudge distance set 

on the Property Bar of 1”, the distance displayed will be the same absolute value, 

but it will read 0.083’ now. 

 

Nudge distance: The keyboard ARROW KEYS can be used to move a selected 

object by a predefined distance, called the nudge distance, although you can also 

shove, push, and propel a selected shape, depending on the distance you specify 

in this box. 

Alternatively, you can use the elevator buttons to nudge an object up, down, and 

across in increasing increments of 0.05” per ARROW KEY hit. This is a very 

useful feature for moving an object out of the way and then returning it to its 

original position when you’ve finished editing some other object. 

While Nudging, Use CTRL while you press a nudge ARROW KEY to perform 

a micro-nudge, a fraction of the nudge distance determined by what you specify 

in the Options | Workspace | Document | Rulers tab. If you hold SHIFT, this is 
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called super-nudging, and it’s a multiple of the nudge distance, again, set in the 

Rulers tab of the Options dialog. 

 

Modifier Keys: The modifier keys CTRL, ALT, and SHIFT are used by many 

programs to extend a command; even the simple Windows Copy command uses 

the modifier key CTRL, for CTRL-C. In CorelDRAW, you should learn to 

reflexively reach for a modifier key when using a tool to change its function. 

Although no two tools are the same in CorelDRAW, the most common functions 

of these three modifier keys are as follows: 

• CTRL An abbreviation for “Control,” you should think of this term as similar 

to “Constrain.” For example, when using the Rectangle tool, if you hold CTRL 

while you drag, it constrains the dimensions of the object to a perfect square. 

Similarly, if you put an object into Rotate/Skew mode (you click with the Pick 

tool on an object that’s already selected) and then hold CTRL while you drag on 

a rotation handle, the rotation is constrained to the number of degrees you’ve 

specified in Options | Workspace | Edit.  

You can also constrain node control handles while you’re drawing by holding 

CTRL. This is useful for creating objects whose angles at nodes are all identical. 

• ALT You can think of this key as offering Alt(alternatives) to the basic 

command you’re executing or the tool you’re using. For example, when dragging 

with the Bézier tool, you usually wind up with curved path segments, but if you 

hold ALT while click-dragging, a straight line segment is a result. Similarly, the 

Eraser tool switches from freehand style to straight lines when you click a start 

point and then hold ALT and click your endpoint. ALT is not as common a 

modifier key as CTRL or SHIFT, but the point is that when you believe a tool or 

command has more than one way to work, you try out these three keys before 

stopping your work to find help. 

• SHIFT can be thought of as “Add to.” For example, if you hold SHIFT while 

using the Eraser tool, the nib becomes larger. When drawing shapes with object 

tools such as the Polygon, Ellipse, and Rectangle tools (and others), holding 

SHIFT before you click-drag draw the object from its center outward instead of 

from the corner.  

And remember that modifiers can also be used in combination. If you hold 

CTRL-SHIFT while you click-drag a rectangle, the rectangle is drawn from its 

center outward, and it is also constrained to a square at the same time. 

 

Right-Click Menu: It’s called different names by different companies, but for 

ages, Windows has supported a pop-up menu called the context menu or 

contextual menu. What it does is a lot more important than what it’s called! 

Contextual means that the menu commands on this pop-up menu change, 

depending on which tool is currently chosen. As an exercise, choose the Pick 

tool and then right-click over an empty area of the drawing page. The menu gives 

you commands for undoing the last edit, creating a new object, and other 

commands specific to helping you out when the Pick tool is chosen and you 

right-click over an empty page area, not an object or an effect. These are pure 

commands useful when you use the Pick tool. 
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Particularly important when the context menu is used in combination with the 

Shape tool, you can turn selected nodes and path segments from straight and 

sharp to smooth and curved, respectively. 

Dropping a Copy of a Selected Object 

 

 

 

When you’re using the Pick tool, left-button dragging moves a selected object, 

but right-button dragging can do something entirely different, especially when 

you use the right-button drag in combination with the left button, other keys, and 

the SPACEBAR. Here are the three methods for making a copy—and several 

copies—without using the Copy and Paste commands, the Duplicate command, 

or the Step and Repeat command: 

 

Figure 5.25: CorelDraw Right-Click Menus 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 97) 
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• Right-click and then drag, release, and use the pop-up menu: If you’re just 

getting the hang of using a point-and-click device, this is the most surefire way 

to quickly copy an object. See the following illustration. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.26: CorelDraw Mouse duplicating action 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 99) 
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Smart Panning and Zooming in CorelDraw  

Figure 5. 27: CorelDraw Mouse duplicating action with space bar  
Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 101) 
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The Standard Bar 

The Standard Bar is a permanent screen element (unless you deliberately detach 

it and/or hide it); it always displays the same features regardless of which tool 

you choose.  

 

 

 

 

 

 

Figure 5.28: Zomming In & Out with mouse wheel in CorelDraw 
Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 105) 
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Import: If you’re new to computer graphics, “Import,” at least as far as 

CorelDRAW is concerned, means to bring a copy of something into the drawing 

window without the original being touched. This is not the same action as 

opening a CorelDRAW file, although you can import a CDR file. Both Open and 

Import commands are under the File menu.  

 

Export: This is the opposite of importing something. Also, exporting is not the 

same as saving a file. CorelDRAW has extensive export filters—including 

exporting objects as typefaces. As an example, if you need a PNG file made from 

your Corel drawing, you can do so in the Export dialog, and you can choose a 

resolution and whether or not you want transparency supported. When you 

export, you’re not sending your Corel artwork original anywhere; it’s a copy, 

usually in a different file format, that is leaving the drawing window. 

 

Publish to PDF: Corel sees the need for many graphic designers and Desktop 

Publishing professionals to quickly create a high-fidelity document for the web. 

You can choose Settings from the Publish to PDF box, or just click Save. Using 

 

Figure 5.29: CorelDraw Standard Bar 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 107) 
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either option, you now have a time- and energy-saving button on the Standard 

Bar all the time. 

 

Zoom levels: This is a combo box that offers preset resolutions, and you can also 

type in a custom value (and then press ENTER). 264,583% is the maximum 

value you can enter, and 1% is the minimum. You’d be hard-pressed to exceed 

those levels of magnification in your work, and at each extreme, it’s very difficult 

to navigate and see objects. 

 

Full-screen preview: Clicking this button removes the entire UI, and you are 

presented with your drawing at whatever magnification you had before clicking 

the button. This is a great feature for making a presentation and for taking 

uncluttered screen captures. 

Although in full-screen preview you can see the printable page and its drop 

shadow, the guidelines, and the grid will not display. A click anywhere returns 

you to the UI and your work. 

 

Show/Hide Rulers: This button toggles on and off the display of the rulers on 

the top and left of the drawing window border. 

 

Show/Hide Grid: This toggles the visibility of the different grids on and off, 

although a grid can continue to “snap to” objects you move around, even if the 

grid is hidden. There are three types of grids in CorelDRAW, and you choose 

which one to hide and display via the View | Grid command. The Document grid 

is the default grid in all documents, and you can change its spacing and whether 

it appears as lines or dots through the Options | Document |Grid command. The 

Baseline grid has no line/dot options, but you can change its spacing and the 

color with which it displays. The Pixel grid is not visible until you’ve imported 

a bitmap—a pixel-based graphic—and View | Pixels is your current choice of 

viewing the page. You can set the color, the opacity of the Pixel grid, and whether 

it appears on screen after you’ve zoomed in more than 800 % — an unchangeable 

value, for reasons apparent when you’re at 800 percent and all you can see is the 

grid! 

 

Search Content: Clicking this button takes you to the Get More docker, also 

accessed by using the Window | Dockers menu. You can add content to your 

document or a tray.  

 

Show/Hide Guides: This setting hides/shows any guidelines in a template or 

guides you’ve added to your document; this button has no effect, naturally, if 

there are no guidelines in your document. There is another way to hide guides if 

you have the Object Manager open. You click the Show/Hide eye icon for the 

Guides entry on the Object Manager list. 

 

Snap To settings: This drop-down list offers a checkmark area to make each 

interface object magnetic (“sticky”) or not, which is useful when you want to 



 205 

enable the stickiness of the pixels in a photo you imported, or the guides, or the 

grid, or other objects. In general, you probably don’t want any item enabled for 

“snapping to” if you’re simply drawing things freehand and have no need for 

precision in creating nodes or moving objects. 

 

Options:  The Options dialog is the nerve center for customizing the way your 

documents behave and look, but also how CorelDRAW behaves and looks. This 

is probably the most important dialog you’ll need for overriding default settings, 

and therefore this button is a welcome alternative to hunting for the command in 

the main menu 

 

Application Launcher: This drop-down list affords access right within 

CorelDRAW to all the other modules in the Graphics Suite, including additional 

apps, extensions, and plug-ins for CorelDRAW and PHOTO-PAINT. 

 

3.3.2 Working with Paged Documents 

 

Setting Up Your Document Page 

 

Every new file you create has its own set of page properties that have two 

attributes: physical properties and display preferences. The physical properties 

refer to the size, length, and color of each page as you’d define a physical page 

in the real world. Display preferences control how page values are viewed. 

 

Control Page size and Orientation 

 

If you’ve unchecked the Always Show The Welcome Screen At Launch check 

box, the default size of a new document is CorelDRAW’s default, which might 

depend on the language version of CorelDRAW you use. For this U.S. author, 

it’s U.S. Letter, 8 1/2” by 11”, but this can be changed. The quickest route for 

document size change is through the Property Bar while the Pick tool—and no 

objects—are selected. The Property Bar features options for setting your page to 

standard and custom sizes as well as its orientation. 

If you have a multipage document, the Property Bar also has ways to change all 

pages at once or only the currently visible page. 



 206 

Paper type / Size 

The Paper Type/Size and orientation options control the format of your 

document. When you have a specific format for a design you need to print, the 

following sections cover the options available to you in CorelDRAW. 

 

To make sure your CorelDRAW page matches the paper in your printer, clicking 

a Paper Type/Size option from the Property Bar is the quickest method. From 

the drop-down box, you can choose Letter, Legal, Tabloid, or other common 

sizes. Once you’ve made a selection, the dimensions are automatically entered 

as values in the Page Width and Height boxes on the Property Bar. If you have a 

limited need for different paper sizes, click the Edit This List button at the bottom 

of the drop-down list, and you can delete seldom-used sizes: with the preset 

highlighted, click the trash can icon in the Options dialog. Here’s a list of your 

paper-type options; you’ll surely find one or more that suit a specific need. 

 

Page Width and Height: You are not limited to a page size that’s the same as 

the paper in your printer; page width and height values can be freely adjusted to 

 

Figure 5.30: CorelDraw Property Bar 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 172) 
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match just about any paper size. For a custom page size, type-specific values 

directly into the Page Width and Height boxes and then press ENTER. 

 

Landscape/Portrait orientation: Clicking either Portrait or Landscape on the 

Property Bar while using the Pick tool (with no objects selected) sets the page 

orientation. If the page width you enter is less than the page height entered, the 

orientation is automatically set to Portrait, and vice versa for Landscape. 

Changing from one orientation to the other automatically switches the values in 

the Page Width and Page Height fields. 

 

All Pages/Current Page: You can create a document up to 999 pages long, with 

different pages set to any size or orientation. The All Pages and Current Page 

buttons operate in “either/or” fashion—like the orientation buttons—so you can 

set the page size either for all pages in your document at once (the default) or 

only for the current page. To set only the current page to be different from the 

others in your document, click the right of these two buttons on the Property Bar 

(directly to the left of the Units drop-down) and set your new page size and 

orientation as needed. Other pages in the document aren’t resized when you 

choose this option. 

 

3.4 Creating Basic Shapes and Applying Transformations 

 

Using the Rectangle Tool and Property Bar 

The Rectangle tool is simple enough to use, but it doesn’t just create a four-sided, 

right-angled polygon—it creates a rectangle that has special properties in 

CorelDRAW. You’ll find the Rectangle tool in the Toolbox; you can quickly 

select it by pressing the F6 shortcut key. Rectangle shapes offer you the option 

to apply corner “roundness,” based on a percentage value. Roundness can be set 

either manually by dragging a corner with the Shape tool or by using the Property 

Bar Corner Roundness option available while a rectangle is selected. By default, 

you round all four corners equally and together. However, if you unlock the Edit 

Corners Together toggle button, you can manually enter different values for each 

of the four corners. There are several more features for changing the shape of a 

rectangle object that are reversible (no destructive changes are made) on the 

Property Bar. 
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Drawing a Rectangle 

 

To create a rectangle, choose the Rectangle tool from the Toolbox and 

then click diagonal drag in any direction to define its corner positions. 

The act of click-dragging begins by defining the first two corners; as you 

drag, the corner positions can be redefined, depending on where your 

cursor is on the page. Then, before you release the mouse button, you’ve 

defined the position for the remaining two rectangle corners. 

 

Figure 5.31: CorelDraw Rectangle tool usage 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 242) 
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While the Rectangle tool is selected, notice that the cursor is a crosshair with a 

small rectangle shape at its lower right. As you click-drag using the cursor, you’ll 

also notice that the Status Bar and Property Bar show the coordinate, width, and 

height properties of your new object shape. 

 

Setting Rectangle Corner Properties 

Corner roundness is one of three different effects you can apply and dynamically 

edit when you’re into rectangles. Corner Roundness, as well as the Scalloped 

and Chamfered corner styles, can be applied to a rectangle using a value of 0 to 

about one-half the overall length of one of the rectangle’s sides. If you think 

about this, a 2” rectangle can’t have more than a 1” rounded corner on each side! 

The Corner Roundness amount can be changed at any time, while the shape 

remains a native rectangle; that is, it has not been converted to curves. By typing 

 

Figure 5.32: Drawing a rectangle in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 244) 
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0 into any of the size boxes while the rectangle is selected, you remove the corner 

style. Corner Roundness, Scalloped, and Chamfered can be set uniformly for all 

corners (the default) or independently when the Edit Corners Together lock 

option is in the unlocked state. 

While a rectangle is selected, use any of the following operations to change 

corner properties according to your needs: 

• Click the type of corner style you want on the Property Bar and then either type 

in the size for the corner values or drag the elevator buttons up or down to adjust 

the size of the corners. 

• Set your rectangle’s corners manually, using the Shape tool, by first unlocking 

the Edit Corners Together toggle button and then CTRL-dragging any corner 

control point away from its corner (toward a side that makes up the rectangle). 

Enabling the Edit Corners Together option causes all corners to be rounded or 

scalloped in an equal amount by dragging any of the control points. 

• Use the Object Properties docker; press ALT-ENTER, click the Rectangle icon 

to go to the Rectangle Properties tab on the docker, and then edit any property 

you so choose. 
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Figure 5.33: Creating corners in Rectangles in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 246) 
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Creating 3-Point Rectangles 

If you want to create a rectangle and have it rotated all in one fell swoop, you 

can use the 3-Point Rectangle tool. You’ll find it grouped with the Rectangle tool 

in the Toolbox. Using this tool, you can draw new rectangles at precise angles. 

The rectangle you create is a native rectangle shape, so you can round its corners 

and manipulate it as any other shape. 

 

 

 

 

Figure 3.13: Using the 3-point rectangle tool in CorelDraw 
Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 248) 
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To create a rectangle 

using the 3-Point 

Rectangle tool, you 

click-drag. Clicking 

sets the first point of 

the rectangle, and the 

subsequent distance 

you drag determines 

both the angle and 

length of the rectangle. 

As soon as you release 

the mouse button, you 

move your cursor 

(without clicking; this 

is called hovering) to 

determine the height of 

the rectangle. A final 

click seals the deal—

you now have a 

rectangle. You can 

now round its corners 

and perform other 

operations on your 

work. 

 

Using the Ellipse 

Tool and Property 

Bar 

Ellipses are a staple of commercial design work, and essentially an ellipse is a 

circular shape that is not perfect. The Ellipse tool can be used to draw both circles 

and ellipses, but in CorelDRAW an ellipse shape has additional, special 

properties, just like a rectangle can be a round-cornered rectangle. Ellipse shapes 

can be edited to create dramatically new shapes while retaining their elliptical 

properties. In contrast, a shape you might draw that looks like an oval, using the 

Bézier tool, for example, will have no special properties and always remains an 

oval. Ellipses are easy enough to draw with the Ellipse tool and can be set in 

several different states: oval or circular closed paths, pie wedges, and arcs. Pie 

wedges are the portions of an ellipse—like a single slice of a pie, or conversely, 

a whole pie with a slice removed. Arc shapes are open paths, exactly like pie 

wedges, except the two straight line segments are missing. 

To create an ellipse, choose the Ellipse tool from the Toolbox or press F7, 

followed by a click-drag in any direction. While the Ellipse tool is selected, the 

Property Bar shows ellipse-specific options that enable you to control the state 

of your new ellipse shape before or after it has been created. Choose Ellipse, Pie, 

or Arc. A complement is reserved for pie and arc shapes: for example, if you 

 

Figure 5.34: The Ellipse tool in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David 
Bourton (Page 250) 
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specify a 15° pie wedge, clicking the Change Direction icon changes the shape 

to a 345° wedge. Additionally, if you want a pie or arc to travel in a different 

path direction, double-click the Ellipse tool icon on the Toolbox, which takes 

you to Options, where you can choose a clockwise or counterclockwise path 

direction. 

 

Using Polygons and the Property Bar 

The Polygon tool (the shortcut is Y) is unique to the category of vector drawing 

software. Although competing applications offer a polygon tool, CorelDRAW’s 

Polygon tool produces shapes that can be edited for making dynamic changes, 

just like CorelDRAW rectangles and ellipses. The shapes you create with the 

Polygon tool can have as few as three or as many as 500 points and sides; by 

default, all polygon sides are straight paths. You’ll find the Polygon tool, 

together with the Star, Complex Star, and other group tools. While the Polygon 

tool is selected, the Property Bar offers the number of sides for the polygon you’ll 

draw. 

 

Drawing and Editing Polygons 

 

Most of the trick to creating symmetrical, complex shapes with the Polygon tool 

lies in the editing of them. 

To create a default polygon, you use the same click-diagonal-drag technique as 

you use with the Rectangular and Ellipse tools. This produces a symmetrical 

shape made up of straight paths. Because you’ll often want a shape more elegant 

than something that looks like a portion of snack food, it helps to begin a polygon 

shape by holding SHIFT and CTRL while dragging: doing this produces a 

perfectly symmetrical (not distorted) polygon, beginning at your initial click 

point and traveling outward. Therefore, you have the shape positioned exactly 

where you want it and can begin redefining the shape. Here you can see the 

Polygon tool cursor and asymmetrical default polygon. Because the Polygon tool 

can be used to make star-shaped polygons, there are control points that govern 

the polygon points and nodes in-between these point controls that are used to 

alter the coves between points. When you edit a polygon, the position of these 

points can be reversed. These control points have no control handles because 

they connect straight path segments. 
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Stars and Complex Stars 

You have variations on polygons at the ready in CorelDRAW, in the same group 

as the Polygon tool. The Star tool can be used to create pointy polygons with 

anywhere from 3 to 500 points. The Complex Star tool creates some combined 

polygons to make a star shape; you can create interesting symmetrical shapes by 

filling a complex star object—the result contains both filled and vacant polygon 

areas as the component paths intersect one another. 

 

Working with the Star Tool 

The Star tool produces objects by using the click-diagonal-drag mouse technique; 

CTRLSHIFT dragging creates symmetrical stars beginning at the initial click 

point traveling outward. On the Property Bar, when the Star tool is chosen, you 

have options for the number of points for the star and the “pointiness” (sharpness) 

of the resulting object—how severe the indents are between points. At a setting 

of 1, the star object isn’t pointy at all—you’ll see that it looks quite like a Polygon 

tool object. So, if you can make a star using the Polygon tool, why would you 

ever choose the Star tool? The answer is because the geometric structure of a star 

shape is always perfectly symmetrical. Although you can use the Shape tool to 

manually tune the sharpness of a Star tool object’s points, the angle between 

points is always consistent. 

 

 

Figure 5.35: Creating a Polygon in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 256) 
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Using the 

Spiral Tool 

With the Spiral 

tool (press A as 

the keyboard 

shortcut), you 

can create 

circular-shaped 

paths that 

would be 

tedious if not 

impossible to 

create manually. 

Spiral objects 

are composed 

of a single open 

path that curves 

in a clockwise 

or 

counterclockwise direction. They can also be designed to expand in even-

segment distances or increasing distances as the spiral path segments travel away 

from the center (called a logarithmic function). You find the tool in the Toolbox, 

grouped with the Polygon and Graph Paper tools. Spiral tool options share space 

in the Property Bar with the options for the Graph Paper tool and include the 

Spiral Revolutions, Symmetrical and Logarithmic Spiral modes, and a Spiral 

Expansion slider. 

 

 

Figure 5.36: Star tool in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton 
(Page 265) 
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The 

objects you create can have between 1 and 100 revolutions, each of which is 

equal to one complete rotation around its center point. The direction of the 

revolutions is set according to the click-diagonal-drag action during the creation 

of the initial shape. 

 

Figure 5.37: Spiral tool in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 272) 
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Please note that Spiral objects are not dynamic; no special editing or redefining 

is possible once the spiral has been created. This means you must set their 

properties before they are created. Other than using the Pick or Shape tool to edit 

their size or shape, spiral objects are a “done deal.” 

By default, all new spiral objects are set to Symmetrical. If you choose the 

Logarithmic Spiral, the Spiral Expansion slider becomes available. Here’s how 

the modes and options affect the spiral objects you can create. 

 

• Symmetrical vs. Logarithmic: A symmetrical spiral object appears with its 

spiral revolutions evenly spaced from the center origin to the outer dimensions 

of the object. To increase or decrease the rate at which the curves in your spiral 

become smaller or larger as they reach the object’s center, you may want to use 

the logarithmic method. The term logarithmic refers to the acceleration (or 

deceleration) of the spiral revolutions. To choose this option, click the 

Logarithmic Spiral button in the Property Bar before drawing your shape. 

 

Figure 5.38: Spiral objects in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 274) 
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• Logarithmic Expansionoption: While the Logarithmic Spiral mode is 

selected, the Logarithmic Expansion slider becomes available—as well as a 

value field you can type in—and you can set this rate based on a percentage of 

the object’s dimensions. Logarithmic Expansion may be set from 1 to 100 

percent. A Logarithmic Expansion setting of 1 results in a symmetrical spiral 

setting, whereas a setting of 100 causes dramatic expansion. If you need a shape 

that is reminiscent of a nautilus, increase the Logarithmic Expansion option to 

50 or so. 

 

Using the Graph Paper Tool 

The Graph Paper tool (the shortcut is D) is used to create a grid containing 

hundreds (even thousands) of rectangles—an emulation of graph paper. Graph 

paper is invaluable in chart making as well as artistic uses. You find the Graph 

Paper tool grouped with the Polygon and Spiral tools. This tool’s options on the 

Property Bar let you set the number of rows and columns for your new graph 

paper object. As with the Spiral tool, you must set options before drawing your 

graph paper object; a Graph Paper object cannot be edited dynamically. 



 220 

 

Using the Convert Outline to Object Command 

A lot of the shapes covered in this chapter—the spiral in particular—have outline 

properties but no fill. So what do you do, for example, if you want a gradient-

filled spiral? The Object | Convert Outline To Object command converts any 

shape’s outline properties to a closed path. To apply the command to a selected 

object, choose Object | Convert Outline To Object, or use the shortcut CTRL-

SHIFT-Q. Once the outline is converted, the resulting closed path looks exactly 

like the shape of the original, except it can be filled because it’s not an outline. 

Instead, it’s a closed path object whose shape is based on an outline. When an 

outline is converted to an object, CorelDRAW performs a quick calculation of 

the Outline Pen width applied to the object and creates a new object based on 

this value. When you apply this command to objects that include a fill of any 

type, a new compound path object is created based on the outline width. If the 

 

Figure 5.39: Graph Paper tool in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 276) 
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object includes a fill of any type, the fill is created as a new and separate object 

applied with an outline width and color of 

None. When you’re converting open paths, only the path itself is created as a 

single outline object of the path according to the Outline Pen width applied. 

 

3.4.2 Arranging and Organizing Objects 

 

When you create or import an object, it might not be exactly where you want it 

on the page. Or the position might be fine, but the object’s a little too large. It 

might also be rotated by a few unwanted degrees, or it's part of a group or on the 

wrong layer—you get the picture. Learning how to transform objects—both the 

manual approach and the “pinpoint precise numerical entry” approach and 

composing elements on a page to be where you want them to be is what will be 

covered in this section. 

 

Basic Object Selection 

 

The Pick tool—by default, the tool at the top of the Toolbox—can be used to 

move, scale, and make other transformations when you click an object to select 

it and then drag to move the selection, for example. Use the SHIFT key as the 

modifier when you’re selecting things on a page; you add to your existing 

selection by SHIFT-clicking other objects. If you’ve selected an object 

unintentionally, SHIFT-click on the object (which is already selected) to deselect 

it. 

 

With one or more items selected, you’ll notice that information about the selected 

shapes is displayed on the Status Bar. The other workspace area to watch is the 

Property Bar; it shows the position, size, and rotation of the selection. In addition 

to seeing info about your selection, you can also change transformations by 

entering numbers directly into the info boxes and then pressing ENTER. Also, if 

you press ALT-ENTER when something is selected, the Object Properties 

docker provides you with not only details about the object, but also the 

opportunity to quickly change many of the object’s properties. 
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Pick Tool Selections 

The Pick tool can be used for several things; the two most important are to choose 

an object (or several objects) and to create a change in the selected object(s) by 

moving it and adjusting its selection handles. 

Clicking an object once selects it. While an object is selected, selection handles 

appear —the eight black markers surrounding the object. Additionally, 

depending on the type and properties of an object, you’ll see nodes at various 

areas around the object, which indicate the first node in an object path or sub-

path (of combined vector objects) when a vector object is selected or the edge of 

an object when a bitmap is selected. A small X marker appears at the centermost 

point of the object, indicating its center origin. This origin can be moved and is 

quite useful for defining a center of rotation for an object. 

 

Picking and Freehand Picking 

 

Figure 5.40: Pick tool group in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 286) 
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The Freehand Pick 

tool is located in the 

Pick tool group, and 

both new and 

experienced 

CorelDRAW users 

might want to give 

this selection tool a 

try; the Freehand 

Pick tool behaves 

exactly like the 

(regular) Pick tool 

after an object is 

selected, so you can 

move or perform 

other transformations 

without switching 

tools. 

The main difference 

between these tools is 

that with the Pick tool, 

you must click-drag 

to define a rectangle 

that the desired 

objects are 

completely within. 

The Freehand Pick 

tool is used more like a shape-creation tool than a rectangle-creation tool; you 

can click-drag around objects, selecting some and avoiding others, regardless of 

how closely the objects neighbor one another. The illustration here visually 

demonstrates the different properties of the Pick and Freehand Pick tools. 

 

 

 

 

 

  
Figure 4.41: Selection Handles in CorelDraw 
Source: CorelDraw X8, The Official Guide by Gary David 

Bourton (Page 288) 

 



 224 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Selection Techniques 

You can use mouse and keyboard combinations while navigating through a 

collection of objects and for selecting more than one object at a time using the 

Pick tool. Many of these object-selection techniques can also be used in 

combination with each other. Here’s how to select more than one object in one 

fell swoop: 

• SHIFT-clicking to select: Holding the SHIFT key while clicking an unselected 

object adds it to your current selection. This also works in the reverse: holding 

SHIFT while clicking a selected object deselects the object. This technique 

works with both the Pick and Freehand Pick tools. 

• Marquee-selecting objects: To select all objects in a specific area, use the 

(regular) Pick tool and click-drag diagonally to surround the objects; a dashed 

blue outline representing the rectangular area being selected appears until you 

release the mouse button. When you do so, all object shapes completely within 

the area you define are selected. 

• Holding ALT while marquee-selecting: Holding the ALT key as the modifier 

while click-dragging to marquee-select a specific area selects all objects 

 
Figure 5.42: Picktool vs Freehand picktool in CorelDraw 
Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 290) 
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within—and even ones whose edge you touch. Holding SHIFT-ALT while 

marquee-selecting causes the reverse to occur—deselecting any objects that are 

already selected. 

• Pressing TAB to select the next object: Suppose you have a bunch of objects 

in a document, but some of them overlap, and you’re getting nowhere by 

attempting to click the one you need. Pressing the TAB key alone while the Pick 

tool is active selects a shape and selects the next single object arranged directly 

behind your current selection (whether or not it overlaps the current object). 

Holding SHIFT while pressing the TAB key selects the single object arranged 

directly in front of your current selection. This tabbing action works because 

each new object created is automatically ordered in front of the last created object. 

Tabbing cycles through single object selections on a page, whether you have a 

current object selected or none at all. The key is to begin tabbing after you’ve 

chosen the Pick tool. 

• ALT-clicking to select objects covered by other objects: To select an object 

that is ordered in back of and hidden by other objects, hold the ALT key while 

the Pick tool is selected and then click where the object is located. Each time you 

ALT-click with the Pick tool, objects that are ordered farther back in the stack 

are selected, enabling you to “dig” to select hidden objects.  

 

Selecting Objects by Type 
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So far, you’ve 

learned to select 

any objects on or 

off your page. But 

you can also 

select objects by 

their type (such as 

text objects, 

guidelines, and 

path nodes) using 

commands from 

the Select All 

menu, as shown 

in the following 

illustration. All 

text objects 

shown here are 

selected, and 

CorelDRAW is 

being very 

clever—it didn’t 

select the O and the A because they are drawings and not text. You can extrude, 

add a perspective, and put any type of fill you like on text—and it’s still text. See 

how effortless sifting through a page of objects can be? Each time you use a 

command from the Select All menu, a new selection is made (and any current 

selection of objects becomes not selected). 

Please note that you can’t select what’s locked or hidden. Check the status of 

layers with the Object Manager if an object is welded to the page. Also, if click 

an immovable object and its selection handles are tiny lock icons, right-click 

over it and choose Unlock Object from the pop-up contextual menu.  

Here’s how to use each of the commands: 

• Select All Objects: Choosing Edit | Select All | Objects selects all objects in 

your current document window. Quicker is the CTRL-A keyboard shortcut, 

which accomplishes the same thing and is easy to remember. 

• Select All Text: Choosing Edit | Select All | Text instantly selects all text 

objects both on and off the current document page. Both artistic and paragraph 

text objects are selected after this command is used (unless they have been 

grouped with other objects, in which case they are ignored). Text objects that 

have effects (such as Contour and Extrude effects) also are selected using this 

command. 

  
Figure 5.43: Object selection by type in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton 

(Page 294) 
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• Select All Guidelines: Guidelines are a class of document page objects, 

different from objects you draw, but objects nonetheless. To select all guidelines 

on your document page, choose Edit | Select All | Guidelines. Selected guidelines 

are indicated by a color change (red, by default). To select guidelines, they must 

be visible and cannot be locked. Probably the fastest way to unlock or unhide a 

bunch of guidelines is to double-click one using the Pick tool to display the 

Guidelines docker (only if the docker is closed and not docked to the Pasteboard 

edge). The Guidelines docker has options for locking/unlocking and 

hiding/revealing existing guides. If guidelines you’ve placed merely aren’t 

visible on your page, and you’re sure you laid some down in your last session, 

try choosing View | Guidelines. 

• Select All Nodes: You can have the Shape tool or the Pick tool (which will 

magically change into the Shape tool) and an object selected (closed or open 

paths qualify) when using this Select command. Choose Edit | Select All | Nodes 

to select all the object’s path nodes, as shown next. For a quicker method in the 

same situation, use the CTRL-A shortcut when the Shape tool is your current 

tool. Special CorelDRAW objects, such as rectangles, ellipses, and polygons, 

can’t be selected this way because their shapes are defined dynamically by 

“control points” instead of nodes. 
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Transforming Objects 

A transformation is any type of object shape or position change, short of actually 

editing the object’s properties. This includes changing an object’s position, size, 

skew, and/or rotating or reflecting it. Dragging an object directly in a document 

is more intuitive than precision transformations—but both approaches have their 

special advantages. 

 

 

 

 

Figure 5.44: Object nodes selection in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 297) 
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Transforming Objects Using the Cursor 

For the intuitive method, the Pick tool is what you need to transform objects by 

the simple act of click and 

dragging. Depending on 

the type of transformation 

you need to apply, you 

can click-drag any of the 

four black, square 

selection handles that 

surround the selected 

object or group of objects 

to change the size 

proportionally—by width 

only and by height only. 

Dragging any middle 

selection handle or side 

handle scales the object 

disproportionately—

“smush” and “stretch” are 

the more common terms 

for disproportionate 

scaling. 

 

During transformations, 

CorelDRAW keeps track 

of the object’s 

transformed size, position, 

width, height, scale, and 

rotation angle. 

CorelDRAW remembers 

your object’s original 

shape from the time it was created, regardless of how many transformations have 

been applied to it. You can remove all transformations and restore the object to 

its original state in a single step: choose Object | Transformations | Clear 

Transformations to return your object to its original shape immediately. 

While transforming objects, you can constrain certain shape properties by 

holding modifier keys. Here are the effects of holding modifier keys for 

constraining a transformed object’s shape: 

• To change object size (scale) Click-drag any corner handle to change an 

object’s size proportionally, meaning the relative width and height remains in 

proportion to the original object’s shape. Hold ALT while dragging any corner 

selection handle to change an object’s shape disproportionately, meaning width 

and height change, regardless of original proportions. 

• To change width or height only Click-drag any side, top, or bottom selection 

handle to change the size of the object in the drag direction. Hold SHIFT while 

 

Figure 5.45: Object scaling in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary 

David Bourton (Page 303) 
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doing this to change the width or height from the center of the object, or hold 

CTRL while dragging to change the width or height in 200 percent increments. 

You can also rotate or skew an object using Pick tool states that become available 

after you click a selected object a second time—you click an object that is already 

selected once to display rotation and skew controls around the object. 

 

You control the point around which objects are rotated or skewed by moving the 

center origin marker or anchor point of an object or group of objects. Your cursor 

will change to display either the rotation or skew cursor when held over a corner 

or side handle. 

 

Figure 5.46: Rotating and Skewing in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 305) 
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To flip a selected object quickly, either vertically or horizontally, use the Mirror 

Vertical and Mirror Horizontal buttons on the Property Bar while using the Pick 

tool. 

Using the Free Transform Tool 

The Free Transform tool is the middle ground between controlling 

transformations entirely with mouse gestures and using the hands-off controls of 

the Transformation docker. When you use the Free Transform tool, the Property 

Bar offers four transformation modes: Free Rotation, Free Angle Reflection, 

Free Scale, and Free Skew.  

 

 

 

 

 

Figure 5.47: Horizontal & Vertical Mirror tool in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 308) 
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To transform a selected object in one of these four modes, click to select the 

mode and then use a click-drag action on your object. A live preview of the new 

object’s shape appears. While you’re using Rotation or Angle Reflection mode, 

a reference line appears as you drag to indicate the object’s angle transformation 

from its original state. 

Using the Free Transform tool and then applying a little transparency can yield 

compositions that contain believable reflections. The Free Transform tool works 

with bitmaps as well as native CorelDRAW vector objects. 

 

Applying Precise Transformations 

The Transformations docker is terrific for applying multiple transformations 

with a single command. The docker has five Transformation buttons: Position 

(Move), Rotation, Scale and Mirror, Size, and Skew. 

  
Figure 5.48: Free transform tool in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 

309) 
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To open the Transformations docker, choose Window | Dockers or choose 

Objects | Transformations. When you click any sub-menu command, the entire 

docker appears docked to the right edge of the drawing window. 

 

For all transformations, the procedure is the same: click the button for the type 

of transformation, enter the values you need, and then click the Apply button in 

the docker to transform the selected object(s). 

 

3.5 Working With Text In Coreldraw 

 

CorelDRAW Text tool 

All the text you want to enter on a page in CorelDRAW is created with the Text 

tool, the tool with an “A” as its icon in CorelDRAW’s Toolbox. To begin, click 

 

Figure 5.49: Precise transformation in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 314) 
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its button in the Toolbox or press F8. If there’s already text on the page, double-

clicking the text with the Pick tool switches the current tool to the Text tool and 

makes an insertion point for adding text. The Text tool cursor is a small crosshair 

with an A in the bottom-right corner, which becomes an I-beam (a text-editing 

cursor) when it’s over a text object. You click anywhere on the page or the 

pasteboard to create an insertion point, and then you get to work with your 

keyboard. 

 

Text copied from the Clipboard can be pasted when the Pick tool is your current 

tool. Usually, unformatted text—text from a TXT file you copied from TextPad, 

for example—will import as Paragraph Text. Text copied from word processors 

will import as a document object; double-clicking the object offers in-place 

editing exactly as you’d edit a WordPerfect or Microsoft Word document. It’s 

usually best to choose Edit | Paste Special when pasting Clipboard text to ensure 

correct formatting and the original fonts are used and to use the Text tool’s I-

beam cursor to insert pasted text. 

When you use the Text tool, you can produce two different types of text objects 

in a document: Artistic Text and Paragraph Text.  

 

The smaller body copy text uses Paragraph Text; the top paragraph wraps around 

the top of the image by use of a CorelDRAW Envelop. Artistic Text and 

Paragraph Text have different properties but are added to a document using the 

same Text tool. Artistic Text, by the way, it’s produced in a document, is easy to 

reshape and distort—you’ll find it simple to do artistic things with it, such as 

creating a company logo. Conversely, Paragraph Text is optimized for longer 

amounts of text, and it’s a great text attribute for quickly modifying columns of, 

for example, instructions, recipes, and short stories. In short, Paragraph Text is 

best used for several paragraphs of text in a composition while Artistic Text 

should be reserved for headlines and just a few lines of text you might want to 

curve along a path, extrude, or do something else unique and fancy with. 
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Although there are similarities between Artistic and Paragraph Text, you’re best 

off using one or the other depending on the type of text element you want in your 

design. 

 

Entering and Editing Artistic Text 

 

Artistic Text will serve you best for illustration headlines, callouts, and on any 

occasion when you want to create text that has a special effect such as extrusion, 

an envelope, text on a path, and so on. To add a line of Artistic Text to a 

 

Figure 5.50: Artistic & Paragraph text in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 473) 
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document, with the Text tool you click an insertion point and then type your 

phrase; alternatively, after clicking an insertion point you can press CTRL-v to 

paste any text you have loaded on the Windows Clipboard. To create several 

lines of Artistic Text, you type and press ENTER to put a carriage return at the 

end of the line; you then continue typing. By default, all Artistic Text is set in 

Arial, 24 points. 

 

Artistic Text is also easy to convert to curves so you can modify a character in a 

word. To duplicate this effect, you begin with Artistic Text for the company 

name, press CTRLQ (Object | Convert to Curves), and then edit away using the 

Shape tool. Artistic Text can be fine-tuned using the features on the Property Bar 

when the text is selected using either the Pick tool or the Text tool.  
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• Type of Font (File): To the left of the font name displayed in the drop-down 

box is an icon signifying what file format the chosen font uses: OpenType, Type 

1, or TrueType. This is a nicety when you’re using the Filter List feature, covered 

later in this section. 

 

• Font Name, Font Family: The font name is the name of the typeface you 

decide upon. By default, you’re using Arial 24 points. You change fonts in a new 

document by selecting the text you’ve typed with the Pick tool and then choosing 

 
Figure 5.51: Artistic Text in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton (Page 475) 
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a different font from the drop-down list. If a font has family members, a right-

facing triangle can be seen to the right of the font name when the drop-down list 

is extended, and you can choose one by hovering above the triangle to reveal the 

flyout and then clicking the family member title. You can also perform a speed-

search by clicking the current name in the font name box and then typing the first 

few letters of the font you want. The drop-down list immediately scrolls to the 

neighborhood of installed fonts, making your selection a fast and effortless one. 

Note also that on the Font List, at the top, above the divider bar, are the fonts 

you’ve chosen recently, from previous documents, and even from previous 

CorelDRAW sessions. 

 

• Point Size: Text has traditionally been measured in points; with current digital 

typeface technology, the measure is 72 points to the inch. Artistic Text used as a 

printed headline can be anywhere from 18 points for a flyer headline to 72 points 

for an impactful newspaper headline, to 300 points and up for headlines that 

fairly shout at the reader. 

 

• Bold and Italic: These buttons on the Property Bar are shortcuts to defining a 

whole line of text or only selected characters as bold and italic members of the 

typeface shown in the Font Name box. If a specific font has no family members, 

CorelDRAW doesn’t “fake” a bold or italic look, and the buttons are dimmed. If 

you need an italic treatment of a font that has no italic family member, a quick 

fix is to use the Transformation docker and then set Skew to about –12° to apply 

to the Artistic Text. 

 

• Underline: An underline is an effect available for every font you have 

installed—you click the button when text is selected and CorelDRAW renders 

an underline. You can modify the style of the underline to your choosing by 

highlighting the underlined text and choosing Object Properties. Then on the 

Character area of the Object Properties docker, you click the Underline flyout 

and choose the type of underline style you prefer. 

 

• Justification: Also called “Horizontal Alignment” in balloon help. This drop-

down offers how lines of text are aligned relative to one another. Although 

Justification will serve you best when using long columns of Paragraph Text, 

Artistic Text takes on a more polished look, too, when you apply, for example, 

Center justification to two or three lines. By default, there is no Justification for 

newly entered Artistic Text, but for all intents and purposes, this is left-justified 

text. Full Justification creates a splendid, professional look for columns of 

Paragraph Text, but tends to generate an awkward look for two- or three-line 

headlines. Left Justification is quite common and acceptable in Desktop 

Publishing, and Right Justification should be reserved for extreme design 

circumstances in Western countries because we read text from left to right. There 

is a slight difference between Full and Forced Justification, your last two choices 

on the drop-down list. Full Justification ensures that both the left and the right 

margins are flush to an imaginary line at the width of the text column. Forced 
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Justification creates the same flush-left and -right column edges, but it will also 

create extra space between words and characters if a line has only a few 

characters. In the illustration here, you can see an awkward presentation of a few 

lines. You might want a wide character-spacing effect, and to do this, you put a 

soft return at the end of a line (press SHIFT-ENTER). 

• Text Properties: Clicking this button displays the Text Properties docker. Text 

Properties is very similar to the top area of the Object Properties docker. 

Essentially, anything you need to do to customize one or more characters in a 

text string can be done using the features on the Text Properties docker. You can 

access the features of the Text Properties docker by clicking the button when text 

is selected with the Text tool and Pick tool, or by pressing CTRL-T when the 

Shape tool is the active tool. 

 

 

 

 

• Interactive OpenType: Explained shortly, Interactive OpenType shows 

alternative characters in highlighted OpenType text you’ve typed. OpenType 

fonts sometimes contain scores of custom characters that are very hard for 
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average users to 

access and add to 

the text. The 

Interactive 

OpenType 

button shows and 

hides alternatives, 

allowing one-

click addition of 

special 

characters when 

a specific Open 

Type font 

contains them. 

• Edit Text: This 

button displays a 

text-editing box, 

which also 

appears when 

you click the 

Text tool on the 

text that has an 

effect such as 

Envelope or 

Extrude. 

CorelDRAW is 

designed with 

text editing 

flexibility in 

mind, so to 

transform text 

using just about 

any feature—and to allow the text to still be editable—you work in a proxy box 

so you don’t have to start over when you make a typographic error. You can also 

display the Edit Text box by clicking a line of text that has, for example, an 

Envelope effect, using the Text tool. The Edit Text box just pops up, with the 

text selected and ready to edit. 

• Bulleted List: With text selected (with the Pick tool) or highlighted (using the 

Text tool), clicking the Bulleted List button creates a bulleted list from your text, 

using a standard bullet symbol, a hanging indent for the text, and a new bullet 

wherever you’ve put a hard return in Paragraph Text. This button is inactive 

when Artistic Text is chosen.  

• Drop Cap: By default, when Paragraph Text is highlighted and you click this 

button, a three-line-tall drop cap is auto-created. Options to adjust the drop cap 

height and spacing, as well as whether a hanging indent is used or not, are found 

under the Text menu.  

 

Figure 5.52: Text formatting with Property bar in CorelDraw 

Source: CorelDraw X8, The Official Guide by Gary David Bourton 
(Page 482) 
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• Hide Preview, Filter, Options: These three buttons can be seen when the font 

list has been rolled down. The Hide (or Show) Preview button shows the first 

few characters of the text you want to use, displayed with the selected text on the 

page. The Filter option lets you choose whether the Installed Font List shows 

only OpenType fonts, shows font “favorites,” or only fonts are shown in the 

current document. It’s handy. Finally, the Options button lets you choose how 

the fonts on the list are displayed—fonts displayed by name, show/don’t show 

the recently used fonts, and so on. 

• Recently Used Fonts: When this option is turned on in Options, a list of fonts 

you’ve used in the current and previous documents is displayed. 

 

 

3.6 SUMMARY 
 

The Photoshop and CorelDRAW interface provides no mysteries, but only things 

you have not discovered yet. So if you read up on the software, you’ll be that 

much more ahead when you decide to paint and retouch.This unit intends to work 

the element of discovery into a creative process: you pick up the knowledge of 

how a tool or feature works, you discover several purposes for the tool, and 

finally, you take your newfound wisdom and apply it—to realize an idea on 

paper. Developing skill in any field including design comes with time and 

practice. If you take the time, this unit will provide you with the other ingredients 

needed so that your footing is sound in a new application, and your bearings are 

based first on knowledge and eventually on instinct. 

 

 

 

 

SELF-ASSESSMENT EXERCISES (SAEs) 

 

Define CorelDraw 

What is the transformation docker used for? 

What is the pick tools used for? 

What is the graph paper tools? 

What is the polygon and property bar used for? 

What is the Ellipse tools used for? 

 

3.7 Glossary 

CorelDraw: A software program for editing vector graphics 

Ellipses are a staple of commercial design work, and essentially an ellipse is a 

circular shape that is not perfect. 

Graph Paper Tool:  Used to create a grid containing hundreds (even 

thousands) of rectangles—an emulation of graph paper. 
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Object: Describes an element in a drawing; Examples: layer, logos, poster, line 

and shape 

Transformations docker: Used for applying multiple transformations with a 

single command. 

3.8 REFERENCES/FURTHER READINGS 

 

*Gary D. Bouton (2017), CorelDRAW X8, The Official Guide 

Vinod (2017), What is CorelDRAW? Retrieved online from 

 https://techmonitor.ai/what-is/what-is-coreldraw-5003066 

 

Acknowledge: The contributions of Mr.Victor Oga in the development of Units 

1-3 is hereby acknowledged. 

*Major source materials for Unit three 

3.9 POSSIBLE ANSWERS TO THE SELF-ASSESSMENT EXERCISES 

(SAEs) 

 

SAE 1: Define CorelDraw 

 

Answer to SAE 1: 

CorelDraw is a software program for editing vector graphics. 

SAE 2: What is the transformation docker used for? 

Answer to SAE 2: 

The Transformations docker is used for applying multiple transformations with 

a single command. 

SAE 3: What is the pick tools used for? 

Answer to SAE 3: 

The Pick tool can be used for several things; the two most important are to choose 

an object (or several objects) and to create a change in the selected object(s) by 

moving it and adjusting its selection handles. 

 

SAE 4: What is the graph paper tools? 

https://techmonitor.ai/what-is/what-is-coreldraw-5003066


 243 

Answer to SAE 4: 

The Graph Paper tool (the shortcut is D) is used to create a grid containing 

hundreds (even thousands) of rectangles—an emulation of graph paper. Graph 

paper is invaluable in chart making as well as artistic uses. 

SAE 5: What is the polygon and property bar used for? 

Answer to SAE 5: 

The Polygon tool (the shortcut is Y) is unique to the category of vector drawing 

software. Although competing applications offer a polygon tool, CorelDRAW’s 

Polygon tool produces shapes that can be edited for making dynamic changes, 

just like CorelDRAW rectangles and ellipses. 

SAE 6: What is the Ellipse tools used for? 

 

Answer to SAE: 

Ellipses are a staple of commercial design work, and essentially an ellipse is a 

circular shape that is not perfect. The Ellipse tool can be used to draw both circles 

and ellipses, but in CorelDRAW an ellipse shape has additional, special 

properties, just like a rectangle can be a round-cornered rectangle.  
 

 

 

 

UNIT 4: INTRODUCTION TO MICROSOFT ACCESS 
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4.2 Learning Outcomes 

4.3 Definition of terms and Elements of a Database File  
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4.3.2 Elements of a Database File 

4.4  Relational Database/Relationships  
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4.5.1 Introduction to Microsoft Access 
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4.5.3 Helps for Practical Access Design 

 

4.6 Summary 

 

4.7 Glossary  

4.8 References/Further Readings 

4.9 Possible Answers to Self-Assessment Exercises (SAEs) 

 

4.1 INTROBUCTION 

This Unit will introduce you to the meaning of a database, and the Microsoft 

Access Database framework. 

4.2 LEARNING OUTCOMES 

At the end of this Unit, you will be able to: 

 Define the concept of database 

 Describe a relational database 

 Describe the elements of a database file 

 Explain basic facts about Microsoft Access 

 Highlight  issues to consider in the design of database 

4.3 Definition of terms 

What is a Database? 

There are many definitions of database but in essence it is a collection of 

information. Archive records, library card catalogs, and even the Internet 

encompasses all kinds of databases. In most cases, the term "database" is used 

to describe a set of related data or information stored on a computer. Electronic 

databases allow you to store, sort and retrieve data. It is possible to create a 

database by using Microsoft Access, Word spreadsheet or Excel spreadsheet. 

To be properly described as a database the gathered information must be 

connected to a specific purpose or subject matter.For example a library 

database may consist of bibliographic record of books or information on library 

users. It may also be acquisition record of vendors and their transaction with 

the library. The library can also maintain a database of its inter-library loan and 

its circulation services. A database does not necessarily need to be stored in a 

computer. If it is then it can be defined as a computerised database. Where the 

your database is not stored on a computer, or may be some aspects are, only 

parts of it are, it would entail tracing information from a variety of sources that 

you have to coordinate and organize yourself. A good example is where you 

store information about your  book vendors or suppliers, in a file, file cabinet 

or table drawer. Changes in the vendor’s information will entail updating the 
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changes in all the locations where the information is stored. The case is different 

where the information is stored in the database because you only have to update 

that information in one place — the vendors’ information is automatically 

updated wherever it is used in the database.  

Indeed a database is a collection of logically related data files which is 

integrated and organized so as to provide s single comprehensive file system. 

Database system design is concerned with the problem of organizing the 

database, accessing data on it, using it, updating it and providing output (reports 

or responses to file interrogations) to a variety of users; e. g. a students’ file, 

Marks file, Payment’s file. The Marks’ file will comprise records of marks 

scored by the students. Database Management System refers to software that 

‘builds, manages and provides access to a database’. Examples are Microsoft 

Access, FoxPro, Clipper, Oracle, Foxbase 

 

4.3.2 Elements of a Database  

There are at least five elements that must be present in every database. 

These are: 

A) A field: In Table 5:1 below, students’ name constitutes a field. So also do their 

faculties, departments, age and serial number. A column, or field, is a specific 

category of information that exists in a table. (Stephen 2003) 

 

B) A File: In Table 5.1, the data is arranged in a row. So student’s complete file 

consists of his name, faculty, department street address and age. Furthermore if 

a library has in its holdings 100, 000 different titles, the accession register will 

contain 100, 000 files of information about the records or rows of data. It is 

important to note that the file is organised into records that are related in logical 

characteristics.  

C) A record: Please observe that a record is constituted by building up several 

but related fields of data. Significantly,  database table records are usually in 

rows.  

D) Data type: There are three data types common in most databases. The is 

numeric data type which are in numbers. In Table 5.1, serial numbers and ages 

are listed in raw numbers. The second data type is alpha as illustrated by 

students’ names, faculty and departments. The third data type is alphanumeric 

which is a combination of numbers and alphabets as is seen in the column of 

street address. 

E) Table: They are used to store data that users will access 

The design of most databases will involve the use of the following tables: 
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 Data tables: Their basic role is to store most of the data found in a 

 database. 

 Join tables: They are used to create a relationship between two tables 

 that would otherwise be unrelated. 

 Subset tables: They contain a subset of data from a data table. 

 Validation tables: These are regarded as code tables, and they are used  for 

the validation of data entered into other database tables. 

  

 

 

 

 

 

 

 

Table 5.1: A Database table showing fields (six) and records 

1 
S/

N 

2 

STUDENTS 

NAME 

3 

FACULTY 

4 

DEPT 

5 

STREET 

ADDRESS 

6 

AGE 

1  
ABDULLAHI 

YUSUF  
EDUCATION 

LIBRRY 

SCIENCE  

12 KANO ST 

KANO 
17 

2  
OLADELE 

AYINDE  

PHYSICAL 

SCIENCE 
CHEMISTRY 

15 LEKAN 

MUSHIN 
18 

3  NWACHI OJI  
BIOLOGICAL 

SCIENCE 
ZOOLOGY 

5 ACHI ST 

ENUGU 
20 

4 
JOSEPHINE 

JOHNSON 
AGRICULTURE 

ANIMAL 

SCIENCE 
4 IJAW ST. PH 16 

5 
YUSUF 

YAKUBU 
ARTS FINE ARTS 

7 REMI ST 

KADUNA 
21 
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LibID # First 
Name 

Last 
Name 

Phone 
# 555-555 John Kung 080-
36748
162 

444‐444 Lami Kasim 070-
69753
393 

333‐333 Blessin
g 

Nnamdi  080-
379853
70 

 

6 
GREEN 

GREAT 

SOCIAL 

SCIENCES 

POLITICAL 

SCIENCE 

8 JONATHAN 

ST 

YENOGUWA 

19 

7 
BULUS 

BITRUS 

HEALTH 

SCIENCES 
NURSING 

1 GWOM ST 

JOS 
17 

 

4.4 Relational Database/Relationship  

What is a relational database? It is a collection of tables, with each table 

containing information on a specific subject. Secondly, it uses a series of 

logically-related two-dimentional tables or files to store information. 

Essentially, related data can be stored in separate tables and a definition 

relationship ensure information retrieval, facilitate queries and prepare reports. 

between the tables,  Microsoft Help says that a "relationship works by matching 

data in key fields, usually a field with the same name in both tables. In most 

cases, these matching fields are the primary key from one table, which provides 

a unique identifier for each record, and a foreign key in the other table" 

For example, here we have simple database of library Users: 

 

 

 

Here is a simple database For Librarians: 

 

LibID 

# 

First 

Name 

Last 

Name 

Phone # 

555-555 John Kung 080-

36748162 444‐

444 

Lami Kasim 070-

69753393 333‐

333 

Blessing Nnamdi  080-37985370 
 

In an Access database, we can create both of the datasets and link them. 

 

 

  

4.5  Introduction to Microsoft Access  

 

There are at least 10 basic facts to note about MS Access 

 

LibRec

# 

First 

Name 

Last 

Name 

DOB Librari

an 234-453 Chidi Ikechuk

wu 

02/05/8

0 

Ngozi 
867‐543 Uche Charles 04/20/7

1 

Eze 
523‐425 Musa Adamu 10/10/8

5 

Edwar

ds 

LibRec

# 

Firs

t 

Na

me 

Last 

Name 

DOB Librari

an 234-453 Chid

i 

Ikechu

kwu 

02/05/8

0 

Ngozi 
867‐543 Uch

e 

Charle

s 

04/20/7

1 

Eze 
523‐425 Mus

a 

Adam

u 

10/10/8

5 

Edwar

ds 
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1) It is Database Management System from Microsoft 

2) It is a relational database 

3) Data storage is in MS Access’ own file 

4) Users can create tables queries, reports, and link them together 

5) It has report creation capability that can work with any data source that  it 

can access 

6) It can export and import data from FoxPro, Excel, Oracles, etc 

7) Heterogeneous joining of data between data set stored in different 

 platforms can be handled by MS Access 

8) In terms of programming, it is relatively compatible with Structured 

 Query Language (SQL)  

9)  End users can access data from any system 

10) Latest versions (from 2013) can be used to create web applications 

11) Runtime versions of MS Access allow users to access desktop 

 applications without having to buy and install licensed editions of 

 Access 

 

4.5.1 Access Database Design Considerations  

 

The design and implementation of a database management system will require 

critical planning, just like an architect and engineer will do in a building project. 

The questions to ask include: 

 

a) What purpose will the database serve or who are the ultimate end-users? 

b) How many tables will be needed for the database?  

c) Which fields will the database require?  

d) How will the tables be related?  

e) At what stage will it require to be modified or be redefined?.  

 

There could be more questions. Please note that the primary goal of database 

deign is to arrange data into tables and fields. You will find the following 

guidelines articulated by Shelly and Vermaat (2012) as vital considerations in 

the database design process. 

 

Consideration 1: Table identification 

Consideration 2: Primary keys 

Consideration 3: Additional fields 

Consideration 4: Relationship between tables 

Consideration 5: Data types for fields 

Consideration 6: Unwanted redundancy 

Consideration 7: Storage location 

Consideration 8: Additional properties for fields 

Consideration 9: Best distribution method 

 

Consideration 1: Table identification 
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To identify the number of tables for the database it is important to first identify 

the main objects of the database.. If for example the objects for a library database 

are library users and circulation services, there will be two tables, one for each 

object. 

 

Consideration 2: Primary keys 

  

What is primary key? It is the unique identifier for a record in the table. In the 

example in Consideration 1 above, the registration number can serve as the key 

for library user while  the ISBN will serve as the key for books be borrowed or 

returned by students, 

 

Consideration 3: Additional fields 

 

In most cases, while the primary key provides a unique identification for a record 

in a table, there may be the need for more fields to fully describe the record. In 

the example of student registration number there may be the need to create 

additional field for the student’s name, department, faculty, hostel, telephone 

numbers, etc.  

 

Consideration 4: Relationship between tables 

 

It is crucial to determine the relationship between tables and ascertain  the 

possible matching fields in both tables. In circulation and cataloguing tables for 

example, the ISBN could serve as the matching field fir both tables. 

 

Consideration 5: Data types for fields 

 

The determination of data type for the tables will define whether numeric, alpha 

or alphanumeric data will be entered in the field. It is most likely that student 

telephone numbers will be numeric, their names alpha and street addresses 

alphanumeric. 

 

Consideration 6: Unwanted redundancy 

 

Redundancy occurs when a piece of information is stored in more than one place 

may result to wasted space, and data inconsistency. It is advisable to remove the 

redundancy by splitting a table and put the redundant field in a different table. 

 

Consideration 7: Storage location 

 

Databases are often stored as a single file and it vital to determine in good time 

where it will be stored, whether in a server, a system or cloud. 

 

Consideration 8: Additional properties for fields 
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Considerations here will include: what is the field size (number of character)?; 

any abbreviation?; and any description? 

 

Consideration 9: Best distribution method 

 

Most invariably, the common means of distributing databases (tables) is by 

printing and distributing tables as hard copies. With advances in technology, it 

can be easily done electronically. 

 

4.5.3 Helps for Practical Access Design 

 

Working with access can be an exciting learning experience. Several online 

websites, audios and videos are available facilitate your practical learning 

voyage. The  videos range from 10 minutes to three hours lessons. Some can last 

for three or more days. What is however important is to examine and explore 

these learning resources so as acquire the necessary learning competencies and 

capabilities.  Please consult the following resources: 

 

1) Tutorialpoint (2022).Learn MS Access: Absolute beginners. Available at 

  https://www.tutorialspoint.com/ms_access/index.htm 

 

2) MS Access 2016 - Course Overview Watch More Videos at:  

 https://www.tutorialspoint.com/videot... Lecture By: Mr. Akshay Magre, 

 Tutorials Point India Private Limited. 

 

3) McAllister, D. (2020)) Access.2016: Beginner Part 1. Available at 

 www.learnit.com 

 

4) Kaceli, S. (2017). Tutorial: A Comprehensive Guide to Access-Part 1 of 2. 

Available at www.learn.kaceli.com 

 

 

4.6 SUMMARY 

A database is a collection of logically related data files which is integrated 

and organized so as to provide s single comprehensive file system. Database 

system design is concerned with the problem of organizing the database, 

accessing data on it, using it, updating it and providing output. The design 
and implementation of a database management system will require critical 
planning, just like an architect and engineer will do in a building project. 
Database Management System refers to software that ‘builds, manages and 

provides access to a database’. Examples are Microsoft Access, FoxPro, 

Clipper, Oracle, Foxbase 

SELF-ASSESSMENT EXERCISES 

1) Define database 

https://www.tutorialspoint.com/ms_access/index.htm
https://www.youtube.com/redirect?event=video_description&redir_token=QUFFLUhqbW4xWVpmSFRYMll2YlItS0o3NENVMnhsUDVaUXxBQ3Jtc0tuOWx3Q0tsTUtrclhBX19QRnpkSmhPOGhhLW9aWU0zOHg3Z3JleVNaV0pXUUNXRmRfckw0bUJxSXc5b3RVcU9qRmV6bFk3OTBteVdGV0dXNi1UR09US3lCV09hVUNmYXRUX2JJLWFCb01va1pIVzdhWQ&q=https://www.tutorialspoint.com/videotutorials/index.htm
http://www.learnit.com/
http://www.learn.kaceli.com/
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2) List the elements of a database file 

3) Highlight at least five basic facts about Microsoft Access 

4) List seven considerations in the design process of a data base 

5) A University Librarian has engaged your services to design library 

database management system using Microsoft Access. What preliminary 

questions will you ask?  

4.7 Glossary 

Database is a collection of logically related data files which is integrated and 

organized so as to provide s single comprehensive file system 

Database Management System refers to software that ‘builds, manages and 

provides access to a database’. Examples are Microsoft Access, FoxPro, 

Clipper, Oracle, and FoxBASE 

Data types: Describe the category of entered in a database There are three data 

types common in most databases.  

Alpha data type is in words as illustrated by students’ names, faculty and 

departments.  

Alphanumeric data type is a combination of numbers and alphabets as is seen 

in the column of street address. 

Numeric data type is in numbers.  

Field: A column, or field, is a specific category of information that exists in a 

table. 
 

File: It is important to note that the file is organised into records that are related 

in logical characteristics.  

Record: Constituted by building up several but related fields of data. 

Significantly, database table records are usually in rows.  

Tables: They are used to store data that users will access 

Data tables: Their basic role is to store most of the data found in a  database. 

Join tables: They are used to create a relationship between two tables 

 that would otherwise be unrelated. 

Subset tables: They contain a subset of data from a data table. 
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1.9 POSSIBLE ANSWERS TO SELF-ASSESSMENT EXERCISES 

(SAEs) 

SAE 1: Define database 

Answer to SAE 1: 

A database is a collection of logically related data files which is integrated and 

organized so as to provide s single comprehensive file system 

SAE 2: Highlight the elements of a database file. 

Answer to SAE 2: 

There are at least five elements that must be present in every database. These are: 

1)A field: A column, or field, is a specific category of information that exists in 

a table. 

2)A File:. It is important to note that the file is organised into records that are 

related in logical characteristics.  

https://www.developer.com/database/the-elements-of-a-database/
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3 A record: Please observe that a record is constituted by building up several 

but related fields of data. Significantly,  database table records are usually in 

rows.  

4) Data type: There are three data types common in most databases. The is 

numeric data type which are in numbers. The second data type is alpha as 

illustrated by students’ names, faculty and departments. The third data type is 

alphanumeric which is a combination of numbers and alphabets as is seen in the 

column of street address. 

5) Table: They are used to store data that users will access 

SAE 3: Highlight at least five basic facts about Microsoft Access. 

Answer to SAE 3: There are many facts to know about Microsoft Access. They 

include the following: 

1) It is Database Management System from Microsoft 

2) It is a relational database 

3) Data storage is in MS Access’ own file 

4) Users can create tables queries, reports, and link them together 

5) It has report creation capability that can work with any data source that  it 

can access 

6) It can export and import data from FoxPro, Excel, Oracles, etc 

7) Heterogeneous joining of data between data set stored in different 

 platforms can be handled by MS Access 

8) In terms of programming, it is relatively compatible with Structured 

 Query Language (SQL)  

9)  End users can access data from any system 

10) Latest versions (from 2013) can be used to create web applications 

 

SAE 4: List seven considerations in the design process of a data base. There 

are several considerations to make before embarking on Database design. The 

following considerations are germane: 

Answer to SAE 4: 

There are several considerations to make before embarking on Database 

design. The following considerations are germane: 

Consideration 1: Table identification 

Consideration 2: Primary keys 

Consideration 3: Additional fields 

Consideration 4: Relationship between tables 

Consideration 5: Data types for fields 

Consideration 6: Unwanted redundancy 

Consideration 7: Storage location 

Consideration 8: Additional properties for fields 
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Consideration 9: Best distribution method 

 

SAE 5: A University Librarian has engaged your services to design library 

database management system using Microsoft Access. What preliminary 

questions will you ask?  

Answer to SAE 5: 

The questions to ask include: 

 

a) What purpose will the database serve or who are the ultimate end-users? 

b) How many tables will be needed for the database?  

c) Which fields will the database require?  

d) How will the tables be related?  

e) At what stage will it require to be modified or be redefined?  

Validation tables: These are regarded as code tables, and they are used  for 

the validation of data entered into other database tables. 

 


